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What is KeyShot?

KeyShot is a stand-alone, real-time ray tracing and global illumination program used to
create 3D renderings, animations and interactive visuals. With its CPU-based
architecture, photorealistic real-time rendering can be achieved on both Mac and PC,
even on laptops, without the need for special graphics cards.

KeyShot supports more 3D file formats than any other rendering software, importing
over 25 different file types. It has a simple user interface with drag-n-drop material and
environment presets, interactive labeling, texture mapping, physical lighting, animation
and much more.

KeyShot is…

Fast
Everything inside KeyShot happens in real-time. KeyShot uses unique rendering
technology which makes it possible to see all changes to materials, lighting, and
cameras instantly.

Easy
You don’t have to be a rendering expert to create photorealistic images of your 3D
models. Simply import your data, assign materials by dragging and dropping them onto
the model, adjust the lighting, and move the camera. Done.

Accurate
KeyShot is the most accurate rendering solution for your 3D data. KeyShot is built on
Luxion’s internally developed, physically correct render engine based on research in the
areas of scientifically accurate material representation and global illumination. 

 

 

What's New
KeyShot 7 is our biggest release to date with more of what you love across five areas
we've focused on to make the 3D rendering process faster and more flexible while
providing more possibilities, more control and more ways for you to create.

More Ways to Create

Create the way you want right from the beginning. Use KeyShot Studios to set up
different Camera, Environment, Model Set, and Multi-Material combinations in one
scene, then present your model and material variations in the new KeyShot
Configurator.

More Material Possibilities

New options are available for many existing materials and new Cloudy Plastic and
Measured materials are here. Textures now offer Tri-planar and Tiled UV mapping,
while more control is added with new 2D Procedural Texture options. 

More Lighting Control

In this section:

Product Updates
Feature Highlights
Additional Features
KeyShot Library Updates
User Interface Updates
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With the new Environment list, HDR export and improved Ground, you have more
control over your lighting. Take care of everything in one place with the integrated HDRI
Editor full of new enhancements.

More Flexible User Interface

You have more flexibility in the KeyShot user interface with the ability to create your
own Workspaces, reorder tabs, preview parts in the scene tree, and enjoy an improved
experience on a 4k display.

More Workflow Options

You love KeyShot for the speed and KeyShot 7 brings you more. Introducing a
completely new sampling method, re-tessellate, an adaptive performance mode and
new output capabilities that has you producing visuals faster than ever before.

The new Cloudy Plastic material type in KeyShot 7 - Rendered by John Seymour

Product Updates

With KeyShot 7, we have the following product updates:

Windows 32-bit Version End of Life

With KeyShot 7, we are ending support of Windows 32-bit systems and installations.
Support for customers with 32-bit installations of KeyShot 6 is available until the release
of KeyShot 7.

KeyShot 7 for Education

Education licenses of KeyShot 7 will now have all features of KeyShot Pro. Previously,
KeyShot for Education contained only KeyShot HD features. You can see a comparison
of KeyShot versions .here

New Library Presets

The KeyShot Library has been completely updated to take advantage of the latest
KeyShot material, texture and environment capabilities. Learn more about the new

.KeyShot Library presets

On this page:
Windows 32-bit Version End
of Life
KeyShot 7 for Education
New Library Presets
New Texture Mapping

https://www.keyshot.com/product-comparison/


To obtain the new library presets, the full version of KeyShot 7 must first be installed.
The full install of KeyShot 7 is available  . Note: For a clean install of the newhere
KeyShot 7 material presets, remove the contents of any previous KeyShot 7 resource
folder installation (except the keyshot7.lic file). All assets which have been removed
from the previous KeyShot Library are available on  .KeyShot Cloud

New Texture Mapping

Old KeyShot scenes will still use the legacy texture mapping for existing textures and
labels when opened in KeyShot 7. Click the Upgrade to New Node button to convert the
legacy texture mapping to the new mapping technique. Some shifts may occur when
doing so.

Feature Highlights
KeyShot 7 is our biggest update yet with new features an enhancements that cover
every area of KeyShot. Below you'll find the top features in this release with short
description on how it works and a link to more information. 

Workspaces

Workspaces allow you to select preset UI arrangements or save your own custom
arrangements of the KeyShot UI to best suit the way you work. Workspaces remember
window dock state, position and size, Library and Project tab order, tab visibility, torn-off
tab state, Toolbar and Ribbon position and Ribbon icon visibility. Learn more in the
manual on the   page.Workspace

How it Works
The Ribbon at the top of the KeyShot UI now contains a dropdown menu at the far left
where you can select, add, and manage Workspaces. To create your own custom
Workspace make adjustments to any of the items mentioned above click the
Workspaces dropdown and select Add… to launch a name entry field and save. To
save changes to an existing Workspace click Apply Changes… To adjust display order,
import, export, or delete Workspaces click Manage...

Custom Hotkeys

KeyShot 7 now allows you to assign custom hotkeys for many KeyShot commands.
Learn more in the manual about the new  . Hotkeys

How it Works
The Hotkeys preferences can be accessed by selecting Edit, Preferences and selecting
the Hotkeys section or by pressing the K-key to show the Hotkeys Overview where you
will see a button for Setup/Details... in the bottom right corner. This will take you to the
Hotkeys section of the Preferences page. Here you can set custom Hotkeys for any of
the listed actions.

New Material Types

The  material type contains light-scattering particles to replicatePlastic (Cloudy)
complex, scientifically accurate materials such as Polycarbonate or ABS. This material
has settings to control light Transmission, Cloudiness, and Scattering Directionality.
Read more about Plastic (Cloudy) material type .here

The  material type allows you to load measured material files in .axf or .xmlMeasured
format. Read more about measured materials .here

How it Works
When editing an existing material select Plastic (Cloudy) or Measured from the Material
Type drop-down.

Material Enhancements

Dielectric-based material types -  , , ,  - have beenGlass (Solid) Liquid Dielectric Gem
updated with a unit-aware  setting that allows you to specify theTransparency Distance

On this page:
Workspaces
Custom Hotkeys
New Material Types
Material Enhancements
Texture Mapping
Environment List
Copy/Paste Position
Multi-Material
Video Map Textures
Panoramic Camera
Real-time VR Rendering 
Configurator 
Studios 
Re-Tessellate 
Move Active Camera 
Integrated HDRI Editor 
Deformation Animation
Support 
All New Network Rendering 
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distance through the material at which the defined color is achieved. Learn more about
the  , ,  and  material types.Glass (Solid) Liquid Dielectric Gem

The  material type now includes options for  and 13 scientifically accurateMetal Color
metal presets including Aluminum, Brass, Chromium, Copper, Gold, Iron Magnesium,

, and  These, along with the ability toNickel, Niobium, Platinum, Silver, Titanium Zinc.
load Complex IOR files (.ior, .nk, .csv), may be chosen for custom metal appearances.
All metal preset provide the additional ability to add an anodized coating with control of 

, and . The  seFilm Refractive Index, Film Extinction Coefficient  Film Thickness Anodized
ttings are available for all metal presets selected from the  drop-down. LearnMetal Type
more in the manual on the  material type page.Metal

The  material type now has settings for Clear-coat Color, which allowsMetallic Paint
you to create deep rich candy coats and can be further controlled by a Clear-coat
Thickness. In addition, the new Clear-coat settings may have a textured applied, which
does not affect the Base coat. Learn more in the manual on the  materialMetallic Paint
type page.

Translucent and  material types have been updated with aTranslucent (Advanced)
unit-aware  setting, which defined the distance light is able to penetrateTranslucency
the material. Learn more about the  and  materialTranslucent Translucent (Advanced)
types.

The  material type now has control of  and the ability to control theToon Shadow Color
visibility of shadows produced by . The  setting canLight Source Materials Shadow Color
be textured to achieve sketch-like shading effects and much more. Learn more about
the   material type.Toon

The   material type now has control of  in order to easilyGround Reflection Contrast 
increase visibility of ground reflections.

How it Works
When editing an existing material select Metal, Glass (Solid), Liquid, Dielectric, Gem,

or  from the  droMetallic Paint, Translucent, Translucent (Advanced)  Toon Material Type
p-down. Note: When opening KeyShot 6 scenes in KeyShot 7 the material types listed
above will automatically be updated to include the listed enhancements.

Texture Mapping

Texture Mapping has been completely refreshed for KeyShot 7. Updates include an
improved interactive mapping tool, and the ability to specify Center On: Model or Part.
The new Planar mapping type is highly versatile - replacing Normal Projection, Planar
X, Y and Z. This now gives you the ability to control Depth for Planar projections.
Cylindrical Mapping has also been vastly improved. 

Note: Old KeyShot scenes will still use the legacy texture mapping for existing textures
and labels when opened in KeyShot 7. Click the Upgrade to New Node button to
convert the legacy texture mapping to the new mapping technique. Some shifts may
occur when doing so.

New Texture Types
KeyShot 7 features three new Image Texture types and three new 2D Texture
procedural types. Learn more about the new  .Texture Types

Tri-Planar - project textures to each plan independent of the other
Tiled UV - apply and filter multiple UV texture tiles
Video Map - apply a video as an animation
Brushed - new procedural with more brushed appearance options
Mesh - consolidated and improved mesh texture capabilities
Weave - new procedural for fiber and cloth textures

Other Texture Improvements

Other improvements to Textures include:

Unit-aware size parameters across all Texture Types
Unit-aware Radius setting for Occlusion and Curvature Procedural Texture
Color Map support for Area Light Diffuse material 

Environment List

The Environment tab of the Project window now includes the ability to save
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Environments and their settings to a list in order to quickly access and toggle. Learn
more in the manual about the  .Environment List

How it Works
When a new scene is opened the Environment list is populated with the startup
environment at default settings. All changes made to the settings will be recorded and
saved with that environment. To create a new environment based on the current
settings click the Add Environment icon at the top left of the dialog. Alternatively, you
can populate the list with environments by dragging-and-dropping one or more from the
Environment Library.

Copy/Paste Position

You can now copy and paste the position of one object to the position of another object.
You will find  and  options when you right-click a model inCopy Position Paste Position
the  tab.Scene

Multi-Material 

Any material can be turned into a Multi-Material to facilitate non-destructive material
swapping, variations and color studies. The Multi-Material allows you to cycle through a
variety of materials within a single “container” material. Learn more in the manual on the

 page.Multi-Material

How it Works
When editing a material click on the three-arrow Multi-Material icon above the Material
Type dropdown to convert a single material to a Multi-Material. Once you have done so
a list will be displayed that can be populated by drag and drop or by using the buttons
along the left side of the list. Simply select a sub-material in the Multi-Material list to
make it active in the Real-time View.

Video Map Textures 

Image sequences can now be set as Textures or Labels to animate device displays and
much more. The supported formats at the moment include avi, mp4, mpeg, flv, webm,
dv, f4v, mov, mlv, m4v, hevc, ogg, and ogv. Note: Some formats may have variants
encoding which are not supported (for example, avi may include encodings which may
not be directly supported.) Learn more in the manual on .Video Map Textures

How it Works
From Project > Materials > Textures select “Video Map” from the Texture dropdown
menu or Add Label (Video) from the Labels tab. Select an image sequence in the file
browser or a video file to extract the frames. This will create a node in the Animation
Timeline in which you can position and adjust similar to other Animation types.

Panoramic Camera 

The Panoramic Lens Setting for Cameras allows you to render a Spherical or Cube Map
image in real-time or rendered output. This feature can be used to render out your own
spherical EXR images to use as Environments to light KeyShot scenes or to load in
your VR headset image viewer. Learn more in the manual about the  LensPanoramic
Setting.

How it Works
In the Camera tab, under Lens Settings, select Panoramic. Select your desired format
of Spherical or Cube Map from the Mode drop-down menu. The Real-time View will
display a Panoramic Preview message at the top to indicate you are Panoramic mode.
This means that you can mouse around the Real-time View and the image will not
re-render. Click the Reset View button at the bottom of the screen to do just that. Click
the Preview Map button in the Lens Settings to see a flat preview of your Panoramic
image. When using the Spherical Mode the Resolution in the Image tab will be locked to
a 2:1 ratio. Cube Map Mode will be locked to an 8:1 resolution. Try increasing the pixel
resolution if the image does not appear clear.

Real-time VR Rendering 
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Real-time VR rendering and output is available with the support for Stereo Perspective
Cameras, Stereo Spherical Maps, and Stereo Cube Maps. These can viewed within
KeyShot in real-time or output as still images and animations. Spherical and Cube Maps
offer a 360-degree stereo viewing experience while Stereo Perspective shows a
stereoscopic image of the viewport. Read more in the manual about .Stereo VR Support

How it Works
Support has been added for real-time Oculus Rift and HTC Vive Head Mounted Display
(HMD) viewing. From the Camera menu click Enable VR to add a new VR camera. Or
do so manually from the Camera tab by enabling the Stereo accordion for your
Perspective or Panoramic Camera. Click the Head-Mounted Display button to select
Oculus Rift or OpenVR for HTC Vive to open the HMD viewing window.

Configurator 

KeyShot 7 introduces the KeyShot Configurator - a tool for presenting Model and
Material variations in real-time for design reviews and interactive point-of-sale displays.

How it Works
To access the Configurator Wizard click Window > Configurator Wizard or select the

Configurator Wizard icon   on the Ribbon. Here you can define Parent Models,
Components, and Material Variations. Enter Presentation Mode and use the toolbar to
control the Model and Material being displayed. Read more about the KeyShot

.Configurator

Studios 

KeyShot Studios is the new way to combine and save scene variations in one file for
quick creation and presentation. Studios may contain any combination of Camera,
Environment, Models Sets or Multi-Materials. Learn more in the manual about KeyShot 

.Studios

How it Works
View the Studios window from the main menu under Window, Studios... The Studios
window is a dockable window and may also be accessed from the Ribbon at the top of
the KeyShot interface by selecting the Studios icon .

Within the dialog there are four dropdown menus that display the currently active
Camera, Environment, Model Sets or Multi-Materials. Click the Add Studio icon in the
top left corner to add a new Studio with the active elements added to that Studio.

Inline with the Studio name are icons that indicate what elements are included in that
Studio. By default the active Camera and Environment are included when a new Studio
is created. With a Studio active, uncheck any checkbox to exclude that element from
the Studio. To modify a Studio simply select a different Camera, Environment, Model
Set or Multi-Material from the dropdown menus. Multiple Model Sets can be added to a
Studio by checking the corresponding boxes within the Model Sets dropdown menu.

To copy a Studio, select an existing Studio in the Studio window and select Add Studio.
This will copy the elements into a new Studio where you can change the selection as
needed.

Re-Tessellate 

Models that have been imported with NURBS included can be re-tessellated directly in
the scene without having to re-import the model. This tool allows you to fine tune
tessellation quality of entire models or individual parts in a scene to optimize
appearance and file size. Learn more in the manual about .Re-Tessellate

How it Works
In order for Re-Tessellate to be available for a model or its parts the Include NURBS
Data checkbox must have been enabled upon import from the Geometry section of the
Import dialog.

Access the Re-Tesselate function by right-clicking on a model, part, or multi-selection of
parts in the Project window, Scene Tree or Real-time View and selecting Re-Tessellate.
This will open the Tessellation Settings dialog where you can adjust the overall
Tessellation Quality or drill down to access finer adjustments including Angle Tolerance,
Distance Tolerance, and Maximum Edge Length. Click the Tessellate button to show a
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preview in the Tessellation Settings dialog, which can be displayed as a Wireframe or
Glossy representation. Click Apply to commit the changes to the scene. Cancel will
revert all changes and exit the dialog.

Move Active Camera 

The Active Camera in the Geometry View can now be manipulated with a move tool.
This features makes positioning cameras in interiors especially easy.

How it Works
Hit the O-key or select Window, Geometry View... to activate. Set Camera Type in
Geometry View to Perspective or Orthographic. Right-click and select a Move Active
Camera option. As the camera is moved in the Geometry View, the Real-time View and
camera properties in the Project window update as well. Note: If a camera is locked,
you will need to select Unlock Camera to unlock the camera prior to moving it.

Move Active Camera Position
This changes the actual position of the camera. With the camera unlocked, right-click in
the Geometry View and select Move Active Camera Position. Use the Move Tool to
change the position.

Move Active Camera Target
This changes the ‘look at’ point of the camera. With the camera unlocked, right-click in
the Geometry View and select Move Active Camera Target. The Move Tool will appear
on the ‘look at’ point. Use the Move Tool to change the position.

Right-click and select Save Camera to update the current camera position or target, or
select Add Camera to create a new camera. The new camera will appear in the Project
window, Camera tab where the camera changes may be saved or added as well.

Integrated HDRI Editor 

The KeyShot HDRI Editor is now fully integrated into the Environment tab of the Project
window. All Pins and Adjustments are embedded in the KeyShot file so there is no need
to save an individual .HDZ for each custom Environment you create. This provides a
huge convenience and asset management benefit while greatly reducing the amount of
data necessary to store locally and in .KSP files. Learn more in the manual about the H

.DRI Editor

The HDRI Editor is also much more flexible with new features including:

Export of HDR/EXR
Gradient Background
Draggable interactive Sun & Sky
Sun & Sky Ground Color
Sun Size parameter
Rectangular Pin Rounded Corners
Gradient Pins
Image Pin Color Adjustments
Extract pins from previous version HDZ files

How it Works
The HDRI Editor can be accessed from it’s sub-tab in Project > Environment. All pins
and adjustments will be added to the Environment currently selected in the Environment
list.

Deformation Animation Support 

Deformation animations may be imported as Alembic cache files, played back in
real-time, and rendered.  Learn more in the manual about .Deformation Animations

How it Works
Start by importing an .ABC file. On the KeyShot Import dialogue, in the Animation
section, select the Deformable Meshes option and select Import. The file will import and
appear as an animation on the Animation Timeline where it may be positioned and
adjusted similar to other Animation Types.

All New Network Rendering 

https://luxion.atlassian.net/wiki/x/3DFDAg
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KeyShot Network Rendering has been rewritten from the ground up. To see the
complete list of new features, along with how to install and use the new features please
see the .KeyShot 7 Network Rendering Manual

Additional Features
Adaptive Performance Mode - When enabled from the   menu performanceCamera
intensive settings will automatically be turned off when the FPS drops below 20
providing a smoother real-time experience. When the mouse is released the settings
will turn on again.

Rounded Edges - Rounded edges has been greatly improved to get better results.

Updated Primitives - The KeyShot primitives have been updated so they may be
rendered as NURBS and Re-tessellated (both Pro features). Add KeyShot primitives
via Edit, Add Geometry.

Move Tool - Updated to add planar XY, YZ and XZ handles. The Move Tool now shows
automatically when a primitive is added via Edit, Add Geometry.

New Render Passes - Ambient Occlusion, Diffuse, Direct Lighting, Indirect Lighting,
Caustics, Shadow

Improved 3Dconnexion support - Improved defaults to better match viewing in 3D
modeling software.

Improved First Person Camera - Collision Detection option to prevent walking through
objects, i.e. prevent walking through walls with sensitivity control. 

FBX Export - Ability to export objects and cameras as an FBX file.

Improved Absolute Camera Controls

Material Template Improvements

Co-planar surfaces - Support for co-planar surfaces with layering of objects
determined by Scene Tree structure

Flatten Ground - Improved appearance with less distortion

Preferences - Real-time Rendering Samples Cap

Preferences - Set Default Startup Scene

Camera Path Animation - Set Target

Environment - Occlusion Ground Shadows

Isolate Materials to Selection - Creates a new linked material instance within a
selection

Selective NURBS Rendering (Pro) - Available in the   accordion of the Tessellation Proj
 tab when an object with NURBS is selected.ect > Scene > Properties

KeyShot Library Updates
The KeyShot Library has been completely updated to take advantage of the latest
KeyShot material, texture and environment capabilities. Below is a summary of changes
made to the KeyShot 7 library items.

Obtaining the New Resources

To obtain the new library presets, the full version of KeyShot 7 must first be
. Note: For a clean install of the new KeyShot 7 material presets, remove theinstalled

contents of any previous KeyShot 7 resource folder installation (except the keyshot7.lic
. All assets which have been removed from the previous KeyShot Library arefile)

available on  .KeyShot Cloud

Materials

On this page:
Obtaining the New
Resources
Materials
Textures
Environments
Backplates
Favorites
Additional Resources

Environments - by
Aversis
Textures - by
Poliigon
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General
Material samples increased for highly specular/textured materials
Low-resolution legacy materials retired to KeyShot Cloud
Repetitive or lackluster materials retired to KeyShot Cloud
Optimized default settings for materials with unit-aware parameters
Many materials with image-based textures replaced with procedural
versions

Organization
New Architectural folder with sub-folders for popular architectural
materials such as tile, brick, concrete, glass
“Material Graph” folders removed

Cloth and Leather
Updated mesh texture materials

Glass
Color Density folder replaced with Solid Glass
All refractive glass using Glass (Solid) material type

Light
Redundant IES files moved to KeyShot Cloud
Area & Point light output adjusted to fit real world light values

Metal
Anodized - renamed ‘Basic’ sub-folder to ‘Polished’ to better reflect the
application

Mold-Tech
Previous samples replaced with Spray Dot #11000 series Mold-Tech
texture materials
Updated to use Tri-Planar mapping

Paint
Textured folder added

Plastic
Textured folder added for Clear, Cloudy, Hard, and Soft plastics
Optical folder added with accurate material settings including
dispersive variants
Rubber re-added  

Stone
Concrete materials either moved or retired to KeyShot Cloud
Improved procedural materials
Surface materials moved to Architectural folder

Toon
New Shaded and Transparent presets added
All presets improved with contour, part, and quality settings  

Wood
All-new procedural wood materials
Improved image-based materials

Textures

Some low-resolution image-based textures have been retired to KeyShot Cloud
Some image-based textures re-created procedural textures
Gradient textures moved to Opacity Maps folder
Solid opacity maps retired to KeyShot Cloud
Added three additional KeyShot icons (without color gradient) White, Black &
Bump

Environments

All .HDZ studio environments have been replaced with procedural 4K .KLF
environments
4K resolution offers crisp highlights and smooth reflection gradients, can be
scaled up to 8K with no quality loss
Procedural environments are fully editable, allowing fewer environments to
replace multiple image-based environments
2 new zebra stripe environments added to help evaluate surface continuity
22 image-based studio environments have been retired to KeyShot Cloud
Updated Sun & Sky environments

Backplates



Studio Backdrop added with matching environment
Backplates for previous HDRI locations moved to KeyShot Cloud

Favorites

New Categories: Architectural, Automotive, Jewelry, KeyShot 7, Product
Precious Metals with complex IOR values added to Jewelry folder

Additional Resources

A KeyShot Content installer is available for KeyShot 7 users on both Windows and Mac.
The installer contains Environments from   as well as textures from  .Aversis Poliigon
Download the installer here:

Content Download

KeyShot 7 Content (Win) 700 MB
710 MBKeyShot 7 Content (Mac) 

Content Installation

After downloading, run the installer. During installation, the new resources will be added
to your KeyShot Resource folder  and visible in your KeyShot library. The new Aversis
environments are located in the Indoor and Outdoor Environments folders and a new
Poliigon folder will be added to your Textures folder.

The installer contains the following resources:

Environments - by Aversis

Find more environments from Aversis at aversis.be/hdri/

Textures - by Poliigon

Find more textures by Poliigon at poliigon.com/

 

User Interface Updates
The KeyShot 7 user interface has a clean, new look with completely new ways to
customize menus, windows, hotkeys and create workspaces. Among this, there are
some commands/options that have been added, renamed or have changed location
compared to KeyShot 6. This section captures those changes.

"Show Only" for animations in the Timeline.
Name field removed from Camera tab.
Delete key shortcut in Scene Tree (parts, cameras, animations, Model Sets)
Search field in part selection dialog
Parts renamed to “Item” in Scene Tree
Collapse/expand in Scene Tree is now recursive, removal of Collapse All
Automatically expand models when a Scene Tree filter is selected
Edit Geometry command in Edit menu
Scene Tree object preview tooltips
Scene Tree visibility icons
Ability to name nodes in Material Graph
Preferences “Lock Pivot to Target” option for camera.
Real-time View Background Brightness moved from Preferences to right-click
menu
Move Tool on Ribbon and Geometry View Ribbon
Region button on Ribbon.

http://www.aversis.be/hdri/
https://www.poliigon.com/
https://www.keyshot.com/?ddownload=336648
https://www.keyshot.com/?ddownload=336649
http://www.aversis.be/hdri/
http://www.aversis.be/hdri/index.htm
https://www.poliigon.com/
https://www.poliigon.com/


Preview of old color in color picker while maintaining new color
Added tumble, pan and dolly to the camera menu.
Add to Queue button in Render Output and Options pages.
Ability to Move Active Camera and Move Active Camera Target in Geometry
View
Update of Texture Type categories
Right click on material graph node connector to insert utility
Samples count in status bar of render output window for Maximum Samples
and Maximum Time render modes.
Updated Lighting Presets
Hotkey to activate Free Camera (Cmd/Ctrl+Shift+F)
Hotkey to move a selected object (Cmd/Ctrl+D)
Hotkey to copy paste in Scene Tree or Animation Timeline (Cmd/Ctrl+C,
Cmd/Ctrl+V)
Hotkey to add Ground Plane (Cmd/Ctrl+G)
Hotkey to toggle Region Render (Shift+Ctrl/Cmd+R)
Copy/Paste Position in Scene Tree context menu
Select "  is now called .Look At" Point Set Camera Target

 has been renamed to Enter First Person Mode Walkthrough Mode.
Walkthrough Mode HUD has a new layout to include Collision Detection and
Sensitivity

 

Getting Started
How Easy is KeyShot?

KeyShot's drag and drop based workflow will have you rendering images in minutes.
With a simple interface providing many advanced features and instant real-time
feedback, you save time while focusing on your design.

Step 1: Import Your 3D Model

Launch KeyShot. Import your 3D model via  KeyShot supports over 20 3DFile, Import...
file formats, including SketchUp, SolidWorks, Solid Edge, Pro/ENGINEER, PTC
Creo, Rhinoceros, Maya, 3ds Max, IGES, STEP, OBJ, 3ds, Collada, and FBX. KeyShot
also features many plugins with more features, including KeyShot BIP export and
LiveLinking.  Learn More 

Step 2: Assign Your Materials

From the  Window, select the  tab. Apply any of the 600+ scientificallyLibrary Materials
accurate materials from the material library by simply dragging and dropping them onto
your model in the . Changes appear on your model instantly withReal-time View
accurate color and lighting under the current lighting conditions. Learn More 

On this page:
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https://luxion.atlassian.net/wiki/display/K6M/KeyShot+Import
https://luxion.atlassian.net/wiki/x/SQAo


Step 3: Choose Your Environment

Now select the  tab. Drag and drop an Interior, Outdoor or Studio lightingEnvironment
environment (HDRI) into your scene. You will see the change in the scientifically
accurate, real world lighting immediately and how it affects the appearance of your
colors, materials and finishes. 

Step 4: Adjust Your Camera

Use your mouse to adjust the camera. Additional settings are available in the Project,
 tab. Adjust the angle and distance, control perspective with focal length andCamera

field of view settings, and easily add depth of field to your scene. Learn More 

https://luxion.atlassian.net/wiki/x/MgAo


Step 5: Enjoy the Perfect Image

Hit  on the main toolbar. Use the default setting or adjust the output options.Render
Select the  button to watch your image render right before your eyes. Render Learn
More 

 

Installation
Installing Your License

The standard node-locked license of KeyShot can only be active on one machine at a
time. However, you can transfer your license repeatedly between up to three machines
of mixed platforms.

Automatic Install

When you receive your  file save it to your computer. Next, start KeyShot,keyshot6.lic
and select  and browse to the  file. If your licenseInstall a license file (*.lic) keyshot6.lic
fails to install, check to ensure you have full permissions set on your  resourcKeyShot 6
es folder for PC, or full permissions set on the KeyShot application  forpackage contents
Mac.

Manual Install

When you receive your  file, you can manually copy it to the  resokeyshot6.lic Keyshot 6
urces folder on PC or Mac.

Transferring Your License

During the license transfer process, an internet connection is required. Once the license
has been successfully transferred, KeyShot can run without being connected to the
internet.

How to Transfer Your License

To transfer your license, ensure you are connected to the internet on the active
machine. Start KeyShot and go to Help, Deactivate License on this Computer...

On this page:
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https://luxion.atlassian.net/wiki/x/XYAV
https://luxion.atlassian.net/wiki/x/XYAV


Next, ensure the new machine is connected to the internet and KeyShot is installed.
Start the software, fill out your information on the activation screen, and press .Next

On the following screen you will be asked for your KeyShot serial code(s). Type in your
information and press  to finalize the activation.Next



 

 

Resource Folder

KeyShot Resource Folder

Your KeyShot installation contains a folder of preset KeyShot resources (or assets).
Resources such as materials, environments, and textures are stored here. When you
open a .bip file, KeyShot references the KeyShot resources folder location and loads
any files that apply to the scene. You can specify the location of the KeyShot resources
folder from  under the  tab.Edit, Preferences Folder Preferences

The KeyShot resources folder contains the following sub-folders:

Animations

Animations will be saved to this folder by default. At render time, other locations can be
specified in the Render Options window.

Backplates

The KeyShot Library loads backplates from the this location and saves imported
backplates to this folder by default.

Colors

The KeyShot Library loads color library files from the this location and saves imported
color library files to this folder by default.

Downloads

Resources downloaded from the KeyShot Cloud will be saved to this location .

Environments

On this page:
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The KeyShot Library loads environments from this location and saves imported
environments to this folder by default.

Favorites

This folder is empty until a favorite list of resources is created. Once created, the
favorite list is saved to this location as a XML file.

Materials

The KeyShot Library loads materials this location and saves imported materials to this
location by default.

Material Templates

This folder is empty until a material template is created. Once created, the material
template is saved to this location.

Models

This folder contains standard primitives that you can import into KeyShot.

Renderings

Renderings will be saved to this folder by default. At render time, other locations can be
specified inside the Render Options window.

Scenes

This folder contains sample scenes that you can only open with KeyShot. These scenes
are saved as BIP files.

Scripts

This folder contains sample scripts that you can use with KeyShot.

Textures

The Keyshot Library loads textures from this location and saves imported textures to
this folder by default.

You can specify the location of the KeyShot Resources folder Preferences, Folder
.Locations

PC Location

After KeyShot 6 is installed, a “KeyShot 6 Resources” shortcut will be created on your
desktop. By default, this shortcut points to: Documents/KeyShot 6.

Setting Permissions

You must have read and write permissions for your KeyShot 6 folder in order to save
renders, animations, and more. Here’s how to set permissions:

Right click the KeyShot 6 resources folder and select “Properties”.
Go to the Security tab and highlight your group or user name.
Click the “Edit” button.
Set permissions to “Full Control.”
Click “Apply” and “OK.”

https://luxion.atlassian.net/wiki/display/K6M/Preferences#Preferences-Folders
https://luxion.atlassian.net/wiki/display/K6M/Preferences#Preferences-Folders


1.  
2.  
3.  
4.  
5.  

Mac Location

On a Mac your KeyShot 6 resources folder is saved inside the “Application Support”:
Library/Application Support/KeyShot 6

Setting Permissions

You must have read and write permissions to your KeyShot 6 folder in order to save
renders, animations, and more. Here’s how to set permissions:

Right click the KeyShot 6 resources folder and select “Get Info.”
Expand “Sharing & Permissions” and unlock access.
Change all privileges to “Read & Write.”
Click the settings button and select “Apply to enclosed items…”
Click “OK” and close the window.

 



 

Pro Floating Installation

Welcome to the KeyShot Pro Floating Installation Guide! This guide will walk you trough
the installation process starting with the license management application: LMTools
(PC), KeyShot License Manager (Mac), or lmgrd (Linux). You will then install and

client application features andconfigure the  , KeyShot! We have also included a list of 
add-ons troubleshooting guide definitions, a  , and licensing terminology with  .

LMTools (PC) KeyShot License Manager
(Mac)

lmgrd (Linux)

In this section:
Pro Floating Quick Start
Setup
Windows PC Setup
Mac OS X Setup
Linux Setup
Pro Floating Features
Pro Floating Troubleshooting
Pro Floating Server
Changes
Pro Floating Technical Info

https://luxion.atlassian.net/wiki/spaces/K7M/pages/63340592/Pro+Floating+Quick+Start+Setup
https://luxion.atlassian.net/wiki/spaces/K7M/pages/63340592/Pro+Floating+Quick+Start+Setup
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37950271/Windows+PC+Setup
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37950659/Mac+OS+X+Setup
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https://luxion.atlassian.net/wiki/spaces/K7M/pages/37952193/Pro+Floating+Server+Changes
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37952193/Pro+Floating+Server+Changes
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37952330/Pro+Floating+Technical+Info


1.  

2.  
3.  
4.  

1.  
2.  
3.  
4.  

5.  

Windows PC

Setup

LMTools is the license
management

application for PC.

Requires Windows
Server 2008 and later.

Mac OS X Setup

KeyShot License Manager is
the license management

application for Mac.

Requires Mac OSX 10.7 and
later.

Linux Setup

The lmgrd (unix executable
file) is the license

management process for
Linux.

All license management applications utilize the latest FlexNet licensing tools
(v11.13.1.3) by Flexera Software LLC. KeyShot Pro Floating and KeyShot License
Manager are both provided by Luxion Inc.

Pro Floating Quick Start Setup

KeyShot Pro Floating - Server Installation

All license management applications utilize the latest FlexNet licensing tools
(v11.13.1.3) by Flexera Software LLC. KeyShot Pro Floating and KeyShot License
Manager are both provided by Luxion Inc. Please follow the instructions below to install
the license server and have your license file issued.

During license setup, you will install the server on a single computer in your network.
This computer will host your license file and will be referred to as the license server. Not
e: The server must be a local central server--a dedicated machine for the FlexNet
server software to be installed on and powered on and connected to the network at all
times.

Before You Begin
Your KeyShot Pro Floating license will be sent via email. If you have a previous
installation, please save the license file to your license server folder (e.g.   onC:\FlexLM
Windows) overwriting the previous file. If you changed the port number in the original
file, please make sure your new license reflects that. It is important to note that the
latest client software installation requires the latest KeyShot license server software.
Without the latest license server software, KeyShot will display an "unknown error".

1. Download the license server software
KeyShot License Server - Windows
KeyShot License Server - Mac OS X
KeyShot License Server - Linux

2. Install the license server

Download and unpack the server software on the machine that will host the
licenses.
Start the server software.
The server software will automatically provide the   and the  .Host name Host ID
Send the following information to  .license@luxion.com

Company name
Serial code
Computer Hostname
Computer MAC Address

How to Restart a Windows Server

Go to the server’s C:\FlexLM folder
Launch LMTools.exe
Go to the START/STOP/REREAD tab
Enable Force Server Shutdown

On this page:
KeyShot Pro Floating -
Server Installation
KeyShot Pro Floating -
Client Installation

https://luxion.atlassian.net/wiki/display/K6M/Mac+OS+X+Setup
http://keyshot.com/install/keyshot_floating_license_server.exe
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5.  
6.  

1.  
2.  
3.  
4.  
5.  

1.  

2.  

1.  
2.  

Click Stop Server and wait for the server to stop
After a minute, click Start Server

The service will restart. Client computers will be able to connect as usual.

How to Restart a Mac Server

Launch KeyShot License Manager.app
Make sure to select Install License File
Click Browse and browse to your new license file
Click Stop
Click Start/Restart

The service will restart. Client computers will be able to connect as usual.

How to Restart a Linux Server
Using the command line on a Windows system running the FLEXlm license server:

Stop server: Enter
lmutil lmdown -c [path to license file]

Start server: Enter
lmutil lmgrd -c [path to license file]

The service will restart. Client computers will be able to connect as usual.

How to move the license server
Should you need to move the KeyShot Floating license server to a new computer,
please follow the following instructions to ensure you are up and running quickly.

Follow the steps above for installing the license server on the new machine.
Send the following information to  .license@luxion.com

Old license file
New Computer Hostname
New Computer MAC Address
Letter on company letterhead stating the old license server will be
removed.

We will usually send your license file within 24 hours during business days (Mon-Fri).
Should you have any questions please contact us at  .license@luxion.com

KeyShot Pro Floating - Client Installation

1. Gather Server Information
Before installing, make sure that the KeyShot Floating license server has been installed
on a computer in the network and gather the following information from that computer:

Computer Hostname
Computer IP Address

2. Install KeyShot Pro Floating
Install the KeyShot Pro Floating (FL) client software on all the user's computers. You
may download the KeyShot Floating client application here:

KeyShot Pro Floating - Windows
KeyShot Pro Floating - Mac OS X

3. Enter Server Information
When first installed, the KeyShot Floating client application will ask you to Specify the

.License Server System

 - Enter the   at the first promptWindows Computer Name
 - Enter   (e.g.  )Mac [port number]@[server's IP address] 27000@192.168.1.123

KeyShot Pro Floating will remember the server location from now on. For more
information please refer to the relevant section for your installation:

Pro Floating Installation - Mac OS X
Pro Floating Installation - Windows PC
Pro Floating Installation - Linux

Should you have any questions, please contact us at  .license@luxion.com

https://www.keyshot.com/?ddownload=335582
https://www.keyshot.com/?ddownload=335583
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37950659/Mac+OS+X+Setup
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37950271/Windows+PC+Setup
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37950982/Linux+Setup


Windows PC Setup
Before you can run KeyShot Pro Floating, it is important that your license server is
configured properly.  The following section will walk you through the process starting
with the license server setup: automatic or custom. You will then install and configure
KeyShot Pro on your client machines.

 

In this section:
License Server Installation
(PC) - Automatic
License Server Installation
(PC) - Custom
KeyShot Pro Floating
Installation (PC)

 

License Server Installation (PC) - Automatic
The instructions below will walk you through the typical first-time license service setup.
Our licensing team will provide you with a license file and the appropriate software links.
You may reach our licensing team at  . If you already have a licenselicense@luxion.com
server set up you can then  .make changes

Automatic License Server Setup Instructions

1. Download and run the “keyshot_floating_license_server.exe” installer.  Follow the
prompts and finish the installation.

 

2.  Launch the . Select Floating License Configurator Has received a license file from
. If the configurator doesn't launch or if you receive an error, then youLuxion

may perform a  instead.custom license service setup 

On this page:
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https://luxion.atlassian.net/wiki/spaces/K7M/pages/37950522


 

3. Click the Browse button ( ) and browse to your license file in Windows Explorer.…

4. Click . Your license file will be loaded into the configurator. Click .Open OK



5. A dialog will tell you that the server has started. Click . If you run into any errorsOK
here, then you may perform a  instead.custom license service setup 



6. Open the “debug.log” file inside your C:\FlexLM folder (this folder contains the
licensing software). The debug log will reference your license file and tell you that the
server started on your computer system.  If you don’t see any errors, then your license
service is up an running.

Technical Tip: If your debug log does not look similar to the above image or if you are
getting an error message inside , then you can use the Floating License Configurator tro

 for diagnosis or perform a custom license service setup. You mayubleshooting guide
also contact Luxion Customer Support at   for assistance.support@luxion.com

 

License Server Installation (PC) - Custom
The  application automatically creates a service in Floating License Configurator LMTool
. But what if you wish to create a custom license service? Then, you will need tos

understand   in greater detail. The instructions below will walk you throughLMTools
creating your very own custom license service. Our licensing team will provide you with
a license file and the appropriate software links. You may reach our licensing team at lic

. If you already have a license server set up you can then ense@luxion.com make
.changes

Custom License Server Setup Instructions

1. Download and run the “keyshot_floating_license_server.exe” installer.  Follow the
prompts and make sure that "Run KeyShot Floating License Server 1.0" is disabled.
 Click Finish.

On this page:
Custom License Server
Setup Instructions



2. Launch the  application (found inside ) and go to the ConfigLMTools C:\FlexLM
Services tab.

 

3. Write a new service name.

4. Browse to the , license ( ), and  files.  You should be able tolmgrd.exe .lic debug.log
find all of these files in your  folder.  Note that the  is created afterC:\FlexLM debug.log
you start the service.  For now, you can simply specify the correct path:  C:\FlexLM\deb
ug.log

 



5. Enable  and .  Then click  andStart Server at Power Up Use Services Save Service
confirm.

6.  Launch  and go to the  tab.  Enable LMTools Start/Stop/Reread Force Server
 and click .  You may also stop the  serviceShutdown Stop Server KeyShot Floating

within the  dialog ( ).Windows Services services.exe



7. Click .  You may also start the  service within the Start Server KeyShot Floating Windo
 dialog (services.exe).ws Services

8. Open the  file inside your  folder (this folder contains thedebug.log C:\FlexLM
licensing software). The debug log will reference your license file and tell you that the
server started on your computer system.



Technical Tip: If your debug log does not look similar to the above image or if you are
getting an error message inside  , then you can use the Floating License Configurator tro

 for guidance. You may also contact Luxion Customer Support at ubleshooting guide sup
 for assistance.port@luxion.com

 

 

KeyShot Pro Floating Installation (PC)
Now that your server is up and running, you are ready for the client setup. The
instructions below will walk you through setting up your PC clients.  For setting up your
Mac clients, click . here

License Client Setup Instructions

1. Download and install the KeyShot Pro Floating application. To download KeyShot,
click  .here

2.  Launch KeyShot 7.

On this page:

License Client Setup
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https://www.keyshot.com/resources/downloads/


3.  Select If you are currently in demo mode, then open theFloating License. 
registration wizard from  >  (PC) or  >  (MHelp Register License KeyShot Register License
ac) first. Click Continue.



4. Specify the port number, followed by the “@” sign and the server’s hostname (for
example,  ). Click 27000@KeyShotServer.local Connect.

You may also use the server’s IP Address (use the IP Address if your license server is a
PC). For example,  Click. 27000@192.168.1.123  Connect.



4. Review your license features and Click . Finish

KeyShot Pro Floating will start.  From now on, KeyShot will remember the server
information.  You will be able to check out the license as long as your system can
connect to the computer acting as the license server.



Technical Tip: If your service status window does not look similar to the above image
or if you are getting an error message when you start the server, then you can use the tr

 for diagnosis. You may also contact Luxion Customer Support at oubleshooting guide s
 for assistance.upport@luxion.com

 

Mac OS X Setup
Before you can run KeyShot Pro Floating, it is important that your license server is
configured properly.  The following sections will walk you through the process starting
with the license server setup. You will then install and configure KeyShot Pro Floating
on your client machines.

In this section:
License Server Installation
(Mac) - Automatic
License Server Installation
(Mac) - Custom
KeyShot Pro Floating
Installation (Mac)

 

License Server Installation (Mac) - Automatic
The instructions below will walk you through a typical first-time license service setup.
Our licensing team will provide you with a license file and the appropriate software links.
You may reach our licensing team at  . If you already have a licenselicense@luxion.com
server set up, you can then  .make changes

License Server Setup Instructions

1. Download and unzip KeyShot License Manager folder into your folderDownloads 
first. Then, drag and drop the  to your Application's folder.*KeyShotLicenseManager.app

2.  Launch the   application.KeyShot License Manager

On this page:
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3. Click  and browse to your license file in the Finder app.Browse

4. Click . Your license file will be loaded into .Open KeyShot License Manager



5. Check that the correct hostname appears in the appropriate field and click . AStart
dialog will tell you that the server has started. Click .Ok

6. Click . Your license server’s status will appear in the service statusService Status
window. The service status window will tell you how many seats are available and how
many seats have been issued.



* It is important that you manually drag and drop the KeyShotLicenseManager.app (for
Mac OSX) into your Applications folder before running it.  This prevent Gatekeeper from
translocating it.

Technical Tip: If your service status window does not look similar to the above image
or if you are getting an error message when you start the server, then you can use the tr

 for diagnosis. You may also contact Luxion Customer Support at oubleshooting guide s
 for assistance.upport@luxion.com

 

License Server Installation (Mac) - Custom
The   application is just a graphical user interface to FlexNetKeyShot License Manager
licensing tools. KeyShot License Manager is great for quick setups.  However, for better
troubleshooting and customization your IT department may prefer to have direct access
to the license manager (lmgrd) and the license manager status application (lmstat). In
that case, you can create your license service manually.

Custom License Server Setup Instructions

1. Launch the Activity Monitor.app. Organize your processes by name. Find the   plmgrd
rocess and click   (click the crossed-stop-sign button). This will stop anyForce Quit
existing license services.

On this page:
Custom License Server
Setup Instructions



2. Download the latest FlexLM license server update from here.

3. Once downloaded, move the FlexLM.zip file to your Applications folder and unzip it.
Your FlexLM folder contains the main license management application,   and otherlmgrd
useful applications that help you check the status of your service such as   Insidelmstat.
the FlexLM folder you will also be able to find the installation guide  .PDF

4. Rename your KeyShot license file to “keyshot.lic” and move it into the FlexLM folder.
This is very important.

https://we.tl/TKr6XiNkqW


5. Right-click the FlexLMAutostart.app and select   If you are asked to confirm,Open.
then click Open once more. Your KeyShot license service will start right up.

6. To confirm that your service is up an running, you can run the   applicationlmstat
inside the FlexLM folder.

Launch Terminal.app and change the directory to /Applications/FlexLM : 

cd /Applications/FlexLM

Press   Then, type: Enter.

sudo ./lmstat -a

Press  (no characters will appear as you type). If youEnter and type your password 
think you made a mistake, simply delete and start over.



Presse Enter one more time. If your service is running,   will return a messagelmstat
stating that the “license server is UP ( )…” and it will tell you the number ofMASTER
license issued as well as the number of licenses in use. Otherwise, please send a
screenshot of the lmstat output to   for further assistance.support@luxion.com

7. To ensure that your license service starts every time that you restart your computer,
open your System Preferences.app and go to Users&Groups > Login Items. Click the
Add button (+) and browse to your Applications/FlexLM folder. Select the
FlexLMAutostart.app and click Add. 



8. Close System Preferences.app. You can now launch KeyShot and point it to the
server as outlined in the KeyShot Pro Floating Installation.

KeyShot Pro Floating Installation (Mac)
Now that your server is up and running, you are ready for the client setup on your. The
instructions below will walk you through setting up your Mac clients. For setting up your
PC clients, click . here

KeyShot Pro Floating Setup Instructions

1. Download and install the KeyShot Pro Floating application. To download KeyShot,
click  .here

2.  Launch KeyShot 7.

On this page:

KeyShot Pro Floating Setup
Instructions

https://www.keyshot.com/resources/downloads/


3.  Select If you are currently in demo mode, then open theFloating License. 
registration wizard from  >  (PC) or  >  (MHelp Register License KeyShot Register License
ac) first. Click Continue.

4. Specify the port number, followed by the “@” sign and the server’s hostname (for
example,  ). Click 27000@KeyShotServer.local Connect.



You may also use the server’s IP Address (use the IP Address if your license server is a
PC). For example,  Click27000@192.168.1.123.  Connect.

4. Review your license features and Click . Done



1.  
2.  

KeyShot Pro Floating will start.  From now on, KeyShot will remember the server
information.  You will be able to check out the license as long as your system can
connect to the computer acting as the license server.

Technical Tip: If your service status window does not look similar to the above image
or if you are getting an error message when you start the server, then you can use the tr

 for diagnosis. You may also contact Luxion Customer Support at oubleshooting guide s
 for assistance.upport@luxion.com

 

Linux Setup
Before you can run KeyShot Pro Floating, it is important that your license server is
configured properly. The following sections will walk you through the process starting
with the license server setup. You will then install and configure KeyShot Pro
Floating on your PC or Mac client machines.

After installation, install KeyShot following the:

KeyShot Pro Floating Installation (PC)
KeyShot Pro Floating Installation (Mac)

In this section:
License Server Installation
(Linux)

License Server Installation (Linux)

https://www.keyshot.com/manual/keyshot6network/?section=send-to-network
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37951019
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37951019


The instructions below will walk you through the typical first-time license service setup
on Linux. Our licensing team will provide you with a license file and the appropriate
software links. You may reach our licensing team at license@luxion.com.

License Server Setup Instructions

If you are running RedHat Linux skip steps 3, 4 and 5.

1. Download and unzip the " " file into theKeyShot_Floating_License_Server_Linux.zip
your home folder ("/home/<your username>" or "~/")

2. Open the terminal (usually ) and change your current directory to the Ctrl + Alt + T luxi
 folder ("~/luxion_flexlm")on_flexlm

cd luxion_flexlm/

If you are running RedHat Linux skip the next 3 steps.

3. Run the following command:

ls -l /lib64/ld*

On this page:
License Server Setup
Instructions

http://www.keyshot.com/install/KeyShot_Floating_License_Server_Linux.zip


4. Take note of the return value before the arrow (highlighted in the picture).

5. Run the following command where <value from step three before the arrow> is the
value from step 8 before the arrow.

sudo ln -s <value from step 8>
/lib64/ld-lsb-x86-64.so.3

6. Move your license file to your luxion_flexlm folder, where your file would have your
computer name instead of  .MyCompany

mv
~/Desktop/keyshot_floating_MyCompany.lic
~/luxion_flexlm/

7. Run the following command to star the service, where your file would have your
computer name instead of .MyCompany



./lmgrd -C
keyshot_floating_MyCompany.lic

8. Run the following command to check the service status:  

./lmstat -a

The lmstat output will confirm that the license server is up. The output message will also
show you how many license seats are issued (available).

Pro Floating Features
In this section we’ll go over some of the licensing features and add-ons available for KeyShot Pro Floating. First we’ll explore how KeyShot Pro
Floating handles the KeyShotXR feature in terms of licensing. We’ll then learn about license borrowing and how to change the server connection.

KeyShot Pro Floating is available as an single license or as a bundle with KeyShot Enterprise. Refer to the KeyShot Comparison for a look at all
features.

https://www.keyshot.com/product-comparison/


KeyShot Pro Floating

KeyShot Pro Floating is the floating license version of KeyShot
Pro. It allows for KeyShot to be run on several machines
(purchase multiple licenses to run simultaneously) while the
license(s) is (are) served from a central server using FlexNet fro
m Flexera. It also includes the Animation add-on:

All KeyShot Pro features
 KeyShot Animation
 FlexNet based server license
 Floating license manager
 Floating license borrowing
 Camera animation
 Part and object animation
 Multiple turntable animations
 Interactive setup, editing and playback in realtime
 Individual frame output
 Compiled movie output (Quicktime, AVI, FLV)

KeyShot  Enterprise

KeyShot Enterprise is all encompassing solution, including
KeyShot Pro Floating, Animation, KeyShotXR, Siemens NX
plugin and Network Rendering (32 cores): 

All KeyShot Pro features
 KeyShot Animation
 FlexNet based server license
 Floating license manager
 Floating license borrowing
 Camera animation
 Part and object animation
 Multiple turntable animations
 Interactive setup, editing and playback in realtime
 Individual frame output
 Compiled movie output (Quicktime, AVI, FLV)
 Interactive, touch-enabled KeyShotXR
 32 Cores Network rendering
 Plugin for Siemens NX

 

Enabling KeyShotXR
KeyShotXR is included with your KeyShot Enterprise license. Otherwise, it is sold
separately as an add-on. KeyShotXR allows you to create interactive (touch-enabled)
visuals for your website. Please refer to the KeyShotXR section for additional
information regarding KeyShotXR features.

How To Enable KeyShotXR

On Windows PC

1. Go to the top menu and click Help,
.Select Floating License Type

2. Enable Check out KeyShotXR
.feature from license server

3. Click . KeyShot will restart andOK
KeyShotXR will be enabled.

On Mac OS X

1. Go to the top menu and click KeyShot,
.Select Floating License Type

2. Enable Check out KeyShotXR feature
.from license server

3. Click . KeyShot will restart andOK
KeyShotXR will be enabled.

Note: If your license does not contain the KeyShoXR feature, then KeyShot will tell you
that there are "no additional options available”.

On this page:
How To Enable KeyShotXR

On Windows PC
On Mac OS X

 

Borrowing A License
As you know, to check out a KeyShot Pro Floating license, your computer must be connected to the license server. To continue using KeyShot
Pro Floating, the connection must be maintained at all times. But what if you want to work from a remote location and take KeyShot with you?
Well, then you borrow the license. 

The client and server must be connected during the borrowing process. Once you’ve borrowed the license, you can take your laptop and KeyShot
anywhere for up to 30 days. Educational license holders must submit a request with their IT staff to activate this feature.

How To Borrow A License

http://www.flexerasoftware.com/producer/products/software-monetization/flexnet-licensing/
http://www.keyshot.com/xr/
https://www.keyshot.com/features/network-rendering/
http://www.keyshot.com/plugins
https://buy.keyshot.com/products/keyshot-enterprise-edition
https://buy.keyshot.com/products/keyshotxr


On Windows PC

1. Ensure that your client computer can connect to the server, then
open KeyShot Pro Floating.

2. Go to the top menu and click .Help, Borrow Floating License

3. Select a return date and click .OK

4. You will receive a confirmation message. Click .OK

On Mac OS X

1. Ensure that your client computer can connect to the server, then
open KeyShot Pro Floating.

2. Go to the top menu and click .KeyShot, Borrow Floating License

3. Select a return date and click .OK

4. You will receive a confirmation message. Click .OK

Technical Tip: Please note that other clients cannot checkout or borrow a license seat that has already been borrowed. The borrowed license
seat remains with the client that borrowed it until the return date expires or until the client manually returns the license seat. If your license server
holds more than one license seat, the remaining seats can still be checked out normally.

How To Return A Borrowed License

On Windows PC

1. Ensure that your client computer can connect to the server
(otherwise, this will not work).  Then, open KeyShot Pro Floating.

2. Go to the top menu and click Help, Return Borrowed Floating
. License

3. You will be asked to confirm this action. Click .Yes

KeyShot will close and your borrowed license will return to the
license server.

On Mac OS X

1. Ensure that your client computer can connect to the server
(otherwise, this will not work).  Then, open KeyShot Pro Floating.

2. Go to the top menu and click KeyShot, Return Borrowed Floating
.License

3. You will be asked to confirm this action. Click .Yes

KeyShot will close and your borrowed license will return to the license
server.

 

 

Changing Server Connection
In larger companies, there may be more than one KeyShot license server in the same location or in other locations. KeyShot allows you to choose
between different license servers. Below you will find instructions for changing the license server connection within KeyShot. Please contact your
IT department for VPN connection instructions when trying to connect to a remote license server.

How To Change Your License Server Connection

On Windows PC

1. Ensure that your client computer can connect to the current
server, then open KeyShot Pro Floating.

2. Go to the top menu and click Help, Change Floating License
.Server

3.  Change the port number and the hostname/IP address as
needed.  Click .OK

On Mac OS X

1. Ensure that your client computer can connect to the current server,
then open KeyShot Pro Floating.

2. Go to the top menu and click KeyShot, Change Floating License
.Server

3.  Change the port number and the hostname/IP address as needed.
 Click .OK

 

Technical Tip:  Please refer to the included troubleshooting section if you are unable to establish your new client-server connection.

 

Pro Floating Troubleshooting
This troubleshooting guide will help you diagnose the cause of an



error message and assist you in finding a solution. Below, we list
errors under two main categories: server errors and client errors.
Errors inside KeyShot License Manager are server errors. Errors from
KeyShot Pro Floating are client errors. Please find your error in the
categories shown below.

In this section:
Server Error: Invalid Hostname
Server Error: Invalid Mac Address
Server Error: Expired License
Server Error: Cannot Connect
Server Error: Unknown Hostname
Server Error: License File Not Found
Client Error: Looping Prompt
Client Error: No Licenses Available
Client Error: Unsupported KeyShot Version
Client Error: Unknown Error

Server Error: Invalid Hostname
Reason: The hostname in your license file does not match your computer’s hostname. LMTools assumes that the hostname inside your license
file is correct.  However, this is not always the case.

How To Fix It:

On Windows PC

1. Launch the Windows command prompt ( ), bycmd.exe
right-clicking on the Windows Start menu and selecting . Type Run

 and hit  to open the command prompt, then type thecmd Enter
following command:  hostname

Press .  Make a note of the correct hostname.Enter

2. Open your license file with any text editor (e.g. Notepad, Notedp
). Add the correct hostname to the SERVER line and savead ++

your changes.

3. Launch LMTools and go to the  tab. Enable Start/Stop/Reread Fo
 and click .  You may also stop therce Server Shutdown Stop Server

 service within the Windows Services dialog (KeyShot Floating servi
).ces.exe

4. Click .  You may also start the  servStart Server KeyShot Floating
ice within the Windows Services dialog ( ).services.exe

5. Open the  file inside your  folder (this folderdebug.log C:\FlexLM
contains the licensing software). The debug log will reference your
license file and tell you that the server started on your computer
system.

On Mac OS X

1. Open your System Preferences application and go to . InSharing
your Sharing preferences you will find your computer’s hostname.
 Make a note of this hostname.

2. Inside the , click  and correct theKeyShot License Manager OK
Hostname.

3. Click  and .  Then click  and . The service will start.Stop OK Start OK

4. Click . You should see a dialog box with license serverService Status
and status information. If correcting the hostname in the license file did
not fix this issue, then you can proceed to step 5.

5. Open the Terminal app.  Type the following command inside the
terminal and press :Enter/Return

sudo scutil –-set HostName computer_hostname 

In the command above, substitute  with yourcomputer_hostname
server’s hostname.

6. Type your password and press .Enter/Return

7. Type  and press  to check that the changehostname Enter/Return
took effect. Your hostnames should now match and you can attempt st

 and   again.eps 3 4

 

Technical Tip: If results are not consistent with the above, please reference other possible solutions in the troubleshooting guide. You may also
contact Luxion Customer Support at support@luxion.com for assistance.

 

Server Error: Invalid Mac Address
Reason: The Mac Address (or HostID) in the license file does not match your computer’s active mac address (or HostID).

How To Fix It:

https://luxion.atlassian.net/wiki/spaces/K7M/pages/37951601/Server+Error%3A+Invalid+Hostname
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37951637/Server+Error%3A+Invalid+Mac+Address
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37951693/Server+Error%3A+Expired+License
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37951758/Server+Error%3A+Cannot+Connect
https://luxion.atlassian.net/wiki/spaces/K7M/pages/38786455/Server+Error%3A+Unknown+Hostname
https://luxion.atlassian.net/wiki/spaces/K7M/pages/38800317/Server+Error%3A+License+File+Not+Found
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37951829/Client+Error%3A+Looping+Prompt
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37951912/Client+Error%3A+No+Licenses+Available
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37951998/Client+Error%3A+Unsupported+KeyShot+Version
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37952088/Client+Error%3A+Unknown+Error
https://notepad-plus-plus.org/
https://notepad-plus-plus.org/


On Windows PC

1. Open your license file with any text editor (e.g. Notepad, Notedp
) and look at the SERVER line.  Make a note of the expectedad ++

Mac Address.  This is a 12-digit hexadecimal number.

2.  Launch the Command prompt ( ) and type the followingcmd.exe
command:  ipconfig /all

Press  and you will see a list of devices; each listed with itsEnter
corresponding mac address (aka Physical Address).

3. Once you find a match for the mac address in your license file,
you will want to turn on/connect that device (i.e. turn on Wi-Fi and
connect to a network or connect ethernet cable).

Note:  If you found a typo in the license file or wish to use another
device, then skip to  below.step 7 

4. Launch LMTools and go to the  tab. Start/Stop/Reread Enable
 and click .  You may also stopForce Server Shutdown Stop Server

the  service within the Windows Services dialogKeyShot Floating
(services.exe).

5. Click .  You may also start the  servStart Server KeyShot Floating
ice within the Windows Services dialog ( ).services.exe

6. Open the  file inside your  folder (this folderdebug.log C:\FlexLM
contains the licensing software). The debug log will reference your
license file and tell you that the server started on your computer
system.  You can now open KeyShot on your client computer
(ignore steps 7 and 8 below).

7.  If it does not start, you will need a new license file.  Send an
email to   describing the error. Please makelicense@luxion.com
sure to specify which Mac Address to use in your new license.
 Also, you will want to attach your current license file to your email.

8. Once you receive your new license file, you can follow the licens
 instructions.e replacement

On Mac OS X

1. Click  and go to the  tab.  Make a note of the MacOK Request License
Address.

2. Open your  application.System Preferences

3. Go to  and select a device:  or .Network Ethernet Wi-Fi

4.  Click  for that device and check the MacAdvanced, Hardware
Address.  Once you find a match for the mac address in  above,Step 1 
you will want to turn on/connect that device (i.e. turn on Wi-Fi and
connect to a network or connect ethernet cable).

Note:  If you found a typo in the license file or wish to use another
device, then skip to  below.step 7 

5.  Close and re-open KeyShot License Manager.  Then, click Start
 in the  tab.Server Install License

6. Click . Your license server’s status will appear in theService Status
service status window. The service status window will tell you how
many seats are available and how many seats have been issued.  You
can now open KeyShot on your client computer (ignore steps 7 and 8 b
elow).

7.  ou will need a new license file.  Go back to If it does not start, y KeyS
 and fill the request form.  Click  and send anhot License Manager Email

email to   describing the error. Please make sure tolicense@luxion.com
specify which Mac Address to use in your new license.  Also, you will
want to attach your current license file to your email.

8. Once you receive your new license file, you can follow the license
 instructions.replacement

 

Technical Tip: If results are not consistent with the above, please reference other possible solutions in the troubleshooting guide. You may also
contact Luxion Customer Support at support@luxion.com for assistance.

 

Server Error: Expired License
Reason:  An  (PC) or  (Mac) error means that your license has expired. It is common practice for the licensingEXPIRED vendor daemon is down
team to issue a temporary license while a purchase order is paid. Once the payment is processed, the licensing team will send you your
permanent license file. Please consult your IT staff or your sales representative for any questions regarding payment.

How To Fix It:

On Windows PC

1. Send an email to   describing the situation.license@luxion.com
You will want to attach the  and your current license file.debug.log

2. Once you receive your new license file, you can follow the licens
 instructions.e replacement

On Mac OS X

1. Send an email to   describing the situation. Youlicense@luxion.com
will want to attach the  and your current license file.debug.log

2. Once you receive your new license file, you can follow the license
 instructions.replacement

 

Technical Tip: If results are not consistent with the above, please reference other possible solutions in the troubleshooting guide. You may also

https://notepad-plus-plus.org/
https://notepad-plus-plus.org/


1.  
2.  
3.  

contact Luxion Customer Support at support@luxion.com for assistance.

 

Server Error: Cannot Connect
Reason: There are multiple reasons this error may be seen:

The service has not started
One of the required files is missing: LUXION.exe, lmgrd.exe, or license (.lic) file (PC)
The user changed the server’s port number on the server after launching KeyShot Pro Floating on that same computer (Mac)

How To Fix It:

On Windows PC

1. Make sure that the  folder contains all the requiredC:\FlexLM
files:   , and your license ) file.  You canLUXION.exe, lmgrd.exe (.lic
always re-install these files using the provided server software.

2. Launch  and go to the  tab.  Enable LMTools Start/Stop/Reread F
 and click .  You may also stoporce Server Shutdown Stop Server

the  service within the Windows Services dialog (KeyShot Floating s
).ervices.exe

3. Click .  You may also start the  servStart Server KeyShot Floating
ice within the Windows Services dialog ( ).services.exe

4. Open the  file inside your  folder (this folderdebug.log C:\FlexLM
contains the licensing software). The debug log will reference your
license file and tell you that the server started on your computer
system.

On Mac OS X

1. Make sure that you have started the service and that you receive a
confirmation prompt when you click  inside the Start KeyShot License

 application. Press .  You can now click .  IfManger OK Service Status
your status window doesn’t show any errors, then your license service
is running properly.  You can skip the instructions below and start
KeyShot. 

2. If it doesn't start, Open KeyShot Pro Floating

3. Edit the port number so that it matches with KeyShot License
Manager. Click .OK

4. KeyShot will launch. You can click  once more on the Server Status K
 application. The server status window will telleyShot License Manager

you that your service is up and running.

 

Technical Tip: If results are not consistent with the above, please reference other possible solutions in the troubleshooting guide. You may also
contact Luxion Customer Support at support@luxion.com for assistance.

 

Server Error: Unknown Hostname

Reason:  The licensing software (lmgrd) is unable to read the computer's hostname within your Mac's /etc/hosts file.

How To Fix It:

1. Open Terminal. app.

2. Type the following command cd /etc/

3. Press Enter.

4. Type the following command: sudo vi hosts

5. Enter password (no characters will appear as you type). If you think you made a mistake, simply delete and start over.

6. Press Enter.

7. Press the "i" key to go into "insert" mode.

8. There are two columns here, IP on the left and hostname on right. Move the cursor to the end of the last entry and press Enter to enter a new
row.

9. Enter the IP address of the local machine. If you are not sure of your local machine's IP address, please consult your IT department.

10. Add a couple spaces until your cursor is under the previous hostname and enter the hostname.  To find your computer hostname go to
System Preferences.app > Sharing. 



11. When you are through editing press the "esc" key.

12. Type the following command: :wq

13. Press Enter. You need to type the colon ":: and WQ stands for "Write" and "Quit".

14. With the computer's IP address and hostname in place, you can now try to stop and start your license service once more.

Technical Tip: You may also contact Luxion Customer Support at   for assistance.support@luxion.com

Server Error: License File Not Found

Reason:  The licensing software (lmgrd) is unable to read the license file in your FlexLM folder.

How To Fix It:

1. Browse to C:/FlexLM.

2. Right-click the FlexLM folder and select Permissions.

3. Select "Properties"

4. Disable "Read only"

5. Go to the Security tab

6. Click the Edit button. Ensure that all users have read and write permissions

7. Click Apply and OK

8. Click Apply and OK once more.

9. Once all users have read and write permissions into the FlexLM folder and its contents, re-start the license service from LMTools.

Technical Tip: You may also contact Luxion Customer Support at   for assistance.support@luxion.com

Client Error: Looping Prompt
Reason: This means that KeyShot is unable to connect to KeyShot License Manager on your license server.

How To Fix It:



On Windows PC

1. Server status - Is your license server running properly? You can
check the service status within the debug.log file (found inside your

 folder). If you find any problems, see serverC:\FlexLM
errors for troubleshooting.

2. Computer connection - Make sure that your client computer
can ping the license server and that your client computer can “see”
the server in your office network. Contact your IT department if you
are using a VPN connection.

3.  Remember that KeyShot uses port numberPort conflict - 
27000 by default. It is possible that another application in your
computer is using this port. You can try to change the port number
in the license first and then inside KeyShot Pro Floating. Please
refer to instructions on how to  .change the port number

4.  Turn off the firewall on the serverFirewall/Anti-virus settings - 
and the client. If this is already the case, then you can try to add
LUXION.exe and lmgrd.exe to the list of programs allowed through
the firewall and through the anti-virus. Please consult your IT
representative for further assistance with firewall/anti-virus settings.

5.  Depending on yourClient Environment Variable/Registry - 
system’s restrictions, it is possible that KeyShot is unable to write
into the registry. If so, you can manually edit this  .registry entry

On Mac OS X

1.  Is your license server running properly? You canServer status - 
check the service status inside KeyShot License Manager. If you find
any problems on the server, see server errors for troubleshooting.

2. Computer connection - Make sure that your client computer can
ping the license server and that your client computer can “see” the
server in your office network. Contact your IT department if you are
using a VPN connection.

3.  Remember that KeyShot uses port number 27000 byPort conflict - 
default. It is possible that another application in your computer is using
this port. You can try to change the port number in KeyShot License
Manager first and then inside KeyShot Pro Floating. Please refer
to instructions on how to  .change the port number

4.  Turn off the firewall on the server andFirewall/Anti-virus settings - 
the client. Please consult your IT representative for further assistance
with firewall/anti-virus settings.

5.  Depending on yourClient Environment Variable/Registry - 
system’s restrictions, it is possible that KeyShot is unable to create the
correct environment variable. If so, you can manually edit this environm

.ent variable

 

Technical Tip: If results are not consistent with the above, please reference other possible solutions in the troubleshooting guide. You may also
contact Luxion Customer Support at support@luxion.com for assistance.

 

Client Error: No Licenses Available
Reason: There are no more licenses available on the server. This means that the license server has issued all the available license seats to other
clients in your office network.

How To Fix It:

On Windows PC

1. Close KeyShot Pro Floating on one of your other clients.

2. Re-open KeyShot Pro Floating on the desired client.

On Mac OS X

1. Close KeyShot Pro Floating on one of your other clients.

2. Re-open KeyShot Pro Floating on the desired client.

 

Technical Tip: If results are not consistent with the above, please reference other possible solutions in the troubleshooting guide. You may also
contact Luxion Customer Support at support@luxion.com for assistance.

 

Client Error: Unsupported KeyShot Version
Reason: Your current floating license does not support the version of KeyShot that you are trying to open.

How To Fix It:



1.  

2.  

3.  

4.  

5.  

On Windows PC

1. Send an email to   describing the errorlicense@luxion.com
message. You will want to attach the  and your currentdebug.log
license file.

2. Once you receive your new license file, follow the license
 instructions.replacement

3.  Edit the  .registry entry

On Mac OS X

1. Send an email to   describing the error message.license@luxion.com
You will want to attach the  and your current license file.debug.log

2. Once you receive your new license file, follow the license
 instructions.replacement

3.  Edit the  .environment variable

 

Technical Tip: If results are not consistent with the above, please reference other possible solutions in the troubleshooting guide. You may also
contact Luxion Customer Support at support@luxion.com for assistance.

 

Client Error: Unknown Error

Reason:  The Unknown Error error means that your license server is running outdated software.

How To Fix It:

On Windows PC

1. Download the latest FlexLM license server update (version
11.13.1.3). You can find the latest software .here

2. Run the installer file and follow the prompts on the installation
wizard. Your destination folder path should point to your existing
license server FlexLM folder. Once the destination path is set, click
"Install" to finish the software update.

3. Go into the C:\FlexLM folder and launch LMTools.exe. Under the
Start/Stop/Reread tab, click . Then click  to re-start theStop Start
license service.

4. It is also a good idea to update KeyShot itself. You can check for
updates from the Help menu inside KeyShot.

5. Once your server is up to date and running, KeyShot will start
properly.

On Mac OS X

Download the latest FlexLM license server update (version
11.13.1.3). You can find the latest software .here

Extract zip file contents into your Downloads folder first. Then,
replace the old KeyShotLicenseManager.app with the new
KeyShotLicenseManager.app.

Launch KeyShotLicenseManager.app (new). Browse to your
license file, and start the service as outlined in the License Server

.Installation

It is also a good idea to update KeyShot itself. You can check for
updates from the Help menu inside KeyShot.

Once your server is up to date and running, KeyShot will start
properly.

Pro Floating Server Changes
In the corporate world, software licensing practices vary. Companies replace hardware,
move license servers, and restrict ports every so often. The KeyShot Pro Floating
license server system provides you with tools for making adjustments to your license.

In this section:
Change Port Number
Replace License File

 

Change Port Number
When you upload your license file into KeyShot License Manager, the port number is displayed next to the hostname. KeyShot uses port number
27000 by default. We recommend leaving the port number at default if KeyShot is the only FlexNet based application in your office network.
Otherwise, you can change this number to any free port on your server computer system.

How To Change The Port Number:

https://luxion.atlassian.net/wiki/display/K6M/Replace+License+File
https://luxion.atlassian.net/wiki/display/K6M/Replace+License+File
http://keyshot.com/install/keyshot_floating_license_server.exe
http://keyshot.com/install/KeyShot_Floating_License_Server_Mac.zip
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37952209/Change+Port+Number
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37952247/Replace+License+File


On Windows PC

1. Open windows explorer and browse to  (this folderC:\FlexLM
contains the licensing software).

2. Open your license file with any text editor (e.g. Notepad, Notedp
).ad ++

3. Add a new port number to the SERVER line, put a space after
the mac address and then type the new port number. Say 27005,
and save your changes.

4. Launch LMTools and go to the  tab.  Enable Start/Stop/Reread F
 and click .  You may also stoporce Server Shutdown Stop Server

the  service within the Windows Services dialog (KeyShot Floating s
)ervices.exe

5. Click   You may also start the  servStart Server. KeyShot Floating
ice within the Windows Services dialog ( ).services.exe

6. Open the  file inside your  folder (this folderdebug.log C:\FlexLM
contains the licensing software). The debug log will reference your
license file and tell you that the server started on your computer
system.

 

On Mac OS X

1. Launch KeyShot License Manager. Click the “Install License” tab.

2. Enter a different number in the Port box.

3. Click  and then click .Stop OK

4. Click  and then click .Start OK

5. Click  to confirm that your new port number is in use.Service Status

 

 

Technical Tip: If results are not consistent with the above, please reference other possible solutions in the troubleshooting guide. You may also
contact Luxion Customer Support at support@luxion.com for assistance.

 

Replace License File
If you’ve received a new license file from us, you can easily replace the old license and update the license server.

How To Replace The License File:

On Windows PC

1. Open windows explorer and browse to  (this folderC:\FlexLM
contains the licensing software).

2. Make sure that the new license file has the exact same file name
 as your previous license.  Replace the old license file in C:\FlexLM
with the new license file.

3. Launch  and go to the  tab.  Enable LMTools Start/Stop/Reread F
 and click .  You may also stoporce Server Shutdown Stop Server

the  service within the Windows Services dialog (KeyShot Floating s
).ervices.exe

4. Click .  You may also start the  servStart Server KeyShot Floating
ice within the Windows Services dialog ( ).services.exe

5. Open the  file inside your  folder (this folderdebug.log C:\FlexLM
contains the licensing software). The debug log will reference your
license file and tell you that the server started on your computer
system.

 

 

On Mac OS X

1. Launch . Click the Install License tab.KeyShot License Manager

2. Click  and then Click .Stop OK

3. Click  and browse to your new license file in the Finder app.Browse

4. Click . Your license file will be loaded into Open KeyShot License
.Manager

5. Check that the license information is correct and click . A dialogStart
will tell you that the server has started. Click .Ok

6. Click .  Your license server’s status will appear in theService Status
service status window. The service status window will tell you how
many seats are available and how many seats have been issued.

 

 

Technical Tip: If results are not consistent with the above, please reference other possible solutions in the troubleshooting guide. You may also

https://notepad-plus-plus.org/
https://notepad-plus-plus.org/


contact Luxion Customer Support at support@luxion.com for assistance.

Pro Floating Technical Info

FlexNet licensing tools and methods are commonly utilized in the software industry.
This licensing method includes a myriad of different advanced features. In fact, there is
an entire FlexNet licensing manual on the web.  In this section, you will find definitions
to common terminology and useful information for your advanced IT specialist. 

In this section:
Silent Install (PC)
Edit Registry (PC)
Environment Variable (Mac)
Floating License Definitions

Silent Install (PC)
You or your IT department may wish to run the KeyShot Pro Floating installer for PC as a silent installation. The KeyShot Pro Floating installer 
takes the following arguments.

Commands

/S – for a silent installation.

/AllUsers – installs for all users with shortcuts in start menu.

/USERNAME=somepath – changes the destination folder for the KeyShot Resources folder. 

/FLEXLM=27000@myserver – set the FlexLM server’s port and hostname.

/D=C:\Program Files\KeyShot 7 – set the program files destination. This must be placed at the end of the command line.

/FloatingFeature=feature – set the feature to check out (if more than one is available): keyshot2, keyshot_enterprise, or keyshot_base.

/NO_AUTOUPDATE – disable updates.

/NO_CLOUD – disable KeyShot Cloud Library.

Example

keyshot_w64_7.x.x.exe /S /USERNAME=C:\Users\Luxion\Documents /FLEXLM=27000@myserver /D=C:\Program Files\KeyShot 7

Unattended Uninstall

C:\Program Files\KeyShot 7\uninst.exe /S _?=C:\Program Files\KeyShot 7

Edit Registry (PC)
Earlier you learned how to connected KeyShot Pro Floating to the license server system.  When you specify the server name in KeyShot, a 
registry entry is created.  Depending on your system’s restrictions, it is possible that KeyShot is unable to write into the Windows registry. If so, 
you can manually edit this registry entry.

How To Edit The Registry Entry

1. Click the Windows Start button and search for "regedit.exe".

2. Launch the  ( )Registry Editor regedit.exe

3. Go to .HKEY_CURRENT_USER > Software > FlexLM License Manager

4. While the  key is selected you will see a string called . If you don’t see this string, then createFlexLM License Manager LUXION_LICENSE_FILE
a new string. You can go to   and name it .Edit > New > String Value LUXION_LICENSE_FILE

Note:  You may also create the  key inside    (i.e. ).FlexLM License Manager HKEY_CURRENT_USER, Software Edit > New > Key

5. Right-click the LUXION_LICENSE_FILE string and select “Modify”.

6. Change the  to the correct port number at the server’s IP Address (e.g. 27000@192.168.1.123). Click , then close the Value data OK Registry
.Editor

7. You may now open KeyShot on your client computer.

https://www.keyshot.com/downloads/documents/guides/FlexLM-setup_guide.pdf
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37952371
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37952406
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37952452
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37952485/Floating+License+Definitions


 

Environment Variable (Mac)
Earlier, you learned how to connected  to the license server system.  When you specify the server name in KeyShot, anKeyShot Pro Floating
environment variable is created.  Depending on your system’s restrictions, it is possible that KeyShot is unable to write into the environment
variable. If so, you can manually edit this file.

How To Edit The Environment Variable

1. Open up the terminal.  Make sure you are in the home directory.

2. Type the following command to open the environment variable in vim (text editor): vim .flexlmrc

3. Press .Enter

4.  Press the  key to start insert mode.“i”

5.  Change the IP Address or hostname to the correct server location (e.g. 27000@192.168.1.123). Once done, Press  on your keyboard toESC
exit insert mode.

6.  Hold  and press the  key.Shift semicolon/colon

7.  Type the following command to write and quit: wq

8. Press . You will be brought back to the screen shown in   above.Enter step 2

9.  You may now open KeyShot on your client computer.

 

Floating License Definitions
Floating License: This is a type of license that can be accessed by various computer systems. The actual license file is saved on the license
server system. Your license file is an encoded text file that tells the license server which port to use, how many seats are available for checkout,
and when will the license expire.

Seat: The number of seats in a license file tells the license server how many client computers can check out the floating license at the same time.
This number is displayed and encoded in the license file.

License Server: The computer that hosts and manages the license file. Any Windows PC or Mac computer can be a license server. We
recommend that you select a desktop computer in your ofice network that your design team can access during regular business hours or later if
needed.

Client: In this manual, we refer to any computer in which KeyShot Pro Floating is installed as the client. If KeyShot Pro Floating is installed on
your license server, then your license server computer is also a client.

Server Hostname:  This is the name of your computer as listed under your computer network.  The hostname is a label used for identification.

Server Mac Address:  Your computer has various ways to connect to other computers on your network and to the internet.  The most common
connections are the ethernet adapter and the wireless adapter.  Each of your adapters has a unique physical address also known as the mac
address.  The KeyShot Pro Floating license is tied to your server’s mac address.

 

User Interface
This section provides information on the KeyShot user interface and its elements (windows, menus and commands). Its purpose is to explain 1)
the location of elements 2) purpose of elements 3) menus and commands and 4) customization. Information on the function of elements and how
they work are located in the latter sections.

KeyShot is a single interface built around the Real-time View of your scene. The docking windows allow scene authoring capabilities while the
floating windows contain setting and output options.

 

Main Interface Docking Windows Floating Windows Extras

Real-time View
Main Menu
Toolbar
Ribbon
Workspaces

Library Window
Project Window
Animation Timeline
Geometry View
Material Templates

Preferences
Render Options
Image Editor

Welcome Window
Hotkeys
Multi-Touch

 



Real-time View

Real-time View

The KeyShot  is the main viewport in the KeyShot user interface. AllReal-time View
real-time rendering of your 3D model will occur here. You can navigate your scene
using the camera controls, multi-select objects and right-click directly on your model or
in the area around it to view more options.

 

 

 

 

Main Menu

File

New...
Open a new blank scene in KeyShot.

Import...
Import a 3D file into an open or new scene. See Importing section for more details.

Open…
This will open a KeyShot scene, or opens the import panel.

Open Recent
KeyShot lists the last 10 scenes that were opened/saved so you can quickly open them.

Save
Save the currently open scene in KeyShot (.bip).

Save As…
Save the current scene in Keyshot (.bip) with the option to change the name of the file.

Save Package...
Save a KeyShot Package (.ksp) which includes the model, materials, environments,
textures, cameras, and backplates used in a given scene.

It is very important to use this saving method when sharing or moving a scene across
different computers.

Save Active Model Sets...
Save only the Model Set(s) displayed in order to share Model Sets with non-Pro users.

Revisions Manager...
Opens  to preview, revert to or delete revisions. To enabled theRevision Manager
Revision Manager, enable   under oBackup Revisions Edit >Preferences > General (PC) 
r KeyShot > Preferences > General (Mac).

Export (Pro)

On this page:

File
Edit
Environment
Lighting
Camera
Image
Render
View
Window
Help



Export model file to OBJ, FBX, STL, and ZPR file formats.

Connect to Onshape...
Launch the Onshape integration dialog. Onshape account required.

Exit
Quit and leave KeyShot.

Edit

Undo
Undo previous actions.

Redo
Redo an action that was undone.

Add Geometry
Add pre-installed primitives into your scene. You can also place commonly used models
into the “Models” folder in your KeyShot Resources directory.

Edit Geometry
Opens the Geometry Editor. See  for more details.Geometry Editor

Clear Geometry
Clears all geometry in the scene.

Set Scene Units
Change the set units used in the scene. For accurate results, use the same units the
model was created in.

Preferences
Set KeyShot preferences. See  for more details.Preferences

Environment

Background
Toggle background mode between lighting environment, color, and backplate image.
See Background for more information.

Ground Shadows
Toggle Ground Shadows on and off.

Occlusion Ground Shadows
Toggle Occlusion Ground Shadows on and off. Ground Shadows must be enabled for
this option to be available.

Ground Reflections
Toggle Ground Reflections on and off.

Flatten Ground
Toggle Flatten Ground on and off.

Lighting

Performance Mode
Toggle the performance mode on/off.

Basic, Product, Interior, Jewelry, Custom
Choose a lighting preset that best suits your scene. if you have a created a custom
preset, this option becomes available under .Custom

Self Shadows, Global Illumination, Ground Illumination, Caustics, Interior Mode
Toggle these settings on/off. See  for more information.Lighting

Camera

Cameras
Choose a saved camera. Cameras that are saved from your list of saved cameras is
populated here.

https://luxion.atlassian.net/wiki/spaces/K7M/pages/37953324/Geometry+Editor
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37953528/Preferences
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37957926/Lighting+Tab


Lock Camera
Lock the camera in the Real-time View.

Add Camera
Add a Camera to your saved camera list.

Tumble/Pan/Dolly
Toggle the default left mouse button action.

Perspective/Orthographic/Shift
Toggle camera lens settings. See  for more information.Lens Settings

Standard Views
Choose from the preset orthographic camera views.

Stay Above Ground
Toggle camera to stay above ground.

Grid
Enable grid. 

Ground Grid
Enable ground grid. 

Match Backplate Perspective
Enable the match backplate tool.

Walkthrough Mode
Adds a new camera and enables  navigation controls.Real-time View

Image

Resolution Presets
Select from a list of  Resolution Presets.Real-time View

Lock Aspect
Toggle Lock Aspect of the .Real-time View

Lock Resolution
Toggle Lock Resolution of the .Real-time View

Render

Pause Real-time Render
Toggle pause of the .Real-time View

Render NURBS
Toggle on/off the display of NURBS in the .Real-time View

Motion Blur
Toggle on/off the display of Motion Blur when animations are present in the scene.

Save Screenshot
Create an image file of the current Real-time View.

Add to Queue
Create a render job in the using the current Render Options.Render Queue 

Render
Open the  window.Render Options

View

Model Sets
Cycle Model Sets or select a specific Model Set from the list.

Show Fullscreen
Toggle fullscreen mode.

Presentation Mode
Toggle presentation mode.

https://luxion.atlassian.net/wiki/spaces/K7M/pages/40106638/Lens+Settings


Heads-Up Display
Hide or show the heads-up display which contains frames per second, time and number
of samples the  has been rendering, the amount of triangles and NURBSReal-time View
in the scene, the resolution, and the current focal length of the camera.Real-time View 

Show Coordinate Legend
Hide or show the coordinate legend on the lower left corner of the real-time render
window.

Selection Outlines
Toggle selection outlines to be shown.

Show Light Sources
Hide or show physical light sources.

Window

Toolbar
Hide or show the .Toolbar

Ribbon
Hide or show the .Ribbon

Cloud Library...
Hide or show the   in your default browser.Cloud Library

Library
Hide or show the   window.Library

Project
Hide or show the   window.Project

Animation...
Hide or show the   window.Animation

KeyShotXR...
Open the   wizard (only available with applicable licenses).KeyShotXR

Show Geometry View
Hide or show the window.Geometry View 

Material Templates...
Hide or show the   window.Material Templates

Studios
Hide or show the   window.Studios

Configurator Wizard
Hide or show the  .Configurator Wizard

Scripting Console...
Hide or show the   console window.Scripting

Enable Docking
Toggle to allow window docking in the Real-time Viewer.

Dock Windows
Auto-docks all open windows to default locations.

Restore Tab Order
Restores the default tab order for the Library and Project windows.

Help

Help...
Loads  for quick access to the Luxion Support staff, FAQs,https://help.keyshot.com/
Troubleshooting and more.

Manual...
Loads the KeyShot online manual, which also contains links to download the PDF
manual.

Hotkeys Overview...

https://help.keyshot.com/


Displays the KeyShot hotkeys panel (or toggle off/on using the  ).K-key

Welcome Dialog...
Displays the Welcome Window for access to the latest learning and 'What's New'
content along with recent and demo scenes.

Learning
Opens the “Keyshot Learning” page for tutorials, webinars and quick tips.

Register License...
Opens the KeyShot license registration window.

Activate KeyShotXR...
If you have purchased the KeyShotXR add-on separately, click here to activate it.

Deactivate License on this Computer...
Deactivate your license so it can be used on a different computer.

Show License Information...
Shows KeyShot version and active licenses.

Disclaimers...
Opens disclaimers pertaining to KeyShot partners.

Check for Updates...
Checks online for the latest version of KeyShot. Requires an internet connection.

Log...
Opens log window to view the source of any errors.

About...
Displays the KeyShot About window, including KeyShot version number and link to
Disclaimers

 

Related pages:

There are no related labels.

Toolbar

KeyShot Toolbar

The Toolbar provides quick and easy access to the most common windows and features in KeyShot.  The center grouping of icons provides a
general order of operations when working in KeyShot from Import to Render. You can right-click on the Toolbar for icon size options and the
ability to disable text. Click and drag on the handle on the left side of the Toolbar to tear it off from the main window to leave it floating or to dock
along the top or either side.

Cloud Library
Opens  in your default browser. See   for more details.https://cloud.keyshot.com/ Cloud Libary

Import
Opens the browse to file dialog to import scenes and 3D data into KeyShot. See  for more details.Import and Model Setup

Library
Opens the Library window. See   section for more details.Library Window

Project
Opens the Project window. See   for more details.Project Window

Animation
Opens the Animation Timeline and Animation Properties window. See   for more details.Animation Timeline

KeyShotXR

https://cloud.keyshot.com/
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37959021/KeyShot+Cloud
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37954154/Import+and+Model+Setup
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37952915/Library+Window
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37953008/Project+Window
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40120601/Animation+Timeline


Opens the KeyShotXR Wizard. See   for more details.KeyShotXR

Presentation
Enters full-screen Presentation Mode. This button is only displayed on the Toolbar for KeyShot Pro users if the Configurator has been set up in
the scene. See for more details.Configurator 

Render
Opens the Render window. See  for more details.Render 

Screenshot
Takes a Screenshot of the real-time view and saves it to your Renderings .resources folder

 

 

 

Ribbon

The KeyShot Ribbon 

The Ribbon provides quick access to commonly used settings, tools, commands, and windows in KeyShot.

Workspaces
Select a predefined , create and manager your own, or select between the Light and Dark theme interface.Workspace

CPU Usage
Select the number of cores used for the real-time render window.

Pause
Pauses real-time rendering.

Performance Mode
Toggle on to lower real-time render settings for faster performance. Performance Mode is also accessible via the Lighting tab.

NURBS Mode (Pro Only)
Enables NURBS Data to be rendered in the realtime rendering window.

Region (Pro Only)
Enables Region rendering.

Move Tool
Enables the Move Tool and prompts to make a selection if nothing is already selected.

Tumble, Pan, Dolly Camera
Select the default left mouse button behavior. This is especially helpful when working on a laptop with only a trackpad.

Perspective
Quick access to the Camera Perspective value.

Add Camera
Add a new Camera to your saved Camera list.

Cycle Cameras
Cycle through saved Cameras.

Reset Camera
Reset the current Camera to its saved state.

Lock Camera
Lock the properties of the current Camera.

Add Studio
Add a new Camera to your saved Camera list.

Cycle Studios
Cycle through saved Studios.

Studios

https://luxion.atlassian.net/wiki/spaces/K7M/pages/37958680/KeyShotXR
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40105883/Configurator
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37953680/Render
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37950074/Resource+Folder
https://luxion.atlassian.net/wiki/spaces/K7M/pages/39977306/Workspaces


1.  

2.  

3.  

4.  

Show/hide the  window.Studios

Material Templates
Show/hide the  window.Material Templates

Geometry View
Show/hide the  window.Geometry View

Configurator Wizard
Opens . Configurator Wizard

 

 

Workspaces
 allow you to select preset user interface (UI) arrangements or save yourWorkspaces

own custom arrangements of the KeyShot UI to best suit the way you work.
Workspaces remember window dock state, position and size, Library and Project tab
order, tab visibility, torn-off tab state, Toolbar and Ribbon position and Ribbon icon
visibility.

Using Workspaces

The  at the top of the KeyShot UI now contains a dropdown menu at the far leftRibbon
where you can select, add, and manage Workspaces. To create your own custom
Workspace make adjustments to any of the items mentioned above, click the Workspac

 dropdown and select es Add… to launch a name entry field and save. To save changes
to an existing Workspace click Apply Changes… To adjust display order, import, export,
or delete Workspaces click Manage...

Theme Options

KeyShot has both light and dark theme options. From the  dropdown, select Workspace
 or .Light Theme Dark Theme

On this page:
Using Workspaces
Theme Options

Library Window
This KeyShot  is where preset resources such as Library Materials, Colors,

and  are stored. Any content displayed hereEnvironments, Textures,   Backplates
is sourced from the locations set for KeyShot resources in , FolderPreferences

. Click on any of the upper tabs to display related assets. The Library is set upLocations
to work like a file browser in an operating system. You can add folders by manually
placing them in the KeyShot resources folder through your OS, or by clicking the “Add
Folder” button. You can refresh content by clicking the refresh button, and you can
import or export content by clicking either the import or export button. You can also
search the Library by typing in the search field in the upper right corner.

The Library is split horizontally into two view panes. The top pane shows the folder
structure and the bottom pane shows the content of the currently highlighted folder as
thumbnails. The thumbnail sizes can be scaled up or down with the scale slider at the
bottom of the Library window. You can drag and drop content from the Library by
clicking and dragging any item from the lower pane into the real-time window.

More Material, Textures, Environments, and Backplates are available on KeyShot Cloud
.

In this section:

Materials Tab
Colors Tab
Environments Tab
Textures Tab
Backplates Tab
Favorites Tab

Materials Tab

The  tab in located in the  window and contains all the preset and saved materials in your library.Materials Library

Search
Type in any keyword to search for a material by name.
Add Folder
Click this button to add custom material folders.
Import
Import a KMP material file.
Refresh

https://luxion.atlassian.net/wiki/spaces/K7M/pages/40115890/Studios
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37953457/Material+Templates
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37953211/Geometry+View
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Refresh material list if any changes were made.
Folder Tree
Contains the folder structure of the material folders.
Material Thumbnails
Mat ball swatches of materials within the selected folder.
List/Thumbnail Toggle
Switch displaying the materials with thumbnails and in a list view.
Zoom Slider
Slide to change the size of the tthumbnails. You can also use +/- to change in steps.
Upload to Cloud Library
Click this button to upload a custom material to the Cloud Library.
Export
Export a saved material as a KMP file.
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2.  

3.  

4.  

5.  

Colors Tab
The  tab contains all preset color libraries and saved colors.Colors

Search
Type in any keyword to search for a color by name.
Add Folder
Click this button to add custom color folders.
Import
Import a KCP or CSV color file.
Refresh
Refresh color list if any changes were made.
Color Search



5.  

6.  

7.  

8.  

9.  

10.  

1.  

2.  

3.  

Opens color picker panel to search by closest color match.
Folder Tree
Contains the folder structure of the color folders. It contains folders for RAL and
Pantone Color Libraries.
Color Swatches
Displays color swatches within the selected folder.
List/Thumbnail Toggle
Switch between displaying the color with thumbnails and in a list view.
Zoom Slider
Slide to change the size of the thumbnails. Use +/- to change in steps
Export
Export a KCP color file.

Environments Tab
The  tab contains all preset environments and any saved environments inEnvironments
your library.

Search
Type in any keyword to search for an environment by name.
Add Folder
Click this button to add custom environments folders.



3.  

4.  

5.  

6.  

7.  

8.  

9.  

10.  

1.  

Import
Import a HDR, HDZ, EXR, DDS file.
Refresh
Refresh environments list if any changes were made.
Folder Tree
Contains the folder structure of the environment folders.
Environment Thumbnails
Thumbnails of environments within the selected folder.
List/Thumbnail Toggle
Switch displaying the environments with thumbnails and a list view.
Zoom Slider
Slide to change the size of the thumbnails. Use +/- to change in steps.
Upload to Cloud Library
Click this button to upload a custom environment to the Cloud Library.
Export
Export environment file.

Textures Tab
The  tab contains all preset and saved textures in your library.Textures
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8.  

9.  

10.  

Search
Type in any keyword to search for a texture by name.
Add Folder
Click this button to add custom texture folders.
Import
Import an image file.
Refresh
Refresh texture list if any changes were made.
Folder Tree
Contains the folder structure of the texture folders.
Texture Thumbnails
Thumbnails of textures within the selected folder.
List/Thumbnail Toggle
Switch between displaying the textures with thumbnails, or a list view.
Zoom Slider
Slide to change the size of the thumbnails use +/- to change in steps.
Upload to Cloud Library
Click this button to upload a custom texture to the Cloud Library.
Export
Export an image file.
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8.  

9.  

10.  

Backplates Tab
The  tab contains all preset or saved backplates in your library.Backplates

Search
Type in any keyword to search for a backplate by name.
Add Folder
Click this button to add custom backplate folders.
Import
Import an image file.
Refresh
Refresh backplate list if any changes were made.
Folder Tree
Contains the folder structure of the backplate folders.
Backplate Thumbnails
Thumbnails of backplates within the selected folder.
List/Thumbnail Toggle
Switch between displaying the backplates with thumbnails, or a list view.
Zoom Slider
Slide to change the size of the thumbnails use +/- to change in steps.
Upload to Cloud Library
Click this button to upload a custom backplate to the Cloud Library.
Export
Export an image file.
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3.  

4.  

5.  

6.  

7.  

Favorites Tab
The  tab allows you to organize commonly used resources into collections forFavorites
a faster workflow. Right-click a resource in your library, select , andAdd to Favorite
select the folder you would like to add the resource to or select  toAdd to new Favorite
create a new collection.

Search
Type in any keyword to search for a resource by name.
Add Folder
Click this button to add a favorites folders.
Refresh
Refresh favorites list if any changes were made.
Folder Tree
Contains the folder structure of the favorites folders. Each favorites folder
contains categories for backplates, colors, environments, materials, and
textures.
Favorites Thumbnails
Thumbnails of resources within the selected folder.
List/Thumbnail Toggle
Switch between displaying the favorites with thumbnails, or a list view.



7.  Zoom Slider
Slide to change the size of the thumbnails use +/- to change in steps.

Project Window
The  window contains all the setup and setting for everything in your scene,Project
organized into six tabs:  and .Scene, Material, Environment, Lighting, Camera Image
Show/hide the Project window with the Space bar. 

In this section:

Scene Tab
Material Tab
Environment Tab
Lighting Tab
Camera Tab
Image Tab

Scene Tab
The   tab contains all the items in your scene: Models, Cameras and Scene Sets. Scene

https://luxion.atlassian.net/wiki/spaces/K7M/pages/40119201/Scene+Tab
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40119265/Material+Tab
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40119346/Environment+Tab
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37957926/Lighting+Tab
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40119416/Camera+Tab
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40119480/Image+Tab


Material Tab
The   tab is where you can edit the properties of your material such as changingMaterial

the roughness, adding textures or labels. The texture icon   denotes settings that are
able to have textures applied.

Environment Tab
The   tab is located in the  window and is where you can add andEnvironment Project
edit the HDR lighting of your scene as well as the background and ground properties.

Settings

The  tab located below the  and HDRI preview allows you toSettings Environment List
control the properties of the selected Environment.

HDRI Editor

The  tab HDRI Editor located below the Environment List and HDRI preview allows you
to edit the selected HDRI, add light pins and change background options.

On this page:
Settings
HDRI Editor

Lighting Tab

The  tab contains different Lighting Presets to make applying global lightLighting
settings faster. Five presets options are included with an additional option to save your
own custom preset. The presets include: 

Performance
This preset disables light source materials and shadows with reduced bounces
for the fastest performance possible. This is useful for scene setup and quick
manipulation.

Basic
This preset provides simple, direct lighting with shadows for basic scenes and
fast performance. This is useful for rendering simple models illuminated by the
environment.

Product
This preset provides direct and indirect lighting with shadows. This is useful for
products with transparent materials illuminated by the environment and local
lighting.

Interior
This setting features direct and indirect lighting with shadows that is optimized for
interior illumination. This is intended for complex interior illumination with indirect
lighting; although it can also be used to avoid noise created by local lights and
provide more accurate sampling of HDRIs with very small and strong light
sources such as Sun & Sky. 

Jewelry
This setting features the same settings as the Interior preset with the addition of
Ground Illumination, increased Ray Bounces, and Caustics.

Custom
This preset allows complete control over lighting options with the ability to save
and load presets. To add a new preset, adjust your settings, then select the '+'
symbol.



 

Camera Tab

The   tab is used to create cameras to capture the desired area of your projectCamera
as well as various effects to enhance your camera view.

Camera List

The camera list is the space where you can find all the cameras and studios that you
have created.

By default camera list only has the   Once more cameras are added,Free Camera.
clicking on any of them will make it active. The list will also let you know whether the
camera is in an   state. unsaved



On the right side of each camera the lock icon will enable you to lock or unlock the
camera. When locked, no changes can be made to that camera.

Add new camera button

The add camera button can be found on the left of the  As its nameCamera List. 
indicates, you can use the button to add a new camera.

Add Camera and Environment Studio

The   can be found on the left of the Add Camera and Environment Studio Camera List. 
As its name indicates, you can use the button to add a new camera and add it to a new
studio.

Remove current camera

The   button will delete the camera or studio that is selected inRemove current camera
the list.

Reset camera

The   button will move the camera back to its last saved location.Reset camera

Save current camera

The   button saves the camera or studio that is currently selected inSave current camera
the list.

Position and Orientation

While the camera position can be changed by clicking and dragging the scene, this
section will give you a more precise way of editing the camera.

Spherical

Choosing the   radio button will give you the camera adjustments relative to theSpherical
"target" (looks-at point).

You can imagine the camera being positioned on a sphere around the target.

The   is the radius of that sphere.Distance

The   is when the center of the camera lens is pointed to the right or the left ofAzimuth
the target (global Y-axis).

The   is when the center of the camera lens is pointed higher or lower than theInclination
target (global X-axis and Y-axis).

The  is when the camera is rolled to the right or the left without changing theTwist 
position.

Absolute



Choosing the   radio button will give you the camera adjustments relative to theAbsolute
global X-axis, Y-axis, and Z-axis.

Position

You can use the   adjustments to change the camera position relative to thePosition
global axis (X-axis, Y-axis, Z-axis).

Target

You can adjust the target manually by changing these values. They are relative to the
global axis as well but with (0,0,0) set to the selected target.

Keep View Direction

If the checkbox is not checked, the camera will keep looking at the target while the Posit
 values are changed. If the checkbox is checked, the camera direction will be keption

and therefore the   point will change as the   is changed numerically.Target Position

Twist

The  is when the camera is rolled to the right or the left without changing theTwist 
position.

Set Camera Target

This button will enable you to click on a surface of the model to set the camera target. 

On the right of the button, the position of the selected point is displayed as coordinate
values.

Walkthrough Mode

The Walkthrough Mode widget has controls for navigating your KeyShot scene in
first-person.

Eye height

The eye height indicates the height of the camera in relation to the lower object.

Lock Eye Height
Locking the eye height will keep the camera at a constant height and will ignore the
ground detection setting covered below.

Ground Detection



Ground detection will automatically adjust the camera height in order to keep it at the
set Eye Height specified above. If you move towards an object such as stairs, the
camera will appear to be going up the stairs and will respect the "new ground".

Collision Detection
Selecting this setting will keep you from moving through objects. This is used to make
the walkthrough more realistic by not allowing you to move through objects that you
should not be able to go through.

Arrows
Click and hold the arrows to "walk" around your scene in the arrow's direction.

Sensitivity
Like its name describes it, this adjustment will control the sensitivity of the controls in
order to move around the scene in Walkthrough mode. You can either move the slider
around or type a value in the box.

Accept/Cancel

Clicking the   at the bottom right cancels any changes and deletes the cameraX
from the list.
Clicking the   at the bottom right accepts any changes and saves theV
Walkthrough camera.

Standard Views

The standard views dropdown will let you quickly choose from one of the predefined
camera positions.

Grid

This dropdown will let you display the composition grid on the camera lens.

Stay Above Ground

As its name indicates the   checkbox enables you to control whetherStay Above Ground
or not you would like the camera to be able to go beneath the ground plane imaginary
ground.

Lens Settings

As the title indicates, this section allows you to change the camera lens settings. 

Perspective

The perspective lens settings allow you to change the focal length of the camera along
with the Field of view. For that you can use the sliders or input your own value into the
editing box.

Perspective lens settings also gives you the ability to turn on Stereo mode and Depth of
Field (More about this below).

Orthographic

Orthographic lens settings gives you the ability to enable the   optionDepth of Field
(More about this below).

Shift

The   lens settings allow you to shift the lens without moving the camera in order toShift
control the view. This mode enables you to control the   the   tFocal length, Field of View,
he  and the Vertical Shift,  Horizontal Shift.

Ground Grid

The   as its name gives away will turn on a ground grid to help withGround Grid
composition of the scene.

Panoramic

This option gives you the ability to create a   lens in order to outputSpherical
environment that can be used in other scenes or to render out a spherical image to use
in certain VR headsets. For more information please go to the  page.Virtual Reality

Stereo

https://luxion.atlassian.net/wiki/spaces/K7M/pages/40111433/Virtual+Reality


The   mode will allow you to either render a VR-ready image that can be viewedStereo
through a head-mounted VR display or to see the scene in real-time through a VR
headset such as the Oculus Rift or the HTC vive. For more information please go to the 

 page.Virtual Reality

Image Tab
The   tab allows you to set the resolution of your scene as well as change theImage
brightness, gamma and other effects.

Animation Timeline

Animation Timeline Interface

Time Stamp
This will show where the preview line currently is on the timeline.

Current Time Indicator Line
This line is the marker for the where in the timeline the real-time render window is
rendering from. When you play a real-time preview, this line will move with in time with
the animation. Click and drag the line to scrub to a point in the animation you would like
to preview.

Start/End Markers
Use this to designate the actual animation to be rendered. The space between these
markers is called the “work area.”

Ruler
This shows the timeline in the units chosen (seconds or frames.)

Nodes
Each animation is represented in the timeline as a colored bar called a “Node.” Most
nodes can be selected at the ends and dragged to change the duration of the
animation. Click on the body of the node to move along the timeline. Hold SHIFT while
dragging to snap to another node.

Folder Nodes
Yellow Nodes are “Folder Nodes.” Changing the duration and location of a folder node
affects all animation nodes contained within it.

Node List
This lists all animation nodes and folders. Use the checkboxes to toggle the active state
of the animation nodes.

In this section:
Animation Timeline Interface
Timeline Toolbar

https://luxion.atlassian.net/wiki/spaces/K7M/pages/40111433/Virtual+Reality


Timeline Toolbar

Animation Wizard
This opens the Animation Wizard.

FPS pull down
Select from common frame rates used in video production.

Real-time Preview Buttons
These buttons will allow you to quickly jump to the beginning or end of your animation,
scrub through the animation one frame at a time, and play a real-time preview of your
animation in the real-time render window. To see a more accurate portrayal of materials
and motion, click the “preview” button on the animation toolbar.

Loop
Enable this to loop the animation when playing in the real-time window.

Motion Blur
Enable this create motion blur in your rendered animation output.

Timeline Settings
Click the settings icon to open the settings panel where you can select from Max

 to limit the render time of the preview, or choose seconds per frame Max samples per
 to limit the quality of the preview.frames

Render Preview
Click this button to begin rendering a small video file of your animation with more
accurate results than the realtime preview.

 

Zoom Slider
Use this to change the scale of the Animation Timeline.

Geometry View Window

The Geometry View window provides a secondary OpenGL viewer for use as a
secondary view for lighting, camera or animation setup.



1.  

2.  

3.  

4.  

5.  

6.  

Geometry View Toolbar

Settings
Set the background color and customize what is visible: ground grid, lights,
cameras, etc.
Display Style
Controls your model's display style: shaded, flat, wireframe, shaded wireframe,
and bounding.
Camera Type
Choose to sync with the active camera or navigate independently in this view.
Standard Views
Snap to a pre-defined standard camera view: front, right, top, etc.
Move Tool
Click this button to launch the Move Tool.
Edit Geometry
Click this button to launch the Geometry Editor.



1.  

Material Template Window
The   window can be accessed from  under the Material Templates Window Main Menu.
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9.  

10.  

Search
Type in any keyword to search for a material template.
Add Template
Click this button to add a material template.
Import
Import a KMTP material template file.
Export
Export a KMTP material template file.
Delete
Click this button to delete a material template.
Material Templates List
Contains a list of all material templates available in your resources folder.
Add Rule
Click this button to add a rule.
Delete Rule
Click this button to delete a rule.
Template Rules
Contains a list of all the rules in the template.
Apply
Applies the template to your scene or selection.

Welcome Window
The KeyShot Welcome Window will appear after you launch KeyShot. The Welcome
Window will display:

Recently opened scenes
Latest KeyShot News
Latest KeyShot Tips

Click on a recently open scene to open it immediately or select  or Import Model Open
 to load another model or scene.Scene

To disable the Welcome Window on startup, uncheck  in the lower leftShow at Startup
hand corner. To display the window again at startup, go to  and in the Edit, Preferences

 section, select .General Show news window at application start up
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Hotkeys

Hotkeys

Learning and using the KeyShot hotkeys will speed up the process of working inside
KeyShot. You can access the list of hotkeys and their functionality by pressing the K-ke
 on PC or Mac. A downloadable version of hotkeys for Mac and PC is available .y here

Hotkey Overview

Display the  window by hitting the  or selecting Hotkey Overview K-key Help, Hotkeys
 (Windows) or  (Mac).Overview... KeyShot, Hotkeys Overview...

Setup/Details...
Opens the Hotkeys Preference window to set custom hotkeys.

Save as Image...
Allows you to save an image of the Hotkey Overview for reference or print.

Customizing KeyShot Hotkeys

KeyShot also allows you to assign custom hotkeys for many KeyShot commands. The
Hotkeys preferences can be accessed by selecting  and selecting the Edit, Preferences

 section or by pressing the  to show the  where you willHotkeys K-key Hotkeys Overview
see a button for  in the bottom right corner. This will take you to the Setup/Details... Hotk

 section of the   page. Here you can set custom Hotkeys for any of theeys Preferences
listed actions.

 

In this section:
Hotkeys
Hotkey Overview
Customizing KeyShot
Hotkeys

Multi-touch
KeyShot supports multi-touch input for touch-enabled screens and tablets. The following
gestures can be used on the touch screen when running KeyShot:

1 Finger – Tumble camera
2 Finger Pinch – Zoom
3 Finger Drag – Pan
5 Finger Touch – Reset camera
Tap and Hold – Access right mouse button menu
Single Finger Drag and Drop – Access Library assets

 

 

 

 

Tessellation Settings Window

The Tessellation Settings window can be accessed by right-clicking your model or part and selecting .Re-Tessellate

Tessellation Quality
The quality of your surfaces.  A lower value will yield rough surfaces. A higher value will yield smooth surfaces. 
Angle Tolerance
The maximum allowed angle measurement between adjacent triangles on your model's surface.
Distance Tolerance
The maximum allowed distance deviation – expressed as a percentage of the model's bounding box – measured from any triangle to the
actual NURBS surface. A lower value with yield smooth surfaces.
Maximum Edge Length
The maximum side length – expressed as a percentage of the model's bounding box – for any one triangle on your model's surface. A
lower value will yield smooth surfaces.
Tessellate
Click to make your model appear in the Tessellation Preview at the specified Tessellation Quality.
Apply
Click to Apply the Tessellation Quality to your model in the real-time view.
Tessellation Preview
Shows you a preview of the detail on your model's surface.

https://www.keyshot.com/?ddownload=332494
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10.  

11.  

Triangles
Displays the total number of triangles that make up your model's surface.
Appearance
Select Wireframe for a polygon view or Glossy to see how smooth the surfaces will look.
Cancel
Click to undo any changes to your model's tessellation and close the Tessellation Settings window.
Done
Click to accept your changes and apply them to your scene. Note that you cannot undo the changes once you click Done.

Import and Model Setup
Overview

This section covers import, model setup and working with 3D CAD data. With KeyShot,
you can directly import all major 3D file formats, plus KeyShot has many free plugins for
3D modeling software. On import, KeyShot will automatically recognize your model's up
orientation and match it. Other import options allow you to quickly adjust the location
and import quality. 

KeyShot allows you to control the model units, show/hide parts, group, duplicate
parts/assemblies and create patterns of your imported data. We'll start with bringing



your model in, then go over navigation and manipulating the models in your scene. In this section:

Supported File Formats
Import Dialog
KeyShot Plugins
Scene Units
Scene Tree
Hiding And Showing Parts
Regrouping Parts
Moving Models and Parts
Duplicating Models
Physical Lighting
Pattern Tool
Rounded Edges
Re-Tessellate
Revision Manager
Geometry View
Model Sets

 

Supported File Formats
KeyShot supports the following 3D file formats on both Mac and PC.

3Ds Max (plugin for Windows only)
ALIAS 2017 and prior (needs to be installed)
AutoCAD (.dwg and .dxf)
CATIA v4-6 (.crg, .catpart, .catproduct, and .catdrawing)
Cinema 4D R18 (.c4d) and prior
Creo 4.0 and prior
Inventor 2017 and prior
Maya 2017 and prior (needs to be licensed)
NX 11 and prior
Onshape (plugin only)
Pro/ENGINEER Wildfire 2-5
Rhinoceros 5 and prior
SketchUp 2017 and prior
Solid Edge ST9 and prior
SolidWorks 2017 and prior
IGES
JT
STEP AP203/214
STL
OBJ
Parasolid (.x_t)
Revit (plugin only)
FBX including part and camera animation
3DXML
3DS
Collada
Alembic (including deformable meshes)
Acis

 

 

 

Import Dialog
Supported file types can be imported into the KeyShot interface by pressing   onImport
the Toolbar.

Files can also be imported by dragging and dropping them into the Real-time View, or
by selecting   from the main menu. When a file is designated for import, theFile, Import…

 window will be displayed on the screen.KeyShot Import

KeyShot Import
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The KeyShot Import dialogue will appear after a file is selected for import. The following
options are available.

Location

Center Geometry

When checked, “Center Geometry” will import the model and place it in the very center
of the environment. Any original 3D coordinates for the model are removed when center
geometry is selected. If this option is not selected, the model will be placed in the same
position in 3D space where it was originally created.

Snap to Ground
When checked, “Snap to Ground” will import the model and position it directly on the
ground plane. This will also remove any original 3d coordinate information.

Keep Original
When Checked, “Keep Original” will import the model and retain the location of the
model in relation to the original origin point. Use this for multi-import assemblies with a
shared CAD origin.

On this page:

KeyShot Import
Location
Size
Up Orientation
Environment and
Camera
Geometry
Additional Options

Importing a KeyShot BIP
File

KeyShot BIP Import
Environment and
Camera



Size

Geometry Unit
Use this dropdown menu to choose the correct units the geometry was modeled in for
the first import. The model scale witll be adjusted accordingly upon second import if a
different unit is selected. Available only for .wire, .3ds, .obj and .stl file formats.

Up Orientation

Not all modeling applications define the up-axis in the same manner. Depending on
your application, you may need to set a different orientation other than the default “Y
Up” setting. Although KeyShot will recognize the up orientation of the 3D modeling
software, your model may have been built in a different orientation. If your model comes
in on its side, try setting a different orientation.

Environment and Camera

Adjust Camera to Look at Geometry

When checked, the camera will center to fit the imported geometry in the scene upon
import.

Adjust Environment to Fit Geometry

When checked, the environment will size to fit the imported geometry in the scene upon
import.

Import Cameras

This will add native CAD cameras to the KeyShot camera list. Only available for .fbx,
.ma, .mb.

Materials and Structure

Group by

Use this dropdown box to group the Scene Tree structure by Object (name), Material
(type), Layer, Shader. Different options will show depending on file format. Group by
Object/Layer retains assembly structure and naming for accuracy and flexibility. Group
by Material/Shader flattens the hierarchy for a simpler tree structure by creating a single
part for each material/shader.

Separate Materials by Part/Layer

This option will isolate linked materials to each part by prefixing a part name to each
material name.

Keep Individual Parts

This option avoids merging of objects for troubleshooting purposes. It is recommended
to try importing with this option disabled first to avoid excess separation of surfaces.
Only available for .wire, .dwg, .dxf, .igs, .obj and .skp.

Retain Materials

This option appears for Update and Add to Scene imports to ensure that materials that
have already been assigned in the scene will be applied to the new import if the native
CAD materials names match.

Import Layers as Groups

Uses Layers setup in Maya to define tree structure. Available for .ma and .mb only.

Collapse Hierarchy

Flattens tree structure to simplify Scene Tree. Available for .ma and .mb only.



Assign Materials from Library

When this is enabled materials will be auto-assigned upon import if the native CAD
materials have the same name as materials in the KeyShot Library.

Geometry

Tessellation Quality

Use this slider or input box to input the tessellation quality of the geometry. Lower
values will import faster and higher values will import slower. It is recommended to use
the default value of .2.

Accurate Tessellation

This option will optimize tessellation triangle size for improved performance. It is
suggested to enable this option if available for your import format.

Import NURBS Data (Pro)

This option will bring in NURBS geometry that ensures no faceting on the model for
completely smooth curves.

Cached Geometry

This option allows importing of an assembly without the contained part files. Available
for SolidWorks and SolidEdge only.

Calculate Normals

Available for .obj only. It is recommended to try importing first with this option disabled
as normals may already be included in the file.

Additional Options

Animation

Keyframed Transforms imports non-deformation animations. Specific Frame imports i.e.
deformations at a specified frame and does not import animations to the Timeline.
Available for .abc, .ma and .mb only.

Curve Import Options

Curve Radius Modified adjusts imported curve thickness. Available for .abc, .fbx, .ma
and .mb only.

Importing a Second Model
The import dialogue parameters change slightly when a model is already loaded in a
scene and another model is selected for import or dragged and dropped onto the
Real-time View. You will see three available options:



Add to Scene
When checked, this will add your model to the existing scene.

Update Geometry
With this checked, the newly added geometry will update the existing geometry, if part
names match, replacing the old geometry.

Importing a KeyShot BIP File

A KeyShot BIP file may also be imported. In addition to the options above, you will see
new keyshot BIP options.

KeyShot BIP Import

Open File

Select this if you want to open the scene in its original scene.

Import File

Select this option if you want to import the scene into the currently open scene.

Environment and Camera

Import Cameras

Since a BIP file is a KeyShot scene, you also have the option to import any saved
cameras within the scene. Select this option if you want to import cameras in the
KeyShot BIP.

 

 

KeyShot Plugins
KeyShot offers free plugins to make your workflow from CAD to KeyShot as seamless
and effortless as possible. By installing a plugin for your chosen CAD package, you can
export your active geometry from within the CAD application directly into KeyShot. To
download a plugin and to find the most up to date information of the plugins we offer,
please visit the  .KeyShot Plugins page

LiveLinking

Plugins developed by Luxion (and some third-party plugins) include Luxion’s LiveLinking

On this page:

LiveLinking
KeyShot Plugins
Third-Party Plugins

https://www.keyshot.com/downloads/plugins/


technology. LiveLinking connects your modeling application with KeyShot, and allows
you to update the model inside KeyShot without losing any material assignments,
animations, lighting, and camera settings.

KeyShot Plugins

3DS Max 2014-2017
Cinema 4D 17 and prior
Creo 3.0 and prior
Fusion 360
Maya 2014-2016
NX 10 and prior
Pro/ENGINEER Wildfire 4-5
Rhinoceros 5 and prior
SketchUp 2016 and prior
SolidWorks 2016 and prior

Note: All KeyShot plugins include LiveLinking

Third-Party Plugins

Geomagic Control
Geomagic Design
Geomagic Design X
Geomagic Freeform
Geomagic Freeform Plus
Geomagic Sculpt
Geomagic Studio
Geomagic Wrap
IronCAD
JewelCAD
Siemens Solid Edge*
SolidThinking Evolve
SpaceClaim
Pixologic ZBrush 4.7*
ZWSoft ZW3D

*Include LiveLinking

 

LiveLinking
Luxion's LiveLinking technology allows you to establish a link between your 3D
modeling software and KeyShot. This keeps the software separate, allowing you to
continue working and refining your model in the CAD application, then send all changes
over to KeyShot with the click of a button. All without losing any views, materials,
textures or animations already applied.

To establish LiveLinking between your CAD application and KeyShot, you must first do
 the KeyShot plugin for your CAD application.  Each plugin comeswnload and install

with its own   and unique setup instructions. For specific setup instructions, click installer
here.

LiveLinking is enabled by default and this setting is found in the Preferences window. 

 

 

https://www.keyshot.com/resources/downloads/plugins/
https://www.keyshot.com/resources/downloads/plugins/
https://www.keyshot.com/resources/downloads/plugins/
https://luxion.atlassian.net/wiki/display/KP/Installation


 

Scene Units
Scene units control model scale, light intensity, color density, and texture mapping. To
achieve physical accuracy and better control over your material and texture settings, the
scene units should match the scale of your model.  For example, if you wish to render a
car, then you should set the scene units to meters or feet. On the other hand, if you
wish to render a pair of sunglasses, then you should set the scene units to centimeters
or inches.

On this page:
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In KeyShot there are two ways to change the scene unit:  or Keep Scene Size Scale
. Scene

Keep Scene Size
Applies the proper unit-conversion multiplier to your model and the KeyShot
environment. When you convert scene units, say from centimeter to millimeter, you are
telling KeyShot to make your 1 centimeter model into a 10 millimeter model. Yes,
mathematically they are both equivalent to each other. However, in KeyShot your model
will occupy ten times as much space as it did before. Use this option when you wish to
correct model size, light intensity, color density in glass, or your camera distance slider.

Scale Scene
Re-calibrates texture mapping on your model. When you correlate scene units, say from
centimeter to millimeter, you are telling texture maps that one centimeter along your
model is now treated as one millimeter along your model. Your model will keep its size,
but texture images will re-size according to the new scale. Use this option when you
wish to correct texture units.

Changing the Scene Units

1. To change the model units, go to  and choose the new unit.Edit > Set Scene Units

2. Select one of the two options:  or .Keep Scene Size Scale Scene

 

Scene Tree
The scene tree displays models and their hierarchies along with any cameras that exist
in a scene. Animations are also represented in the scene tree in versions of the
software that include the animation add-on. Models and parts can be hidden and shown
using the check box next to the name. The check box displayed next to animations can
be used to disable and re-enable animations that are applied.

Collapsing the scene tree hierarchy can be very useful if your model has a lot of parts.
This can be achieved by right-clicking the section you would like to collapse and select
“Collapse.” The full hierarchy can be collapsed when you select “Collapse All.”

 

 



 

Hiding And Showing Parts
In some cases, materials may need to be assigned to parts that are enclosed in or
hidden behind other pieces of geometry.

Hiding Parts

To hide parts, right click on the part and select  . A single part of a model canHide Part
be shown when you right click on a part and select  . Parts can alsoShow Only This Part
be hidden through the Scene Tree.

Showing Parts

To display a hidden part, right click in the interface and select  . To bringUndo Hide Part
back all previously hidden parts select  . Parts can also be shown throughShow All Parts
the Scene Tree.

On this page:
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Regrouping Parts
Regrouping gives you the ability to organize the scene tree. Adding a group is done by
right-clicking on the top level and selecting   or  . Parts andAdd to Group Add Sub-Group
sub-assemblies can be dragged and dropped into new groups in the Scene Tree.

Important: Reordering parts and sub-assemblies will disable LiveLinking and Update
Geometry.

 

 



 

Moving Models and Parts
Models and parts can be moved by right-clicking on the model or part and selecting Mo

or . This will display the Move Tool. Highlight the different handles,ve Part  Move Model
then click and drag to translate, rotate, and scale in the X, Y, and Z directions. Click on
the check boxes that enable/disable the Translate, Rotate, and Scale options.

Snap to Pivot
The  option allows you to set a pivot point for rotation; simply click  toSnap to Pivot Pick
launch the Pivot Selection dialog. 

Once you have chosen a pivot, you can use Snap to Pivot to align the object to the pivot
point selected.
Choose an axis from which to reference your transformations. “Local” uses the axis
inherent in the part or model, while “Global” uses the XYZ coordinates from the KeyShot
scene.

Select the desired part then select  to update the position of the Move Tool.Done

Snap to Lower Object
The  option will automatically move the bottom edge of theSnap to Lower Object
object’s bounding box to the top edge of the bounding box of the part located below.

 

 



Snap to Ground
The  quickly moves the model in the Y-direction (up-down) to snap theSnap to Ground
lowest point on the model tangent to the ground plane. This is useful when the model
has been moved and is no longer touching the ground plane.

Snap Increments
To snap in 15 degree increments, hold  as you drag a rotate handle.Shift

To save your transforms, click the . To undo all transformations, click the green check re
 and the model will revert to the state before starting the move tool.d X

 

 

Duplicating Models
Models and parts can be duplicated by right clicking on them in the scene tree and
selecting ‘Duplicate’. This action duplicates the model along with any assigned
materials and animations.

On this page:



 

 

Physical Lighting
In addition to the accurate environment lighting in KeyShot, physical lighting allow you
to add different types of lighting wherever you need it. Implemented as a KeyShot
Material Type, they can be applied to any piece of geometry to turn it into a local light
source. It’s a completely different approach from traditional rendering applications
allowing more flexibility for rendering light accurately in your scene.

Light Sources
There are three Material Types Light Sources that provide different lighting capabilities:

Area Light Diffuse
Turn any object into an array of light. View and adjust the position in the real-time
window. Control the intensity of the light using Power (Watts) or Lumens.

Point Light Diffuse
Turn any object into a point light.  View and adjust the position in the real-time window.

On this page:
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Control the intensity either using Power (Watts) or Lumens.

Point Light IES Profile
Load an IES profile by clicking on the folder icon in the editor and see the shape of the
IES profile load in the material preview and in the form of a mesh in the real-time
window.

Adding Lights
A light source may be added to any objects you like. Import new geometry or use
existing geometry as a light source allowing you to easily control multiple, identical light
sources simultaneously without requiring you to import and place additional objects in
the scene.

When you drag and drop a “light material” onto an object, KeyShot will identify the light
source by adding a light bulb icon next to the object. Simply double-click on an object,
select Type, and choose one of the following three light sources from the list.

 

Pattern Tool
Right click a model on the scene tree, and select  to open the Make Pattern Pattern Tool
dialog. The  allows you to create instances of models instead of duplicates,Pattern Tool
which increases speed and decreases file size.

 

Pattern Tool Settings

Linear/Circular
Create patterns in a linear or circular formation.

Instances (Linear)
This allows you to set how many instances are created along the X, Y, and Z axes.

Count (Circular)
This allows you to sethow many instances are arrayed around an axis.

Spacing (Linear)
This allows you to set the spacing of the instances for X, Y, and Z.

Radius (Circular)
This allows you to set the distance from the instances to center or pattern axis.

Fill Angle (Circular)
The angle at which to array the instances. 360 is a full circle.

Rotate Objects

On this page:
Pattern Tool Settings

 



Instances can be rotated along the Y of each local access to dynamically position them
in the scene. Use this field to
choose how far instances
will be rotated along the Y
axis.

Scattering
Use this to randomly place
patterned objects. useful for
scenes where a more
random distribution of
objects is desired.

Displacement
This controls the amount of
deviation occurs from the
original pattern matrix.

Y Rotation
This changes the amount an
object is randomly rotated by
in the Y axis.

Center
Centers the pattern to the
scene.

Resize Environment
Automatically increase the
environment size to
accommodate all instances.

Adjust Camera
Enable this to have the
camera automatically shift to
include all instance within
the field of view.

Editing Patterns
In the scene tree, right click
on patterned object and
select “edit pattern” to open
the Pattern window to make
changes.

 

Rounded Edges

The Rounded Edges feature allows you to simulate fillets on parts. The adjustment sliders can be accessed by selecting one or more part-level
objects in the Scene Tree, which will then display the Rounded Edges accordion in the Properties sub-tab below. The  slider is unit-awareRadius
to your Scene Units. It is recommended to use a value between .01-.03 for the best results. The Minimum Edge Angle slider allows you to limit
Rounded Edges to corners greater than the set degree value.



1.  

2.  

3.  

4.  

Re-Tessellate
Models that contain NURBS data can be re-tessellated directly in the scene without
having to import the model all over again.   allows you to fine tuneRe-Tessellate
tessellation quality of entire models or individual parts in your scene. Increasing the
tessellation value will yield smoother surfaces on your model and increase scene file
size. In order to  , you must enable theRe-Tessellate  Import N  URBS Data checkbox at
import (Geometry section inside the   Import dialog).

How to Re-Tessellate:

Right-clicking on a model, part, or multi-selection of parts in the scene tree or
real-time view. Then, select  .Re-Tessellate

This will open the   dialog. Change the   Tessellation Settings Tessellation Quality
or drill down to access finer adjustments including  , Angle Tolerance Distance

, and  . For more information about settings,Tolerance Maximum Edge Length
click  .here

Click the   button to show a preview in the   dialogTessellate Tessellation Settings
, which can be displayed as a   or   representation. Wireframe Glossy

Click   and  to commit the changes to the scene.   will revert allApply Done Cancel
changes and exit the dialog.



Revision Manager

Instead of overwriting the BIP file, the Revision Manager will create a serialized backup every time that you save your scene. The result is a
.BIP.XX file (where "XX" is the revision index number) every time that you save. This allows you to revert to any saved version of your BIP file or
delete revisions that you don't need anymore.

The instructions below assume that you've enabled   under  orBackup Revisions Edit >Preferences > General (PC)   KeyShot > Preferences >
and that you've saved your scene at least twice.General (Mac) 

How to manage your revisions:

1. With your scene open, go to The Revision Manager window appears.File > Revision Manager. 

2. From the Revisions list, select the version (revision) of your scene to which you wish to revert. Then, click Revert to selected version.



3. To delete a revision, simply select it and click Delete old revisions.



Geometry View
This highly responsive OpenGL secondary viewer complements the  toReal-time View
add more capabilities and a faster workflow for setting up your scene. Some benefits of
the  are:Geometry View

Animations can be played back at a true 1:1 speed.
A secondary camera can be used to position physical lights easily in a scene.
Scene transformations and composition setup are faster.
All Camera Path Animations can be viewed and edited.

In this section:

Geometry View Settings
Display Style
Camera Type
Standard Views
Geometry Editor

Geometry View Settings

On the  , click on the gear icon   to access the Geometry View Ribbon Geometry
 panel. View Settings

Background Color allows you change the color of the   background byGeometry View
selecting the color swatch. Click each checkbox to toggle the display of the different
elements in the  .Geometry View

https://luxion.atlassian.net/wiki/spaces/K7M/pages/40121654/Geometry+View+Settings
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40121740/Display+Style
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40122108/Camera+Type
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40122189/Standard+Views
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37953324/Geometry+Editor


Display Style

On the  , click on the   dropdown   to change the Geometry View Ribbon Display Style
 of models in the  . The style choices are:  ,  , Display Style Geometry View Shaded Flat Sha

,  , or  .ded Wireframe Wireframe Bounding

Shaded
The  displays theShaded Display State
geometry with solid colors and shaded
areas.

Flat
The Flat Display State displays the
geometry with solid colors and no
shading.

Shaded Wireframe
The Shaded Wireframe Display
State displays the geometry with solid
colors and shaded areas with the
geometry wireframe on top.

Wireframe
The Wireframe Display State displays the
geometry with only a representation of
the wireframe.



Bounding Box
The Bound Box Display State displays
the geometry with wirefrme box
representations of the extents of the
model and part geometry.

Camera Type
The Camera Type options change the view mode in the Geometry View. From the Cam

 drop-down   choose a camera from these available options—era Type Active
,  , or  .Camera Perspective Orthographic

Active Camera

The Active Camera option changes the view mode to display what is seen in the frame
of the current active camera. This is the camera that is active in the Real-Time View as
well. This allows you to adjust the camera just as you would in the Real-time View.

Perspective

The Perspective option changes the view mode to display a perspective view of the
entire scene. 

Orthographic

The Orthographic option changes the view mode to display an orthographic view of the
entire scene. 

Move Active Camera Options

The Active Camera can be manipulated with a move tool inside the Geometry View.
This features makes positioning cameras in interiors much easier.

To move the camera, hit the O-key or select Window, Geometry View... to activate the
Geometry View. Set  in the Geometry View to Camera Type Perspective or Orthographic
. Right-click and select a Move Active Camera option. As the camera is moved in the
Geometry View, the Real-time View and camera properties in the Project window
update as well. Note: If a camera is locked, you will need to select Unlock Camera to
unlock the camera prior to moving it.

Move Active Camera Position

This changes the actual position of the camera. With the camera unlocked, right-click in
the Geometry View and select Move Active Camera Position. Use the Move Tool to
change the position.

Move Active Camera Target

This changes the ‘look at’ point of the camera. With the camera unlocked, right-click in
the Geometry View and select Move Active Camera Target. The Move Tool will appear
on the ‘look at’ point. Use the Move Tool to change the position.

On this page:
Active Camera
Perspective
Orthographic
Move Active Camera
Options

Move Active
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Move Active
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Note
Selecting   or   will unlink the  from the Perspective Orthographic Real-time View

 allowing you to control the two views independently of eachGeometry View
other. However, you will still see the real-time movement and position of the
active camera.



Saving Active Camera Changes

Right-click and select Save Camera to update the current camera position or target, or
select Add Camera to create a new camera. The new camera will appear in the Project 
window, Camera tab where the camera changes may be saved or added as well.

Standard Views

From the   dropdown  , you can also select a display orientation of Standard Views Fr
,  ,  ,  ,  ,   or  .ont Back Left Right Top Bottom Isometric

Note: Selecting a   when the   is selected will alsoStandard View Active Camera Type
update the  . Choose the   or     toReal-Time View Perspective Orthographic Camera Type
unlink the real-time viewing mode from the   allowing you to control theGeometry View
two views independantly of each other. However, you will still see the real-time
movement and postion of the active camera.

Geometry Editor
Enjoy the freedom of splitting surfaces, calculating vertex normals, and closing open
boundaries directly inside of the KeyShot OpenGL View.

Click  on the  ribbon and select a part from the part list.Edit Geometry Geometry View
You can also right-click on a part in the Scene Tree or Real-time View and select Edit

 to launch the  and the  dialog.Geometry Geometry View Geometry Editor

Geometry Editor Mode

Split Object Surfaces

Use the “Split Object Surfaces” option if you would like to split specific polygons from a
single part. This is useful if you would like to apply separate materials to a single part, or
when parts are modeled together and you would like to work with the separately.

Splitting Angle
Use this to let KeyShot automatically determine where you would like to split the
part based on the angle adjacent polygons. Any polygon that has a face at an
angle that is less than the value entered will be highlighted. This is useful when
the split is a clear crease or angle in the part.

Polygons
Use this to select individual polygons from the surface. Hold control while you
click on the part to highlight the individual polygons.

Show Wireframe
Enable this to show the wireframe of the part.

Split All / Split Object / Merge Selection
Once the polygons you want split are selected, click “Split All” to create a part for
each individual polygon selected, or click “Split Object” to group the selected
polygons into a single part. If you would like to merge certain split parts back,
hold shift and select the parts you would like to merge and click “Merge
Selection.” To finalize the split, click done to create the new parts in the scene
tree.

On this page:
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Split Separate Objects

Use “Split Object” when a your model has separate objects grouped into a single part.





Edit Normals

A normal is the direction that is perpendicular to a mesh surface. In a 3D model, the
directions of your normals should all be facing the same direction, other wise holes
might appear. Also if your vertex normals are not aligned, flat spots might appear on
what you thought would be a curved surface.

If your model appears to have a hole or flat areas, try to unify the normals by using the
“Edit Normals” tool. Select the faulty part, and enable the “Show Vertex Normals” and
“Show Face Normals. If you see the normal of the missing polygon pointing in the
opposite direction or if the vertex normals from adjacent polygons are not aligned, use
the “Calculate Vertex Normals”.

“Adjust the “Minimum Edge Angle” to ensure that edges that do have a crease are not
aligned as well.





Close Mesh

If you have an open polygon with a hole, Use “Close Mesh” to fill in missing polygons.

In the “Close Mesh” window, KeyShot will list the open edges of the part you selected.
You can select individual continuous holes and click “Close Selected Edges” and
KeyShot will create the polygons to fill in the hole. If you have 2 holes in a part and want
to create a solid connection between those two holes like a donut, select the 2 holes
and click “Join Selected Edges.”



 

 

Model Sets

Model Sets allow you to save independent Scene Tree variations in a single .bip file. The Model Sets interface is located in the  taProject > Scene 
b as a sidebar on the left side of the panel. When a Model Set is selected in the sidebar it's properties will be displayed in the sub-tab below and
the contained Models will be listed in the Scene Tree. Visibility of Model Sets can be toggled via the checkbox in the sidebar. Double-clicking a
Model Set in the sidebar will make it active. More than one Model Set can be made active at a time via the checkbox or right-click menu. Locking
a Model Set will lock all contained models and parts.



A new Model Set can be added by clicking the icon above the Model Sets sidebar, which will launch the Add Model Set dialog.Add Model Set 
Here you can give it a name, specify some options and see an overview of the models to be cloned into the new Model Set. You can also access
this dialog by selecting the models/parts in the Scene Tree you wish to include in the new Model Set > right-click and select Create Model Set

. from Selection



Materials

The material presets you see in the KeyShot library are created using a KeyShot Materi
Each material type has been designed to be easy to use with as few. al Type

parameters as possible. For example, the   material type will only display theMetal
parameters needed to create metals, and the   material type will have only thePlastic
parameters necessary to create plastics. The following sections will cover all of the
material types and their parameters.

The first four sections cover some common parameters that are found throughout
several material types. Since KeyShot is designed for the user to be able to create
realistic visuals with little to no experience, an understanding of these concepts is not
necessary, but can help you gain a deeper understanding of how rendering and material
creation work. 

In this section:

Assigning Materials
In-Project Library
Copying Materials
Editing Material
General Parameters
Material Types
Saving Materials
Color Library
Color Picker
Material Graph
Multi-Materials
Material Templates

 

Assigning Materials
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https://luxion.atlassian.net/wiki/spaces/K7M/pages/37953457/Material+Templates


To assign materials to models, drag and drop them from the  library onto a partMaterials
in the . Before you drop the material onto the part, you will see a previewReal-time View
of the material on the part beneath the mouse cursor. The material will not be assigned
until you let go of the left mouse button.

Once the material has been loaded from the library, a copy will be placed into the
“In-Project Library.” Any additional materials assigned to the model will also be added to
the “in-Project Library.” If the same material already exists in the “In-Project Library”, a
copy will be created and a number will be appended to that material.

In some cases a user may want to have one material assigned to multiple parts to be
able to make changes to that material, and to have the changes affect all parts. To do
this, assign the same material from the “In-Project Library” to those multiple parts. Since
it is the same material from the “In-Project Library”, any edits made to that material will
affect all parts that it is assigned to. Another method of accomplishing this is to copy
and paste the material from one part to another.

Retaining Textures and Labels

If you are dragging a material onto a part that has an existing texture or label, you can
retain them and apply them to the new material by holding  for textures, or  forAlt Ctrl
labels.

On this page:

Retaining Textures and
Labels

 

In-Project Library
The “In-Project Library” is found in the lower half of the scene tab under materials.
When a material is pulled from the material library and assigned to a model, a copy of
that material is placed in the “In-Project Library.” All materials will be represented in the
form of material ball thumbnails or in a list view.

This window will show all materials that are active within a scene. If a material is no
longer being used in the scene, it will be automatically removed from the “In-Project
Library.” For example, if a material is assigned to only one part and a new material is
assigned to that part, the previous material will be removed from the “In-Project Library”
since it is no longer used in the scene.



 

Copying Materials
There are two methods of copying and pasting materials. The most important concept
to understand when copying and pasting is that when a material is copied from one part
to another, any future edits to that material will affect both parts.

The first method is to press “Shift + Left Click” on a material assigned to a model. That
will copy the material. Next, to paste the material, press “Shift + Right Click” on another
part. That will copy the same material from the “In-Project Library” and paste it to
another part. Now, any edits made to that material will affect both parts.

The second method is to drag and drop a material from the “In-Project Library” onto a
part that does not already have that material assigned.

Shift + Left Click – Copy Material
 – Paste MaterialShift + Right Click

 



Editing Material
There are multiple methods of navigating to the material properties to make changes,
but all editing is done through the materials tab found in the project window.

The first method of accessing the material properties is to double click a part on a
model in the real-time view. That will pull up the material properties for the material
assigned to that part.

The second method of accessing material properties is to double click the material
thumbnail in the “In-Project Library.”

The third method of accessing material properties is to right click a part in the scene
tree and select “Edit Material.”

The fourth method of accessing material properties is to select the part in the scene
tree, and then in the second pane select “Edit Material.”

All material edits made will update interactively in the real-time view. For more detailed
information on material settings and types please see the Material Types.



 

General Parameters
There are four general parameters to understand about KeyShot Materials.

Diffuse Parameter
Specular Parameter
Refractive Index
Roughness Parameter

 

 

 

 

Diffuse Parameter
The  parameter will be found throughout many of the material types. The mostDiffuse
basic way to think of diffuse when working in KeyShot is a material’s overall color.
However, there is a more technical explanation of what this is that can help when
creating materials “scattered” or “spread out.” Diffuse in the rendering world refers to
how light reflects off of materials. Depending on the surface of a material, light rays will
behave differently when they hit the surface. If a surface has few or no imperfections,
like a polished surface, light rays will bounce straight off. This will produce a shiny or
reflective surface. If the surface has many imperfections, like concrete, light rays will be
scattered across the surface creating a matte look. This is why concrete is not reflective
or shiny.

The diffuse slider on many materials will control the color of the diffuse rays (left
diagram) on a material.

 

 

 

 

Specular Parameter
The  parameter is another parameter that will be found with many materialSpecular
types. Specular reflections are reflections that are bounced off a material surface
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https://luxion.atlassian.net/wiki/spaces/K7M/pages/37955282/Specular+Parameter
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without scattering. Materials appear reflective or shiny when a surface is polished and
has few to no imperfections. When the specular color is set to black, a material will have
no specular reflections and will not appear reflective or shiny. Specular color set to
white will give 100% reflectivity for that material. Metals do not have diffuse color so any
color will be derived entirely from the specular color. The specular color of plastics
should be set to a grayscale value.

The specular parameter will control the color and intensity of the specular light
reflections on a material.

 

 

Refractive Index
Refractive Index is a material parameter that is found in multiple KeyShot material
types. The term might not be familiar, but refraction is something that is seen every day.
A good example is when a person sticks their hand in a pool. The light is bent, or
“refracted” and the arm looks broken.

Refraction occurs because light travels through different media at different speeds. This
reduction in speed is referred to as a material’s refractive index (or index of refraction)
and is represented by a number. For example, water has an index of refraction of 1.33,
glass has an index of refraction of 1.5 and diamonds have an index of refraction of 2.4.
This means that light travels through water 1.33 times slower than it does through a
vacuum. Light travels through glass 1.5 times slower, through diamonds 2.4 times
slower and so on. The slower light travels, the more it is bent and distorted.

Refractive indices for different materials can be easily found online. Once the value is
found, it may be entered into the  property of a material, and will beRefractive Index
accurately represented in KeyShot.

 

 



 

 

Roughness Parameter
The  parameter is another setting that will be found on multiple materialRoughness
types in KeyShot. This is a slider that will add microscopic levels of imperfections to
surfaces to create rough materials. The diagram that explains the  caDiffuse parameter
n also help explain why materials appear rough. When roughness is added, light rays
are scattered across the surface which causes specular reflections to break up. Due to
the additional light scattering, rough materials are more challenging and take more
processing power to render than perfectly reflective surfaces.

Samples

Since glossy materials with some roughness are more complex to render, KeyShot has
a setting built in that can improve the accuracy of these rough materials. This setting is
called . This allows you to set how many rays are emitted from a pixel in aSamples
rendered image. Each ray collects information from its surrounding environment and
returns this information back to the pixel to determine the final appearance. You will see
the  slider when you click the expand arrow next to the  slider.Samples Roughness

On this page:
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Roughness Texture
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Roughness Texture

If the Roughness parameter has a checkered box  next to it, this means a texture
can be applied to control the glossy appearance of the surface. When a texture is
applied, dark areas of the texture will have a glossy appearance and white areas of the
texture will have a matte appearance. Read more on the difference between
Roughness Textures and Bump Maps .here

 

Material Types
Material Types bring the power to quickly apply real world, physically accurate material properties to your parts. Each Material Type comes preset
with settings to quickly apply or change material with the option to adjust each setting as desired. There are five categories of KeyShot Material
Types:

Basic

Diffuse
Flat
Glass
Glass (Solid)
Liquid
Metal
Paint
Plastic
Thin Film
Translucent

Advanced

Advanced
Anisotropic
Dielectric
Gem
Measured
Metallic Paint
Plastic (Cloudy)
Plastic (Transparent)
Translucent (Advanced)
Velvet

Light Sources

Area Light Diffuse
Point Light Diffuse
Point Light IES Profile

Special

Emissive
Ground
Toon
Wireframe
Xray

Other

Axalta Paint

https://www.keyshot.com/2016/difference-keyshot-roughness-bump-textures/
https://luxion.atlassian.net/wiki/display/K6M/Glass


 

 

 

 

Diffuse
The  material type is useful for easily creating any kind of matte or non-reflectiveDiffuse
material. It has only one setting, the diffuse color. Since it is an entirely diffuse material,
specular maps are not available.

Diffuse
This setting controls the color of the diffuse material. Select the color box to display the
Color Picker and select the desired color.

 

 

 

Flat
The  Material Type is a very simple material type that produces an unshaded,Flat
perfectly even color over the entire part to which it is applied. This material is often used
as a black-out material behind car grills or other meshes. It is also useful to create
“Clown Pass” areas, which has uniquely colored flat materials applied to the different
parts of a model so that these solid colors can be used to easily create selections in an
image editing software. See  to automatically create a Clown Pass.Render Passes

Color
Click the color thumbnail to launch the Color Picker, which allows you to select the color
of the material. The flat material has no shading or other surface properties. It will show
the solid color you have selected over the entire part that the material is applied to.

 

 

 

Glass
This is a simple Material Type for creating glass materials.

Compared to the  material, this material type lacks the roughness and colorSolid Glass
density settings. However, it adds the two-sided option which is very useful when you
have a part that is just a single surface (no thickness) and you want to make it reflective
and transparent, but not refractive. This is commonly used for car windshields.

Color
This sets the overall color of the glass material. Click the color box to open the Color
Picker and select your desired color.

Refractive Index
This controls how much light will bend or “refract” as it passes through parts that have
this type of material. The default of 1.5 is accurate for simulating most types of glass,
but you can increase the value to create a more dramatic refraction within the surface.

Two-Sided
This can enable or disable the refractive property of the material. When enabled, the
material will appear refractive. When it is disabled, the material will not be refractive.
You will see reflections on the surface and the surface will be transparent, but light will
not bend as it passes through the surface. Disabling this option is very useful when you
want to see things that lay behind a surface without the distorted effect that results from
refraction.

 

 

 

Glass (Solid)

The  Material Type provides a physically accurate glass material. unlikeGlass (Solid)
the simpler glass material type, you will find that solid glass simulates the effect color in
the glass accurately as it takes into account the thickness of your model.

Color
This controls the overall color of this material type. When light enters the surface, it will
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take on the color set here. The amount of color that you see in this material is highly
dependent on the transparency setting as well. If you have set a color, but it looks too
faint, skip down to the transparency section.

Transparency Distance
(Formerly ) This slider controls the depth of the color selected in the   Color Density Color
setting, depending on the thickness of the part to which the material is applied. After
setting a color in the   setting, use   to make that color moreColor Transparency Distance
or less saturated and prominent. A lower setting will show the color more in thin areas
of the model, and a high setting will make the color faint in the thin areas.

This physically accurate parameter simulates the effect you can observe by looking at
the color of the shallow water at a beach versus the deep blue of a deep ocean. Without
this you would see through to the bottom of the deepest ocean as easily as to the
bottom of a swimming pool.

Refraction Index
This controls how much light will bend or “refract” as it passes through parts on your
model that have this type of material. The default of 1.5 is accurate for simulating most
types of glass, but you can increase the value to create a more dramatic refraction
within the surface.

Roughness
Roughness on this type of material will spread out highlights on the surface similar to
what you see on other, non-transparent, materials. However, it also spreads out the
light that is transmitted through the material. This is used to create a frosted glass look.
Expand this parameter and you will see a samples setting. This can be set to a low
value to produce a more imperfect/noisy result or to a higher value to smooth out the
noise/grain for a smoother frosted look.

 

Liquid

The  Material Type is a variant of the  material that has the addedLiquid Solid Glass
ability to set the outside refractive index. This allows you to accurately create surfaces
that represent the interface between, for example, a glass container and water.

Color
This controls the overall color of this material type. When light enters the surface, it will
take on the color set here. The amount of color that you see in this material is highly
dependent on the transparency setting as well.

Refractive Index
This controls how much light will bend or “refract” as it passes through parts that have
this type of material.

Transparency Distance
(Formerly ) This slider controls the depth of the color selected in the Transparency Color
setting, depending on the thickness of the part to which the material is applied. After
setting a color in the   setting, use   to make that color moreColor Transparency Distance
or less saturated and prominent. A lower setting will show the color more in thin areas
of the model, and a high setting will make the color faint in the thin areas.

This physically accurate parameter simulates the effect you can observe by looking at
the color of the shallow water at a beach versus the deep blue of a deep ocean. Without
this you would see through to the bottom of the deepest ocean as easily as to the
bottom of a swimming pool.

Refractive Index Outside
This is an advanced, but powerful, setting that allows you to accurately simulate the
interface between two different refracting materials. The most common use for this is
when you are working on a container with liquid inside, like a water glass. In such a
scene you will need a single surface to represent where the glass and water meet. On
this surface, you have the liquid on the “inside” and therefore, you should set the
refractive index to 1.33. On the “outside,” you have the glass, and you should set the
refractive index outside to 1.5.

Transmission Out
This option controls the color of the light on the outside of the material. It is an
advanced and complex setting, but it is needed when rendering containers with liquid. In
the example of a water glass, you will need to have a dedicated surface for where the
liquid and glass meet. On this surface, you should set the color of the glass with the
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transmission out setting and control the color of the liquid with the transmission setting.
If the glass and liquid are both clear, set both transmission and transmission out to
white.

 

Metal
The  material type is a simple way to create polished or rough looking metalMetal
materials. It provides quick color adjustment, metal presets and simple settings for quick
creation of metal materials.

Metal Type

The Metal material type gives you the option to control the metal by Color or by Measur
 material preset or complex IO file. ed

Color

The Color option provides a quick preset metal appearance with control over  and Color
. Roughness

Color
This setting is visible when  is set to . This controls the color ofMetal Type Color
reflected light on the metal surface. Select the color box to display the Color Picker and
select the desired color.

Roughness
This adds microscopic levels of imperfections to the surface of the material when the
values are increased. When this is set to 0, a material will appear perfectly smooth and
polished. When the value is increased, the material will appear more rough as light is

diffused across the surface. Note: If a slider icon  appears next to the Roughness
setting, adjustment control has been added for finer tuning pf the roughness. Click on

the slider icon  to view and adjust the settings, or right-click and select  toDelete
remove them and use the  slider.Roughness

Samples
A low samples setting (8 or lower) will tend to make the surface look more noisy,
which will give a more imperfect and rough look. As you increase the value, the
noise will even out more and provide a more evenly distributed roughness.

Measured

Metal Presets
The  options includes 13 scientifically accurate metal presets including Measured Alumin
um, Brass, Chromium, Copper, Gold, Iron Magnesium, Nickel, Niobium, Platinum,
Silver, Titanium, and Zinc, along with the ability to load Complex IOR files (.ior, .nk,
.csv)  . All metal presets and Custom IOR files provide the additional ability to add an
anodized coating with control of  andFilm Refractive Index, Film Extinction Coefficient,  F

ss.ilm Thickne

Roughness
This adds microscopic levels of imperfections to the surface of the material when the
values are increased. When this is set to 0, a material will appear perfectly smooth and
polished. When the value is increased, the material will appear more rough as light is
diffused across the surface.

Samples
A low samples setting (8 or lower) will tend to make the surface look more noisy,
which will give a more imperfect and rough look. As you increase the value, the
noise will even out more and provide a more evenly distributed roughness.

Anodized
Anodized settings are available for all metal presets selected from the  dropdMetal Type
own as well as loaded Complex IOR files. The colors you see when  isAnodized

On this page:
Metal Type

Color
Measured



enabled are the result of light interfering with itself in the anodized film and can
therefore be hard to predict the outcome. However, the following setting descriptions
will help you learn better how to control it.

Film Refractive Index
The  setting for anodized metals provides more or less Film Refractive Index
reflection on the surface. Increase the value to get more reflection intensity. The
actual film color will be affected by the  . However, you can shiftRefractive Index
the colors with the   setting, so typically you will focus only onFilm Thickness
finding the desired amount of reflection with the  setting.Film Refractive Index

Film Extinction Coefficient
The  and  determines how lightFilm Refractive Index Film Extinction Coefficient
reflects and refracts through the thin film on the metal. The Film Extinction

 controls the absorption of light through the film. For small to moderateCoefficient
values, a positive extinction coefficient will darken the color but large values will
lead to a bright white metallic reflection. Use an extinction coefficient of 0 for
dielectric coatings and use a non-zero extinction coefficient for metallic coatings.

Film Thickness
Changing the  setting will shift the colors you see for the metal Film Thickness
with  enabled. Increasing the setting to a very high value will result inAnodized
the effect of layers of colored rings on the surface. It is generally a good idea to
stay within a range of 100-1000 nm.

 

Paint
The  Material Type is used when a plain, non-metallic paint appearance is desired.Paint
It provides a quick way to set a base color and then control the clear-coat on top.

Color
Color is your base layer of paint and the overall color of the material. Click the color
thumbnail to open the Color Picker and select your desired color.

Roughness
This will add microscopic levels of imperfections to the surface of the material when the
values are increased. When this is set to 0, a material will appear perfectly smooth and
polished. When the value is increased, the material will appear more rough as light is
diffused across the surface.

Samples
A low samples setting (8 or lower) will tend to make the surface look more noisy, which
will give a more imperfect and rough look. As you increase the value, the noise will
smooth out and provide a more evenly distributed roughness.

Refractive Index
This controls the intensity of the clear-coat. 1.5 is a good general starting point. If a
more shiny paint is desired, increase the value. Bringing the value down closer to 1
reduces the clear coat effect. This can be useful for making a matte finish.

 

 

 

Plastic

The  Material Type provides the basic settings needed to create simple plasticPlastic
materials. Set the diffuse (overall color) and add some specular (reflections), then adjust
the roughness. This is a very versatile material type that is used for anything from
concrete to woods.

Diffuse

 

 

Controlling Anodized Color
In general, a larger   leads to more colors andFilm Thickness/Refractive Index
an  t will darken colors and dampen variation. For allFilm Extinction Coefficien
the metal presets, even if anodized is enabled or not, the color can depend
on the viewing angle (just as with the color of real-world metals). You will
notice slight color tints at grazing angles, especially for Gold and Aluminum.



This can be thought of as the overall color of the material. Transparent materials will
have little or no diffuse color applied. Click the color box to open the Color Picker and
select your desired color.

Specular
This is the color and intensity of the reflection of light sources within the scene. Black
will completely turn off reflections, while white will provide a very shiny plastic
look. Realistic plastic does not have color in the specular value, so generally you should
use some level of gray or white. However, adding color can give the plastic material a
metallic effect.

Roughness
This will add microscopic levels of imperfections to the surface of the material when the
values are increased. When set to 0, a material will appear perfectly smooth and
polished. When the value is increased, the material will appear more rough as light is
diffused across the surface. Within the roughness parameter, you will find a samples
setting. A low samples setting (8 or lower) will tend to make the surface look more
noisy, which will give a more imperfect and rough look. As you increase the value, the
noise will smooth out and provide a more evenly distributed roughness.

Refractive Index
This controls how much light will bend or “refract” as it passes through parts that have
this type of material. The default of 1.5 is accurate for simulating most types of plstics,
but you can increase the value to create a more dramatic refraction within the surface.

 

Thin Film
Thin Film
The  material type produces an iridescent effect similar to a soap bubble.Thin Film

Refractive Index
The  setting for  provides more or less reflection on theRefractive Index Thin Film
surface. Increase the value to get more reflection intensity. The actual colors you see in
the thin film will be affected by the . However, you can shift the colorsRefractive Index
with the  setting, so typically you will focus only on finding the desired amountThickness
of reflection with the  setting.Refractive Index

Thickness
Changing the  setting will shift the colors that you see on the surface set as Thickness T

. Increasing the setting to a very high value will result in the effect of layers ofhin Film
colored rings on the surface. It is generally a good idea to stay within a range of
100-1000.

Color Filter
The  setting acts as a color multiplier for the  material type. WhenColor Filter Thin Film
the  is set to white the color of the material will be determined by the Color Filter Thickne

 setting. Less saturated colors can be used to add subtle hue shifts while fullyss
saturated colors have a greater influence. The  setting can be textured withColor Filter
color maps to create material breakups such as those seen on solar cells or to add
surface imperfections to an optical lens or automotive headlight.

 

 

 

Translucent
The  material type provides control over subsurface scattering propertiesTranslucent
that are found in many skin, plastic and other materials.

Surface Color
This controls the diffuse color of the outer surface of the material. Consider this the
overall color of the material. Something to be aware of with this unique material type is
that you will not see the translucent effect of the subsurface color if the surface color is
completely black.

Subsurface Color
This setting controls the color that light will take on as it passes through the material.
Your own skin is a great example of the subsurface scattering effect. When a bright light
shines through the thin parts of an ear or the thin skin between fingers, the light is
colored by what lies beneath the surface and comes back more red.

While the light is passing through the surface, it is bounced around in many random
directions. This creates the soft translucent effect rather than the direct refraction effect

 

 



of glass and similar materials.

For plastic materials, you will often set this color to something very similar to the surface
color, but perhaps a a bit brighter.

Translucency
This controls how deep light penetrates into and through the surface depending on the
units set under . The higher your translucency value, the more ofEdit, Set Scene Units
the subsurface color you will see coming through the surface. Higher translucency
values will also create a softer looking material.

Texture
This affects the setting. This color multiplies and blends the surface color.Surface Color 
For instance, when the is yellow and the  is blue, the resultSurface Color Texture Color
will be green. When set to white, it will not affect the surface color. 

Specular
This controls the intensity of the reflections on the surface. This works together with the 

 setting to further increase or decrease the strength of the reflections onRefractive Index
the surface.

Roughness
Increasing roughness will spread and distribute reflections over the surface and create
a more matte surface.

Refractive Index
This controls how much light will bend or refract as it hits and passes through parts that
have this type of material. The default of 1.4 is a good starting point, but you can
increase the value to create a more dramatic refraction within the surface.

Samples
A low samples setting (8 or lower) will tend to make the surface look more noisy, which
will give a more imperfect and rough look. As you increase the value, the noise will even
out more and provide a more evenly distributed roughness.

Global Illumination
This options enables  for the material independent of the Global Illumination General

 setting for .Lighting Global Illumination

 

Advanced
The  material is the most versatile of all KeyShot material types. There areAdvanced
more parameters in this material than in any other. With this variety of parameters,
materials such as metals, plastics, transparent or cloudy plastics, glass, leathers and
diffuse materials can all be created from this single material type. Material types that
cannot be created are translucent materials and metallic paints.

Diffuse
This can be thought of as the overall color of the material. Transparent materials will
have little or no diffuse. Metals will have no diffuse with all the color derived from the
specular. To fully understand this parameter see the section on diffuse.

Specular
This is the color and intensity of the reflection of light sources within the scene. Black
will be 0% intensity and the material will not be reflective. White will be 100% intensity
and will be completely reflective. If a plastic material is being created, the specular color
should be gray to reduce reflectivity.

Specular Transmission
This can be thought of as the transparency of the material. Black will be 100% opaque
and white will be 100% transparent.

If a transparent glass or plastic is being created, the diffuse should be black with all the
color derived from this parameter. Transparent glasses or plastics should also have the
specular set to white. If a cloudy plastic is desired, the diffuse can be set to a very dark
version of the color set here.

Diffuse Transmission
This will cause additional light to be scattered across the surface of the material, which
can simulate a translucent effect. It will increase render time, so if it is not needed, the
recommendation is to leave it at black.
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Roughness
This will add microscopic levels of imperfections to the surface of the material when the
values are increased. When set to 0, a material will appear perfectly smooth and
polished. When the value is increased, the material will appear more rough as light is
diffused across the surface.

Roughness Transmission
This will control the roughness of the refractions. The main difference between this
parameter and roughness is that the roughness is on the internal portion of the material.
This can be used to create a frosted look while still maintaining a shiny surface. The
material needs to have some transparency through the specular transmission for the
effect to show.

Refraction Index
This will control the level of refraction on the material.

Fresnel (pronounced frah-nel)
This will control the intensity of the reflections that are perpendicular to the camera. In
the real world, materials are more reflective around the edges of objects than they are
on areas of objects that are directly facing the viewer or camera. This is enabled by
default. Different materials have different
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Glossy Samples
This will control the accuracy of glossy (rough) reflections by increasing the samples
that are used.

 

 

 

 

Anisotropic
The  material type gives you advanced control over the highlights on theAnisotropic
material surface. On other material types that have a single “Roughness” slider,
increasing this value causes the highlights on the surface spread out evenly in all
directions. Anisotropic gives you control over the highlight shape by controlling the
roughness in two directions with two independent sliders. This material type is often
used to simulate a finely brushed metal surface.

Color
When trying to
create a metal, the
diffuse should be
set to black. When
set to anything
other than pure
black, this material
type will take on
more a plastic
look.

Specular
This is the color
and intensity of the
reflection of light
sources within the
scene. Black will
be 0 intensity and
the material will
not be reflective.
White will be 100%
intensity and will
be completely
reflective.

If a metal material is being created, this is where the color is set.

 

Roughness X and Y
These sliders control the spread of the highlights on the surface. The X and Y
roughness sliders control the highlight spread in independent directions. As you offset
the values, the highlights on the surface will stretch out and give a finely brushed effect.

Setting both sliders to the same value will yield reflections that are spread evenly in all

 

 



directions. In the image, the ball on the left has offset values and the right has equal
values.

Angle
This rotates the stretched highlights that are produced when the roughness x and y
values are offset. The value is in degrees and goes from 0 to 360.

Mode
This advanced setting controls how the highlights are stretched. There are three unique
modes. The default mode is Linear, which will stretch highlights in a linear way, and is
independent of any UV coordinate mapping you may have on the model. Radial mode
is an anisotropic method which simulates the effect you might observe on the play side
of a CD. Enabling this mode allows you to choose the center point of the radial
roughness. UV mode is dependent on your UV coordinates. You can use this to
manipulate the anisotropic highlights based on the mapping from your modeling
software.

Samples
A low samples setting (8 or lower) will tend to make the surface look more noisy which
will give a more imperfect and rough look. As you increase the value the noise will even
out more and provide a more evenly distributed roughness.
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Dielectric
The  material type is a more advanced way to create glass materials.Dielectric
Compared to the  Material Type, you will find additional settings forSolid Glass
dispersion ( ) and it can also be used to create an accurate interfaceAbbe Number
between glass and liquid.

Transmission
This option controls the overall color of this material type. When light enters the surface
it will take on the color set here. The amount of color that you see in this material is
highly dependent on the color density setting as well. If you have set a color in the
transmission, but it looks too faint, skip down to the color density section.

Refractive Index
This slider controls how much light will bend or refract as it passes through parts on
your model that have this type of material. The default of 1.5 is accurate for simulating
most types of glass, but you can increase the value to create a more dramatic refraction
within the surface.

Transmission Out
This option controls the color of the light on the outside of the material. It is an
advanced and complex setting, but it is needed when rendering containers with liquid. In
the example of a water glass, you will need to have a dedicated surface for where the
liquid and glass meet. On this surface, you should set the color of the glass with the
transmission out setting and control the color of the liquid with the transmission setting.
If the glass and liquid are both clear, set both transmission and transmission out to
white.

Refractive Index Outside
This slider is an advanced but powerful setting that allows you to accurately simulate
the interface between two different refracting materials. The most common use for this
is when you are working on a container with liquid inside, like a water glass. In such a
scene, you will need a single surface to represent where the glass and water meet. On
this surface, you have the liquid on the “inside,” and therefore you should set the
refractive index to 1.33. On the “outside,” the glass the refractive index outside should
be set to 1.5.

Transparency Distance
(Formerly Color Density) This slider controls the depth of the color selected in the Trans

 setting, depending on the thickness of the part to which the material ismission
applied. After setting a color in the  setting, use  toTransmission Transparency Distance
make that color more or less saturated and prominent. A lower setting will show the
color more in thin areas of the model, and a high setting will make the color faint in the
thin areas.

This physically accurate parameter simulates the effect you can observe by looking at
the color of the shallow water at a beach versus the deep blue of a deep ocean. Without
this you would see through to the bottom of the deepest ocean as easily as to the
bottom of a swimming pool.

Roughness
Roughness on this type of material will spread out highlights on the surface similar to
what you see on non-transparent, materials. However, it also spreads out the light that
is transmitted through the material. This is used to create a frosted glass look.

Expand this parameter, and you will see a samples setting. This can be used with a low
setting to produce a more imperfect/noisy result or a higher value to smooth out the
noise/grain for a smoother frosted look.

Abbe Number (Dispersion)
The Abbe number slider controls dispersion of light as it is transmitted through the
surface and produces a prismatic effect. This prismatic color effect can be used to
create the “fire” effect often desired when rendering gem stones.

A value of zero will disable the dispersion effect entirely. A low value will show heavy
dispersion, and as you increase the value, the effect will become more subtle. A setting
around 35-55 is a good starting point if a subtle dispersion effect is desired.

Expand this parameter and you will see a samples setting. This can be used with a low
setting to produce a more imperfect/noisy result or a higher value to smooth out the
noise/grain for a smoother look.

Roughness Transmission
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This will control the roughness of the refractions. The main difference between this
parameter and roughness is that the roughness is on the internal portion of the material.
This can be used to create a frosted look while still maintaining a shiny surface. The
material needs to have some transparency through the specular transmission for the
effect to show.

 

Gem
The  Material Type is related to the Solid Glass, Dielectric, and Liquid MaterialGem
Type. The settings have been optimized to be relevant to rendering gem stones. The Ab

 (dispersion) control is especially important for gem stone rendering as itbe Number
produces the “fire” effect that is often desired.

Color
This controls the overall color of the gemstone. When light enters the surface it will take
on the color set here. The amount of color you see in this material is highly dependent
on the transparency setting as well.

Refractive Index
This controls how much light will bend or “refract” as it passes through parts on your
model that have this type of material. The default of 1.5 (the Refractive Index of Lapis
Lazuli) is a general setting and will need adjusted depending on the gem you desire. A 

 can be found on the International Gem SocietyTable of Refractive Index for Gemstones
website.

Transparency Distance
(Formerly  ) This slider controls the depth of the color selected in the Transparency Color
 setting, depending on the thickness of the part to which the material is applied. After
setting a color in the   setting, use   to make that color moreColor Transparency Distance
or less saturated and prominent. A lower setting will show the color more in thin areas
of the model, and a high setting will make the color faint in the thin areas.

This physically accurate parameter simulates the effect you can observe by looking at
the color of the shallow water at a beach versus the deep blue of a deep ocean. Without
this you would see through to the bottom of the deepest ocean as easily as to the
bottom of a swimming pool.

Roughness
Roughness on this type of material will spread out highlights on the surface similar to
what you see on other, non-transparent, materials. However, it also spreads out the
light that is transmitted through the material. This is used to create a frosted glass look.
Expand this parameter and you will see a samples slider. This can be used with a low
setting to produce a more imperfect/noisy result or a high setting to smooth out the
noise/grain for a smoother frosted look.

Abbe Number (Dispersion)
The Abbe number controls dispersion of light as it is transmitted through the surface
and produces a prismatic effect. This prismatic color effect can be used to create the
“fire” effect often desired when rendering gem stones. A value of zero will disable the
dispersion effect entirely. A low value will show heavy dispersion, and as you increase
the value, the effect will become more subtle. A setting around 35-55 is a good starting
point if a subtle dispersion effect is desired. Expand this parameter and you will see a
samples slider. This can be used with a low setting to produce a more imperfect/noisy
result or a higher value to smooth out the noise/grain for a smoother look.

 

 

 

Measured
The  material type supports the import of the X-Rite Appearance exchangeMeasured
Format (AxF) and Radiance BSDF format. These formats contain  digitalvendor neutral 
material representations that captures the light scattering characteristics for specific
physical materials.

The X-Rite AxF Material Format

AxF is a digital file format developed by X-Rite that delivers a standardized appearance
representation. AxF materials are created from physical material samples scanned
using an X-Rite TAC7 Scanner which captures and creates the accurate digital material
specifications in the AxF file. AxF files can be accessed from digital material catalogs

The X-Rite AxF Material
Format
The Radiance XML BSDF
Format
Importing Measured
Materials

https://www.gemsociety.org/article/table-refractive-index-double-refraction-gems/


such as the PatoneLIVE Cloud and imported directly into KeyShot using a Measured
material type. Learn more about AxF and how to create them at xrite.com/axf/. 

 Download AxF sample files from X-Rite

The Radiance XML BSDF Format

BSDF (bidirectional scattering distribution function) is a mathematical model used to
describe light interactions with surfaces. heDeveloped for the Radiance Renderer, t
BSDF  dfile format supported in KeyShot is an XML format containing measured BSDFs 
efining the distribution function that dictates how the light is scattered and how the
material appears.

Importing Measured Materials

While editing a material in the ,  tab, select  from the Projects Material Measured Material
 dropdown, the part will appear black and a  location field will appear in the Type File Pro

 tab. Select the folder icon  to select a Measured file format. The .axf andperties
.xml file extensions are supported.

 

Metallic Paint
The  material type simulates a two-layer paint job: a base coat and aMetallic Paint
clear-coat that provides a clean reflection over the entire material.

Paint Settings

Base Color
This is the overall color of the material for the base coat of paint.

Metal Color
This can be thought of as a coat of metal “flakes” sprayed over the base coat. You can
choose a color that is similar to base color to get a subtle metal flake effect, or you can
choose a contrasting color to get some interesting results. A white or gray metal color is
also commonly used for realistic paints. The metal color in the material will show more
in the directly lit or brightly highlighted areas of the surface while the base color will
show more in the less illuminated areas.

Metal Coverage
This controls the ratio of base color to metal color. When it is set to 0, you will see only
the base color. When it is set to 1, the surface will be almost entirely covered in the
metal color. For most metallic paint materials, you will want this value set close to 0. A
setting of 0.25 is the default and a good starting point.

Metal Roughness
This controls the spread of the metal color over the surface. When it is set to a low
value, you will see the metal color only in small areas around the highlight areas. When
it is set higher, the metal will spread more evenly across the entire surface. A setting of
0.15 is the default and a good starting point. Within the metal roughness parameter, you
will find a samples setting. This will control how imperfect or refined the metal effect in
the paint will look. A low setting will result in a more noticeable “flake” effect. A higher
setting will smooth out the distribution of the metal effect, and it will have less
noise/grain. When seeking a pearl effect, , use a higher setting.

Clear-coat Settings

The clear-coat settings control the top clear-coat layer. Settings are unit-aware and can
have a bump map applied that does not affect the base coat. 

Clear-coat Color
Sets the color for the clear-coat layer. The lighter the color, the lighter the clear-coat.
The default is white (completely clear).

Clear-coat Roughness
The metallic paint clear-coat layer, by default, provides perfectly clean reflections.

 

On this page:
Paint Settings
Clear-coat Settings
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However, if a satin or matte paint effect is desired, the clear-coat roughness value may
be increased. This will spread out the reflections on the surface for a matte look.

Clear-coat Refractive Index
This slider controls the intensity of the clear-coat. 1.5 is the default and a good starting
point. If a more shiny paint is desired, increase the value. Bringing the value down,
closer to 1, reduces the clear-coat effect. This can be useful for making a matte finish or
simulating plastics that have a metallic flake effect.

Clear-coat Thickness
Sets the thickness of the clear-coat. This is set as a thickness multiplier that can be
textured. A higher value will darken the clear-coat. This setting can be textured by
clicking on the texture icon next to the setting. This will override the value and provide
additional settings for the texture type selected.

 

Plastic (Cloudy)

The Plastic (Cloudy) material contains light-scattering particles to replicate complex, scientifically accurate materials such as Polycarbonate or
ABS. This material has parameters to control light , , , e and . WhenTransmission Roughness Refractive Index Transparency Distanc Cloudiness
editing an existing material select  from the  dropdown.Plastic (Cloudy) Material Type

Transmission
This sets the overall light transmission of the cloudy plastic material. A lighter color will allow more transmission. A darker color will provide less
transmission. Click the color thumbnail to open the color picker then select your desired color.

Roughness
This will add microscopic levels of imperfections to the surface of the material when the values are increased. When set to 0, a material will
appear perfectly smooth and polished. When the value is increased, the material will appear more rough as light is diffused across the
surface. Within the roughness parameter, you will find a samples setting. A low samples setting (8 or lower) will tend to make the surface look
more noisy, which will give a more imperfect and rough look. As you increase the value, the noise will smooth out and provide a more evenly
distributed roughness.

Refractive Index
This controls how much light will bend or “refract” as it passes through parts that have this type of material. The default of 1.5 is accurate for
simulating most types of plastic, but you can increase the value to create a more dramatic refraction within the surface.

Transparency Distance
Controls the distance at which the transparency is affected.

Cloudiness
This setting affects the overall cloudiness of the plastics. A value of 0 is no cloudiness at all. 

Scattering Directionality
Controls how the light is scattered. A value of 0 is uniform scattering, a negative value will scatter light backwards, a positive value with scatter
light forwards.

Cloudiness Color
This sets a specific color for the internal cloudiness of the plastic.

Samples
A low samples setting (8 or lower) will tend to make the surface look more noisy, which will give a more imperfect and rough look. As you increase
the value, the noise will even out more and provide a more evenly distributed roughness.

Plastic (Transparent)
The  material provides the basic settings needed to create simplePlastic (Transparent)
plastic materials. Set the diffuse (overall color) and add some specular (reflections),
then adjust the roughness. This is a very versatile material type that is used for anything
from concrete to woods.

Diffuse
This can be thought of as the overall color of the material. Transparent materials will
have little or no diffuse color applied.

Specular
This is the color and intensity of the reflection of light sources within the scene. Black
will completely turn off reflections, while white will provide a very shiny plastic
look. Realistic plastic does not have color in the specular value, so generally you should
use some level of gray or white. However, adding color can give the plastic material a
metallic effect.

Roughness
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aterial will appear perfectly smooth and polished. When the value is increased, the
material will appear more rough as light is diffused across the surface. Within the
roughness parameter, you will find a samples setting. A low samples setting (8 or lower)
will tend to make the surface look more noisy, which will give a more imperfect and
rough look. As you increase the value, the noise will smooth out and provide a more
evenly distributed roughness.

Diffuse Transmission
This will cause additional light to be scattered across the surface of the material which
can simulate a translucent effect. It will increase render time, so if it is not needed, the
recommendation is to leave it at black.



Specular Transmission
This can be thought of as the transparency of the material. Black will be 100% opaque
and white will be 100% transparent. If a transparent glass or plastic is being created,
the diffuse should be black with all the color derived from this parameter. Transparent
glasses or plastics should also have the specular set to white. If a cloudy plastic is
desired, the diffuse can be set to a very dark version of the color set here.

 

 

 

 

Translucent (Advanced)

The   material type provides control over subsurface scattering propertiesTranslucent
that are found in many skin, plastic and other materials. Compared to the  mTranslucent
aterial type, this generally will resolve faster.

Surface Color
This controls the diffuse color of the outer surface of the material. Consider this the
overall color of the material. Something to be aware of with this unique material type is
that you will not see the translucent effect of the subsurface color if the surface color is
completely black.

Subsurface Color
This setting controls the color that light will take on as it passes through the material.
Your own skin is a great example of the subsurface scattering effect. When a bright light
shines through the thin parts of an ear or the thin skin between fingers, the light is
colored by what lies beneath the surface and comes back more red.

While the light is passing through the surface, it is bounced around in many random
directions. This creates the soft translucent effect rather than the direct refraction effect
of glass and similar materials.

For plastic materials, you will often set this color to something very similar to the surface
color, but perhaps a a bit brighter.

Translucency
This controls how deep light penetrates into and through the surface depending on the
units set under  . The higher your translucency value, the more ofEdit, Set Scene Units
the subsurface color you will see coming through the surface. Higher translucency
values will also create a softer looking material.

Specular
This controls the intensity of the reflections on the surface. This works together with the 

 setting to further increase or decrease the strength of the reflections onRefractive Index
the surface.

Roughness
Increasing  will spread and distribute reflections over the surface and createRoughness
a more matte surface.

Refractive Index
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This controls how much light will bend or refract as it hits and passes through parts that
have this type of material. The default of 1.4 is a good starting point, but you can
increase the value to create a more dramatic refraction within the surface.

Samples
A low samples setting (8 or lower) will tend to make the surface look more noisy, which
will give a more imperfect and rough look. As you increase the value, the noise will even
out more and provide a more evenly distributed roughness.

 

Velvet
The  material is very useful for creating soft fabrics that have the distinct lightVelvet
catching effects that result from the soft fibers in finely woven fabrics.

This is a complicated material by KeyShot standards, and you will generally be able to
do fabric materials well enough with the plastic or advanced material types. However,
this material type does provide control over parameters not found in other material
types.
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erall color of the material. A dark color is generally preferred for both the diffuse and
sheen settings as this material can become unnaturally bright when light colors are
used.

Sheen
The sheen color is observed as light that appears to be reflected back across the
surface from behind, almost as though the surface is backlit. This setting is combined
with the edginess control to add a soft sheen across the entire material. The
backscatter parameter also gets its color from the sheen setting. Generally, this should
be set to a color very similar to the diffuse color, but a bit brighter.

Roughness
The roughness setting determines how evenly the backscatter effect is distributed
across the surface. When this is set to a low value, the backscattered light will stay
contained within smaller areas. A high value will spread the light across the entire object
evenly.

Backscatter
This is light that is scattered across the entire object and is especially apparent in the

 

 



shadowed areas of the object. It can be used to give an overall soft look to the surface.
The color of the backscatter light is set with the sheen control.

Edginess
This controls how far the sheen effect spreads over the surface. A low value will cause
the sheen to fade out gradually, while a high value will produce a bright border of sheen
around the edges of the surface. A setting of zero disables the sheen effect.

Samples
The samples setting controls how imperfect or refined the backscatter effect appears. A
higher value will smooth out this scattered light and will cause it to appear more even. A
low value will show a coarser grain/noisiness in the backscattered light. A higher
setting, around 32, is often preferred for this setting as it provides a smoother result.

 

 

 

Light Sources
In KeyShot, physical lights are designed as materials that may be applied to parts. Any
geometry can be turned into a light source. You can either import new geometry, use
existing geometry or add a primitive ( ). Light sources are labeledEdit, Add Geometry...

in the   window,   by a light bulb icon   next to the part name.Project Scene Tree

Light Source Material Types

There are three types of physical light source material types:

Area Light Diffuse
Point Light Diffuse
Point Light IES Profile

Applying a Light

Applying a light material is similar to applying other materials. Drag and drop a light
material preset from the Material library or select a light material type from the  wProject
indow,  tab,  dropdown. KeyShot will change the object to aMaterial Material Type
physical light. 

Moving a Light

Right-click the part that is assigned as a light and select . This will activateMove Model
the Move Tool. You can also select the light source in the  window,  tabProperties Scene
, then select  from the  tab. Additionally, the input boxes may be usedMove Tool Position
for more precise positioning.

Animating a Light

Since light sources are materials applied to a part, they can be animated just like any
other part. Simply select the light in the Scene Tree that you would like to animate,
right-click and apply the animation you would like.

On this page:

Light Source Material Types
Applying a Light
Moving a Light
Animating a Light

 

Area Light Diffuse
Area Light Diffuse is a material type that will give you a wide range of light dispersion.
This will function similarly to a flood light.

Color
Here you can choose the color the light will cast.

Power
The power of the light can be controlled by either Watt, Lumen, or Lux. Lumen or lux
are recommended for best results; 1 Lux equals 1 lumen per square meter.
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Apply to Back of Geometry
Apply the light source to the backside of the surface geometry.

Visible to Camera
Here, you can toggle whether or not the light source geometry is shown in realtime
window and renderings.

Visible in Reflections
Here, you can toggle whether or not the reflection of the light source is shown in
realtime window and renderings.

Visible in Shadows
Here, you can toggle whether or not the light source geometry casts a shadow in
realtime window. Disable for more accurate results.

Samples
Use this slider to control the amount of samples used in the render.

 

 

 

Point Light Diffuse
Applying a  to geometry replaces it with a point located in the partsPoint Light Diffuse
center.

Color
Here, you can choose the color the light will cast. For accurate lighting colors, use the
Kelvin scale to select accurate lighting temperatures.

Power
The power of the light can be set to either Watts or Lumen.

Radius
Adjust the radius to control the “Falloff” from shadows cast from this light.

 

 

 



 

Point Light IES Profile
When using IES light, you will need to load an IES profile by clicking on the folder icon
in the editor. As soon as you load the profile you will see the shape of the IES profile in
the material preview. You will also see the shape in form of a mesh in the realtime
window.
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different IES profile.

Color
Here, you can choose the color the light will cast. Use the Kelvin scale to select
accurate lighting temperatures.

Multiplier
Adjust the intensity of the light with this slider.

Radius
Here, you can adjust the radius to control the falloff from shadows cast from this light.

 

 

 

 

 

Emissive
The  material type can be used for small light sources such as LEDs, lamps orEmissive
even illuminated screen displays. It is not meant to illuminate scenes as a main light
source. The emissive material will need “Global illumination” enabled in “lighting” to
illuminate other geometry in the realtime view. It will also need ground illumination to
illuminate the ground plane as shown. Color textures can be mapped to the material

 

 



and any colors included in the texture will be emitted as light. When using emissives, it
is a good idea to enable “Bloom” under effects in realtime settings. This will create the
glowing effect shown in the image.
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Intensity
This will control the intensity of the light that is emitted.

Visible to Camera
Hide the emissive material from the camera, but the emissive material will still emit light.

Visible in Reflections
Hide the emissive material from any specular reflections. The effect of the emissive will
only be seen on the diffuse component of materials.

Two-Sided
This will cause the emissive light to display on both side of the surface.

Use Color Map Alpha
This will allow you to use the alpha channel in the color map.

 

 

 

Ground
The  material type is a simplified material type for creating ground material.Ground

Simply click  and select . This will add a ground plane into yourEdit Add Ground Plane
KeyShot scene. The ground material can also be applied to imported geometry.

Shadow Color
The shadow that is being cast from the object will be displayed in this color. Clicking the
color block will allow you to edit the color.

Specular
The ground material supports specular parameters.

Clip geometry below ground
If any geometry is being displayed below the ground plane material , this option will clip
the geometry below the ground plane, hiding it from the camera.
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Toon
The   material type allows you to apply a solid color with contour lines to your 3DToon
model. You are able to control the contour width, the number of contour lines, and
whether or not shadows are cast onto surfaces. This is useful for creating sketches,
product concepts, or technical illustrations. The Toon material type contains the
following properties:

Color
This will control the fill color of the Toon material.

Contour Color
This will control the outline of the model.

Contour Angle
This will control the number of interior contour lines in the toon sketch. A lower value will
increase the number of interior contour lines and a higher value will decrease the
number of interior contour lines.

Contour Width
This will control how thin or how thick your contour lines will be.

Contour Quality
This will control the quality of the contour lines. Use a lower value to obtain a rough
sketch look, or a higher value for a more clean and precise stroke.

Transparency
Increasing this value will allow light to pass through the geometry. Use this feature on
transparent parts, or to show interior views of your model.

Shadow Color
This controls the color of the shadows on the model. Activated when the Environment

 under   settings setting is enabled. A texture may be applied toShadows Advanced
control the appearance of the shadow,

Advanced

Contour width is in pixels
When enabled, the contour lines are defined using pixels. When this setting is
disabled, the contour lines are defined using scene units.

Outline Contour
This will allow you to show or hide the outline in your sketch.

 

 



Interior Edge Contour
This will show or hide the interior contour lines in your sketch.

Material Contour
This will allow you to show or hide the contour line that separates each unlinked
Toon material. If the Toon materials are linked, this setting will not have an effect.

Environment Shadows
This will reveal the shadows cast by the model onto itself due to the selected
lighting environment.

Shadow Strength
When the   or  setting is enabled,Environment Shadows Light Source Shadows
this controls the strength of each shadow type cast onto the Toon material.

Outline Width Multiplier
Increase this value to create a “perimeter line” effect with your Toon material.
This will help pop the part from your scene and create a stronger visual contrast.

Part Width Multiplier
Use this to increase the line width of part contours and interior edge contours. It
will not affect the scene unless   is enabled.Part Contour

Part Contour
Enable this to allow the use of the   setting.Part Width Multiplier

Light Source Shadows
Controls the visibility of shadows produced by a Light Source (Point Light Diffuse,
Point Light IES Profile, or Area Light Diffuse). The shadow appearance will
change depending on the settings of your light source.

The following video shows how to quickly switch all materials in your scene to a single
material.

 

Wireframe
The  material type exposes the lines and vertices of each polygon of aWireframe
surface.
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Base Color
This controls the overall color of material, excluding the lines (Wire).

 

 



Base Transmission Color
This value controls the base color transmission. A lighter color will give the appearance
of transparency.

Backside Base Color
This controls the backside of the base color. On a cube this would be the inside of the
cube.

Backside Wire Color
This controls the backside of the wire color.

 

 

Xray
The  material type provides a useful tool for illustrative renderings. It is often usedXray
to create a faded view through an outer shell.
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plied to a part, the Xray effect works by showing more of the material color on areas of
the surface that are being viewed at more of an angle. The surface is nearly completely
transparent where it is viewed at a direct angle.

 

 

 

 

 

Axalta Paints
As the leading manufacturer of auto body paints, Axalta has created several collections
of KeyShot materials that are an accurate representation of the real world paints they
provide. Below you will find information and tips on how to use Axalta paints.

 

 

 

Saving Materials

There are two ways to save materials.

The first way to save materials is to right-click a material directly on the model and
select .Add Material to Library

The second way to save materials is to click the  icon  on the  Save to Library Project
window,  tab.Material

Once you have gone through either step, a dialogue will prompt you to designate a
destination folder in the material library. After the folder location has been selected, the
new material will be saved to the library.

Note: You may create your own folder to save custom materials by adding a folder to
the  directory.KeyShot Resources, Material

 

Color Library
The KeyShot Color Library lets you drag and drop predefined colors onto any part or
object inside the realtime window.



PANTONE® and RAL® color libraries are included for use.

Searching for colors can be done by clicking in the search box in the top right and
typing the name of the color. This allows you to search the entire selected folder for the
specific color.

Searching can also be achieved by selecting the crosshair in the top right area of the
dialog. This will open a window with a color picker that allows you to select the color you
are looking for.

Color libraries can also be imported from a CSV file by using the import button and
browsing to the file. When creating a CSV file, the color entries need to follow this
format when using RGB:

name,r,g,b

The values can be separated by comma, semicolon, or tab. Other color spaces
supported are: RGB (0-1), HEX, CMYK, HSV, CIE-L*ab

You can create colors manually within KeyShot by right-clicking inside the color library
and selecting “Add Color.”



 

Color Picker
The color picker can be accessed anytime a color box is clicked as well as through the
eyedropper tool in the color library. The color picker gives you the ability to test and
view your colors visually, or by numerically entering in specific values. The color picker
supports rectangular and triangular color map representations.

The color picker supports the following color formats:

RGB
CMYK
HSV
Grayscale
CIE-L*ab
Kelvin

Swatch colors (both new and old) can be dragged and dropped from the top color bars,
to the bottom squares. This will set the color in the square. Swatches can be overwritten
by simply dragging and dropping new colors onto existing ones.

The eye dropper button gives you the ability to select any color on your display, and the
color picker will update with the selected color from the eye dropper.

To save colors to your library, click the save icon. This will prompt you to pick a folder
where you would like to save your chosen color.



 

 

Material Graph

Advanced material editing is available through the KeyShot Material Graph. The Material Graph opens in a separate window and displays
materials, textures, labels and more as nodes in a graph view to visualize connections and relationships within complex materials.

The Material Graph can be accessed through the Project window Material tab by KeyShot Pro users only. Click the Material Graph button at the
top of the dialog to launch the Material Graph window. There are five components of the Material Graph window: menu bar, Ribbon, Materials &
Textures Library, Material Properties, and the work area.





Material Graph User Interface

Material Graph Menu Bar

Material

New
This will replace the working material and any textures with a basic diffuse material to
start from scratch.

Save to Library
will save the working material to the specified folder in your KeyShot Library. Export will
save an .mtl file to the specified location. The Nodes menu provides quick addition of
Material, Texture, Animation, and Utility nodes to the work area. The View menu gives
you access to Layout Graph, which automatically arranges connected nodes in the work
area. The Window menu gives access to hide/show the Materials & Textures Library
and the Material Properties window.

Export

This will allow you to export your material as a KeyShot MTL file type in a specified
folder.

Nodes

This provides quick addition of Material, Texture, Animation, and Utility nodes to the
work area.

View

This gives you access to Layout Graph, which automatically arranges connected nodes
in the work area. It also has the options for previewing individual node settings in the
realtime window such as color, alpha, and bump. You can also stop the preview within
this menu as well.

Window

This gives access to hide/show the Material Properties window, Materials & Textures
Library, and the Material Graph Ribbon.

Material Graph Ribbon

The ribbon provides quick access to the same functions found in the menu bar with the
addition of “Duplicate” and “Delete” selected nodes.

The quick-access node action icons add default nodes for each category. The Material
icon adds an “Advanced Material” node. The Texture icon adds a traditional texture map
and opens the file browser window to select your image file. The Animation icon adds a
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Color Fade node. The Utility icon adds a Bump Add node.

Preview Modes

The ribbon also includes toggles for showing the preview modes found in “View” on the
menu bar. To active a preview mode, select a node you would like to preview. After
selecting a node, the available preview modes will become selectable. click on a
preview mode to activate it, which will make the selected node red in the work area. To
disable the preview mode, click on the activated preview mode again on the ribbon.

Work Area Controls

At the end of the Material Graph ribbon, you will find buttons for aligning the nodes
within the work area, fitting all the nodes within the work area, and viewing the nodes at
100% zoom level.

Material Graph Libraries

The Materials and Textures Library contains an organized thumbnail display of all the
same nodes found in the Nodes menu and the Work Area right-click menu.

Material Graph Properties

The Material Properties dialog shows the associated properties for the current node
being edited—similar to the Material tab in the Project window but with access to all
nodes.

Material Graph Work Area

The Work Area displays all nodes and connections of materials, textures, labels,
material animations and utilities. Right click in the work area for access to the same
nodes as those found in the Nodes menu. Select a node by left clicking. Select multiple
nodes by left-clicking and holding  (  on Mac). Use the marquee selection toCtrl Cmd
select a group of nodes by holding Shift while clicking and dragging. Right click on a
selection of nodes to delete or duplicate that selection. Zoom in or out of the Work Area
using the middle mouse wheel and pan using the left mouse button.

 

Material Graph Nodes
Nodes are displayed as gray boxes in the Work Area. Each node has different input and
output channels depending on the type.

Channel connections are made by clicking on an output channel and dragging and
releasing directly onto an input channel or onto the node itself. When it is released onto
the node, a context menu will show all the available channel options. Once a connection
is made, a blue line will appear connecting the 2 nodes. Right click the line to remove or
disable the connection. A disabled connection will be displayed as a grey dashed line. If
you select a connection, it will turn light blue.

On this page:

 

Material Node Types
See  covered in our Materials section.Material Types  

 

 

Texture Node Types
See our Texture Types covered in our  section.Textures  

 

 

Animation Node Types

https://luxion.atlassian.net/wiki/display/K6M/Material+Types
https://luxion.atlassian.net/wiki/display/K6M/Textures


Animation nodes allow the manipulation of material color and settings.

In this section:

Color Fade Node
Number Fade Node

 

Color Fade Node

The Color Fade animation node is
unique in that it allows you to create
changing parameters of any of your
custom material color swatches.
when you add a Color Fade node,
an animation node will
automatically be created in the
animation timeline. Like other
animation nodes, you can select the
node and change the settings in the
animation properties window.

Color Bar
Here you can set what colors will fade from one to the the next. Click on the dropper
circle to select it, then use the color swatch to choose a color. If you would like to add
more than 2 color to fade to, click on an empty area below the color bar to create
another color swatch. click and drag the color pins and the gradient apex slider to your
desired animation effect.

Time
With a color selected on the color bar, you can enter in where in the timeline it will
become the selected color.

Time Settings
Use these settings to fine tune your Color Fade animation in your scene.

For more details about time animation and time settings, click HERE.

https://luxion.atlassian.net/wiki/spaces/K7M/pages/40104989/Color+Fade+Node
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40105075/Number+Fade+Node


Number Fade Node

The Number Fade animation node
is unique in that it allows you to
create changing parameters of any
of your numerical properties within
your custom material. when you
add a Number Fade node, an
animation node will automatically
be created in the animation
timeline. Like other animation
nodes, you can select the node and
change the settings in the
animation properties window.

From
Enter the numerical value you would like the animation to start at. use the sliders, or
type in a specific value.

Time
Enter the numerical value you would like the animation to end at. use the sliders, or
type in a specific value.

Time Settings
Use these settings to fine tune your Number Fade animation in your scene.



For more details about time animation and time settings, click HERE.

Utility Node Types
 

Bump Add

Combine two bump texture maps or procedural textures. Control their interaction by
defining the Ratio and Weight in which the two bumps are visible.
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Color Adjust

Colorize and/or modify the existing color of a texture map or procedural texture by
adjusting Hue, Saturation, Value, and Contrast.

Color Composite

Layer and combine two texture maps or procedural textures with control of Blend Mode
and Alpha (transparency).

https://www.keyshot.com/wp-content/uploads/2015/11/Bump-Add@2x-e1447446958970.png
https://www.keyshot.com/wp-content/uploads/2015/11/Color-Adjust.png
https://www.keyshot.com/wp-content/uploads/2015/11/Color-Adjust@2x-e1447447049501.png


Color Invert Utility Node

Invert the color of a source texture map or procedural texture.

https://www.keyshot.com/wp-content/uploads/2015/11/Color-Composite.png
https://www.keyshot.com/wp-content/uploads/2015/11/Color-Composite@2x-e1447447113987.png
https://www.keyshot.com/wp-content/uploads/2015/11/color-invert.png
https://www.keyshot.com/wp-content/uploads/2015/11/Color-Invert@2x.png


Color Key Mask Utility Node

Mask a specified color within a texture map or procedural texture. Control the strength
of the mask by adjusting Threshold and Fuzziness.

Color To Number

The Color to Number node converts a Color to a single number. This is usually done
implicitly such that black is zero and white is 1, however there are times where you
need more control. This is quite useful e.g. for roughness maps where you can use
Color to Number to easily map a black/white image to go from e.g. 0.05 to 0.10 – this
would be hard to do otherwise.

https://www.keyshot.com/wp-content/uploads/2015/11/Color-Key-Mask.png
https://www.keyshot.com/wp-content/uploads/2015/11/Color-Key-Mask@2x-e1447447235681.png
https://www.keyshot.com/wp-content/uploads/2015/11/Color-to-Number.png


 

Color Curve Randomize

Add color randomness to curves that are assigned a solid color, texture map, or
procedural texture.

 

Multi-Materials
Any material can be turned into a Multi-Material to facilitate non-destructive material
swapping, variations or color studies. The Multi-Material allows you to cycle through a
variety of materials within a single “container” material.

Converting to Multi-Materials

In this section:

Converting to Multi-Materials
Adding Multi-Materials
Viewing Multi-Materials
Saving Multi-Materials
Removing Multi-Materials
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When editing a material select the three-arrow  icon  Multi-Material
above the  dropdown to convert a single material to a Multi-Material. Material Type

Warning: Dragging and dropping a material from the library onto the part will overwrite
the multi-materials applied. Use  to Undo.Ctrl-Z/Cmd-Z

Adding Multi-Materials

There are several ways to add a new material to the Multi-Material list:

Drag-and-drop
Simply drag-and-drop a material preset from the Materials library into the
Multi-Material list.

New Plastic

Select the  icon   on the left of  list. This will add aNew Plastic Multi-Material
standard Plastic material.

Duplicate Material

Select the  icon  on the left of the  list. This Duplicate Material Multi-Material
will duplicate the material selected along with any texture and/or label, but keep
the textures and labels unlinked.

Duplicate Material and Link Textures

Select the  icon Duplicate Material and Link Textures  on the left of the Multi-M
 list. aterial This will duplicate the material selected along with any texture and/or

label, but keep the textures and labels linked.

Viewing Multi-Materials

To view or edit the different materials in your list, simply select a material to make it
active in the . You may also use the arrow keys to cycle up or downReal-time View
through the list.

Saving Multi-Materials

Like regular materials you create, you can also save Multi-Materials. To save a

Multi-Material, select the save icon   and select the folder you would like to save it
in. 

Removing Multi-Materials

To remove a material from the  list, select the trashcan icon   or hit Multi-Material Del
. Additionally, you may overwrite all materials added to the list by dragging andete

dropping another material onto the part or cancel Multi-Material setup by selecting the

 to close the Multi-Material list.three-arrow Multi-Material icon 

Material Templates
Material templates automate the material application process. Materials from the
KeyShot library are applied to parts based on the name of each part’s original
materials. The material template menu is found in the  menu bar.Window

Create/Delete Templates

Create a new template by clicking on the add icon. Two methods can be used in
creating a material template, “Automatic” and “Manual”.

Automatic – If a model is in KeyShot when you create a new template, the source and
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material names are automatically populated based on the material applications in the
current scene.

Manual – An empty template is created and you can add template items manually.

Each new template is added to the template list, which can be accessed with any scene
opened in KeyShot.

Template Items

A template item consists of a source name and material name.

Use the ” + ” button to create a new item.

Click an item to select the item from list and edit its source and destination name. You
may also change the source type.

Source Type
The source type can be “Part” or “Material.” The part type considers the part names in
the scene. The material type considers the material names in the scene.

Source Name
Depending on the source type, the source name is the name of the part or the name
given to the default material applied to parts of your models. The naming of your default
materials is controlled in the modeling software.

Destination Name
The destination name is the name of the material from the KeyShot library that is to be
applied to all parts that match the source name. When editing the destination name, you
can type the name or drag and drop a material from the library into the templates menu.



Applying Templates

Applying templates can be done through the “Material Templates” window or the import
window.

Material Template Dialog
Templates can be applied using the “Apply” button. This will give you two
options: “To Scene” or “To Selection.”
To Scene
Apply the current template to the selected model or part.
To Selection
Apply the current template to the selected model or part.
Import Dialog
Expand the “Materials and Structure” section to reveal the “Use material
template” checkbox. Enable this setting and select the desired template from
the list. Click “Import” to complete the import.

Wild-Card Assignment

The wild card refers to the practice of applying a material to several parts using the
source name. This can be activated by inserting asterisks (*) to the source name (e.g.
*Inner*) this will apply the material in the destination to all the parts containing “inner”
when the material template is applied.



 

 

Textures
Textures allows images to be mapped to materials to create detailed effects such as
wood grain, meshes tile as well as fine imperfections such as brushed metals. Textures
are applied in the  properties tab under the  tab. The following sectionsMaterial Texture
outline the types of textures in KeyShot and how to work with each.

In this section:
Texture Library
Texture Types
Map Types
Mapping Types
Move Texture Tool

 

Texture Library
Access the KeyShot Library by clicking the   button on the main toolbar,Textures  Library
selecting   from the main menu or by hitting the ‘ . The texturesWindow, Library M-key’
located here provide a range of textures to use for bump maps, color maps, gradients,
labels and more. These textures provide a fast way to start applying textures to your
materials for added realism or a starting point for developing your own textures.

https://luxion.atlassian.net/wiki/spaces/K7M/pages/40086893/Texture+Library
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40087716/Texture+Types
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40090969/Map+Types
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37957335/Mapping+Types
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37957450/Move+Texture+Tool


More textures are available on  .KeyShot Cloud

Texture Types

KeyShot has three primary types of Textures that can be applied to materials: I and . Each of these aremage Textures, 2D Textures,  3D Textures
accessible from the  window, tab  tab. Image Textures use an image file as a texture. 2D and 3D Textures areProject Material , Texture
procedurally generated textures. The three types of Textures include:

Non-Procedural Procedural Other

Image Textures

Texture Map
Tiled UV
Tri-Planar
Video Map

2D Textures

Brushed
Mesh
Weave

3D Textures

Brushed (Radial)
Camouflage
Cellular
Granite
Leather
Marble
Noise (Fractal)
Noise (Texture)
Scratches
Spots
Wood
Wood (Advanced)

Animations

Color Fade
Number Fade

About Procedural Textures

Procedural textures are computer-generated, customizable textures that allow you to control the values and color of the texture. KeyShot allows
you to create textures in real-time viewing the changes as you make them. In comparison to traditional texture mapping, procedural textures wrap
around your model without leaving seams or stretching, regardless of the model’s shape. Use the  type dropdown to choose theTexture
procedural texture you would like to use.

Texture Map
A  is an type of Image Map. Texture maps and their settings can be viewedTexture Map
in the  window,  tab.Project Materials, Textures

Adding a Texture Map

Double-click the texture  (e.g. Color, Specular, Bump) you would like to add aMap Type
texture to. This will open a window where you can choose the image file to apply as a
texture map. You may also drag and drop textures from the Textures library.

Removing a Texture Map

If you want to delete a Texture Map, right-click on the texture  and select Map Type Dele

 or select the trashcan icon  next to the  dropdown. This will remove thete Texture
selected texture from your material. If you make changes to the image file used for the

Texture Map, select the Refresh icon  to update the  and see theTexture Map
changes. If you would like to replace the image file used for the , select theTexture Map

File icon  to choose a new image file.
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Tiled UV
A  texture is an type of Image Map.  textures and their settings can beTiled UV Tiled UV
viewed in the   window,   tab. Project Materials, Textures

More details on this new feature soon...

Tri-Planar
Tri-Planar texture is an type of Image Map. Tri-Planar textures and their settings can be
viewed in the   window,   tab.Project Materials, Textures

More details on this new feature soon...

Video Map
A  texture is an type of Image Map.   textures and their settingsVideo Map  Video Map

https://luxion.atlassian.net/wiki/spaces/K7M/pages/37957412/Texture+Map
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40101406/Tiled+UV
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40101653/Tri-Planar
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40101862/Video+Map
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40102042/Brushed
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40103866/Mesh
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40102112/Weave
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40102219
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40102294/Camouflage
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40102371/Cellular
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40102578/Granite
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40102646/Leather
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40102713/Marble
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40102778
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40102845
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40102977/Scratches
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40103038/Spots
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40103185/Wood
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40103249
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40105237/Color+Fade
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40105646/Number+Fade
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40090969/Map+Types


can be viewed in the   window,   tab. Project Materials, Textures

With a Video Map textures, image sequences can be set as Textures (or Labels) to
animate device displays and much more. The supported formats at the moment include
avi, mp4, mpeg, flv, webm, dv, f4v, mov, mlv, m4v, hevc, ogg, and ogv. Note: Some
formats may have variants encoding which are not supported (for example, avi may
include encodings which may not be directly supported.) 

Adding a Video Map

From  select  from the  dropdown menuProject, Materials, Textures Video Map Texture
or  from the  tab. Select an image sequence in the file browserAdd Label (Video) Labels
or a video file to extract the frames. This will create a node in the  inAnimation Timeline
which you can position and adjust the animation similar to other Animation types.

In this section:
Adding a Video Map

Brushed
The Brushed procedural texture simulates the effects of brushed metal. It is best used
as a bump on a metal material with low a roughness value.

Color 1/2
Use this to set the color for the highlights and shadows of the texture.

Bump Height
Use this to set the depth of the brushed texture

Length
Use this to control the length of the brush strokes.

Contrast
Use this to control how defined the brush stokes are.

Mesh
Create a pattern of shapes that can be used for meshes in the opacity map, or a shape
pattern in color maps.

Color 1
This sets the background color. Set the color to white if using “Lattice Polygon”as an
opacity map.



Color 2
This sets the shape color. Set the color to black to create holes if using “Lattice
Polygon” as an opacity map.

Lattice Parameters

Lattice Angle
Choose the type of projection used.
Spacing U/V
Change the scale of the overall texture.

Shape Parameters

Radius
This allows you to change the size of the shape in the pattern.
Sides
Increase this value to change from a square (4), Pentagon (5), and hexagon
(6).
Shape Rotation
Use this to rotate the shape within the pattern.
Falloff
Increase this value to feather the edge of the shape.

Noise Parameters

Jitter
Increase this value to add deviation to the pattern.
Distort
Increase this value to randomly distort the shape.
Distort Scale
A greater than one value decreases the distortion scale. A less than one value
increases the distortion scale.

Weave
Weave simulates many types of fabrics and fine woven meshes.

Gap Color
This will designate the color in between the woven colors.

U/V Thread Colors
Assign the colors of your threads to affect the overall color of the weave.



U/V Width
Controls the thickness of the threads.

U/V Wave
Changes the direction of the threads within the weave to simulate different types of
woven patterns.

Contrast
Increase or decrease the contrast of the threads.

Width Noise
Controls the uniformity of the thread widths.

Color Noise
Controls the uniformity of the thread colors.

Distortion Noise
Controls the uniformity of the thread straightness.

Brushed (Radial)

Use the Brushed (Radial) procudural texture for a spun brushed metal finish.

Mapping Tool
Use the mapping tool to place the center of the brushed texture.

Color 1/Color 2
Choose contrasting colors here to create a ringed brushed pattern.

Scale
Use this to control the over all scale of the texture.

Angle Noise
Increase this value to vary the width of the rings.

Distortion Noise
Increase this value to deviate the rings from a perfect circle. For a traditional spun brushed finish, you will want to leave this parameter at 0.

Radius
Use this to control the amount of rings are generated.

Falloff
Increase this value to reduce the contrast between the colors selected.



Radial Axial Blend
Use this to create continuous textures on a cylindar that continues into a rounded cap. For most applications you will leave this at default.

Camouflage
Use the Camouflage procedural texture to simulate camouflage textures used in the
real world.

Color 1/2/3/4
Set the mix of colors to be used in the texture.

Scale
Change the scale of the overall texture.

Color Balance
Colors 1-4 are disperesed through the pattern in decending order, so there there are
more spots of color 1 than color 3 or 4. Increase this parameter to balance the ratio of
colors, or reduce the parameter to increase the difference.

Distortion
Change this parameter to control the amount of shape complexity the spots have.

Spray
Increase this parameter to feather the edges of the spots.

Mix Colors
Enable this option to allow the colors to blend as they overlap.



Cellular
The Cellular procedural texture is an advanced tool that can create a wide variety of
texture maps. You can create a hammered texture as seen here, or you can create
cracked surfaces, orange peel paint, crumpled paper, and more.

Scale
Use this to set the scale of the scale of the texture.

Bump Height
Use this to control the overall intensity of the texture map

Contrast
Contrast refers the to the difference in the peaks and valleys of the bump map. Control
them globally, or expand for finer controls.

Shape
Control the fractal shapes generated with this slider. Control them globally, or expand
for finer controls.

Levels
Increase or decrease the levels of fractals being generated. Control them globally, or
expand for finer controls.

Noise
Use this slider to add noise to the line quality of the fractal shapes



Color Gradient
The Color Gradient Procedural Texture allows you to mix two separate colors on a
surface without having to create a custom texture map.

Mapping Tool
Use this to move the center line of the gradient.

Colors
Double click a color slider to select what color will be applied to the color gradient. Use
the triangle slider to determine the midpoint of the gradient. To add another color to the
gradient, click the “+” icon. To delete a color, select the color slider to be deleted, and
click the “Trash” icon.

Location
Adjust this to numerically control the selected color slider.

Gradient Type
Use the dropdown to choose a gradient type that suits your needs.

Scale
Use this to set the scale of the texture.

Angle
Use this to incrementally rotate the texture on the surface in degrees.

Shift
use this to incrementally shift the texture on the surface.

Invert
Reverse the direction of the gradient.



Curvature
Use the Curvature procedural texture to analyse surface curavature in your model and
parts.

Negative Curvature
Choose a color to display when surface curvature is going into the negative direction.
The more severe the the angle, the closer to the set color the texture will be.

Zero Curvature
Choose a color to display where there is zero curvature. The closer to flat a surface is
on the model, the closer color will become to the the chosen color.

Positive Curvature
Choose a color to display where the surface curvature is going into the positive
direction.

Cutoff
Control the scale of the curvature. Decrease the value to have a smaller range of
curvature. Increase to have a larger range of curvature.
Radius
Radius refers to the radius around each point on the surface in which curvature is
estimated.

Samples
Increase the samples to improve the quality of the gradations. Increasing this parameter
also increases render time.

Adaptive Radius
Enable this toggle to even out surface gradations.

Sample Same Material Only
Enable this toggle to use the curvature data from this material only.



Granite
The Granite procedural texture allows you to simulate the granite texture of a counter
top, tile, or stone.

Color
This is the overall color of your granite texture.

Scale
This controls the scale of the grain in the granite.



Leather
The Leather procedural texture allows you to easily replicate a leather textured material.

Color 1
This is the color of the high points (bumps) in leather. This color should be lighter than
color 2, but it should be as close to color 2 as possible for realistic looking leather.

Color 2
This is the color of the low points in leather. This color should be darker than color 1,
but it should be as close to color 1 as possible for realistic looking leather.

Scale
This controls the scale of the leather grain.
It is highly suggested that you add a synced procedural leather bump to further simulate
realistic leather.



Marble
The Marble procedural texture allows you to simulate the marble material on a counter
top, tile, or stone.

Color 1
This is the overall color of your marble texture.

Color 2
This is the color of the veins in the marble texture.

Vein Thickness
This allows you to adjust the thickness of the marble veins.

Vein Noise
This adds random fluctuations to the marble veins.

Vein Noise Scale
This adds fluctuations to the overall direction of the marble veins.

Scale
This controls the scale of the veins in your marble texture.



Noise (Fractal)
The Noise (Fractal) procedural texture also allows you to simulate ripples and bumps in
your material.

Colors 1 and 2
The noise procedural has light and dark colors that you can modify using these two
settings.

Scale
This controls the scale of the fractal noise.

Levels
This adds more detail to the fractal noise.

Fall-off
This controls the color balance. Low values accentuate color 2, and high values
accentuate color 1.



Noise (Texture)
The Noise (Texture) procedural texture is very similar to the stock noise texture in the
textures library, and it allows you to simulate ripples in glass and liquid materials when
used as bump.

Colors 1 and 2
The noise procedural has light and dark colors that you can modify using these two
settings.

Scale
This controls the scale of the noise.

Magnitude
This increases the intensity of color 2 and the contrast between the two colors.



Occlusion
This new procedural texture type allows for the addition of proximity-based shading on a
material. It can be used to accentuate or augment the self shadows cast on a material
and along with the Material Graph, create interesting texture effects based on occluded
and unoccluded areas.

Unocludded
Choose a color that will be used where there is least amount of surfaces near each
other. this will most likely be the base color, although there are other creative
applications of this procedural texture.

Occluded
Choose a color that will be used where there are surface near each other. Examples
would be a parting line, a fold of skin, or a narrow alley. For more natural results,
choose a color that is a darker value of your “Unoccluded” color to create deeper
shadows.

Radius
It is the maximum distance towards any occluding object. If an object is further away it
will not be considered in the occlusion computation. This value will control how deep or
far the shaded “Occluded” color will reach on the model.

Falloff
This value controls how blended the two color are.

Bias
The bias settings control the intensity of the occlusion on the model.

Normal
This setting adjusts the contrast between the “Unoccluded” and “Occluded” colors on
the model

X/Y/Z Bias
These settings increase the intensity of the “Occluded” color in relation the X, Y, and Z
directions of your scene.

Advanced

Samples
this setting controls the quality of rendered image.
Sample Same Material Only
Enabling this option with only calculate the occlusion in relation to parts with



this material applied, ignoring other parts.
Inside
This will invert the normal values to determine occlusion. this is useful when
applying this material on a part that was not modeled with interior surfaces.
Fast
Since the Occlusion procedural texture emulates what is happening with global
illumination, you can choose to ignore GI calculations on this material for faster
renders.

Scratches
Scratches is great way to add weathering to materials, and to metal materials in
particular.

Scale
Use this to set the correct scale of the pattern generated.

Bump Height
Increase this value to have deeper scratches.

Density
Use this to control the number of scratches generated.

Size
Use this to set the size of the individual scratches. Expand to control the scratch width
and scratch falloff.

Directional Noise
This controls the randomness of the direction of the scratches. Decrease this value to
have scratches in a more aligned direction. Expand to choose mapping.

Noise
Controls the straightness of the scratches. Increase the value to have more irregularly
shaped scratches. OR irregular scratches. Expand to access the noise scale slider.

Levels
Controls the number of unique scratches that are generated. Expand to access the level
scale.

Spots

The Spots procedural texture is a an interactive method of creating a texture map of scattered spots on a surface.



Inside Color
Use this to set the color of the spots generated.

Outside Color
Use this to set the color of the background.

Scale
Use this to control the overall scale of the texture map.

Density
Use this to control the number of spots that appear on your surface.

Radius
Use this to change the overall size of the spots generated.

Falloff
Feather the edges of your shapes with this parameter.

Distortion
Increase this parameter to randomly warp the shape of the spots.

Distortion Scale
Use this parameter to change the amount of distortion is applied to the spots.

Levels
Increase the amount levels of sizes that appears.

Levels Scale
This changes the difference in sizes between the various levels. Increase the value to greater than one to decrease the smallest spot size.
Decrease the value to less than one to increase the largest spot size.

Intensity Modifier
Increase this parameter to have the spots decrease in opacity as they decrease in size.

Invert
Enable this option to have the spots feather in to the outside color, creating rings or bubble like silhouettes.

Vertex Color
The Vertex Color texture is used only with geometry imported from other 3D
applications that supports vertex color texture maps. Do not use this texture if you are
not importing from a compatible 3D application as it will have no affect.



Default color 
controls the background color that is used for the alpha channel from an imported
vertex texture.

Multiplier
Blend a color with the imported vertex color texture.

Wood
The Wood procedural texture allows you to customize the look of your wood materials.
Most often, you will want to start out with the plastic material type and change the
specular color to white.

Ring Width
This adjusts the thickness of the wood rings.

Ring Noise
This adds random fluctuations in each ring.

Axial Noise
This adds fluctuations or waviness of the overall direction of the grain.

Color Noise
This creates random thick and thin areas to give a more organic look to the wood ring.

Scale
Use this to increase size of the grain. For best results, keep the scale small.

Wood (Advanced)
The Wood (Advanced) procedural texture gives finer control than the basic wood
procedural texture, and creates more realism in the map.

Winter/Spring/Summer/Fall
New wood formed in a tree during spring and summer is light in color. Toward the end
of a growing season, new cells formed are smaller and have darker, thicker walls.
Choose the color swatches to accurately color the rings in accordance with the
seasons.

Scale
Use this to control the overall scale of the texture map.

Ring Width
This adjusts the thickness of the wood ring.



Ring Spacing Variation
This parameter controls the contrast of thick and thin ring shapes to represent different
rates of annual growth.

Ring Noise
This adds fluctuations or waviness to the rings.

Axial Noise
Increase this parameter to add variations to the circular shapes of the rings.

Color Noise
Increase this parameter to add more splotches of color in the rings.

Seasonal Color Noise
Add variation to each color swatch as it blends from each color.

Knots
Knot Color/Border
The knot color is blended into the main colors of the texture. Choose a grey value to
darken the knots. The knot border should be darker than any of the other colors.

Knot Density
This parameter controls how many knots appear in the texture.

Knot Age
Increase this parameter to increase the number of rings that appear in the knots.

Knot Border Size
This parameter changes the thickness of the knot borders.

Knot Distortion
Use this to control the fluctuations and add irregularites in the knot shape.

Branch Scale
Control the overal size of the knots with this parameter.

Grain
Grain Color Bleed
This parameter controls the amount of color each ring blends into the rings on either
side. Decrease to have very clearly defined rings or increase to give the rings a more
blended appearance.

Axial Graniness
Increase this parameter to blur the texture.

Ring Graininess
This adjusts the thickness of the wood rings.

Grain Scale
This adjust the size of the grain striations between the rings.

Grain Thinness
Control the size of the grain striations with this parameter.

Advanced

Seed
Scrub through this parameter to add randomness to all of the previous parameters to
create a more natural look.



Color Fade
The  texture is a unique Texture Type that allows you to quickly animateColor Fade
color changes. A color fade transition can be made between two colors or any
combination of colors by adding addition color stops on the Color Gradient Editor.

See  to see how to use this texture type in the .Color Fade Node Material Graph

Number Fade

The   texture is a unique Texture Type that allows you to quickly animate Map Types. Fore example, a number fade transition can beNumber Fade
used on an Opacity map type to fade a material from opaque to transparent. 

See   to see how to use this texture type in the   and control even more settings.Number Fade Node Material Graph

Map Types
KeyShot has four primary Map Types along with a number of material and texture
settings that can also accept textures. Each  uses texture map typesMaterial Type
depending on the material type and settings. You will see the available map types in the

 window,  tab. The four primary Map Types are:Project Material, Textures

Diffuse Map
Specular Map
Bump Map
Opacity Map

Diffuse Map
The  (also seen as  or ) map type allows an Image texture or Diffuse Color Transmission
2D/3D procedural texture to be applied to replace the basic solid
Diffuse/Color/Transmission setting. This map type provides full color information and will
show transparency when a PNG with alpha transparency is used.

 

 

 

You can easily drag and drop textures from one Map Type to another.(e.g.
from Bump to Specular) by simply holding  (Windows) or  (OSCtrl Command
X) and dragging the texture to another Map Type.
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Specular Map
The  map type can use black and white values to indicate areas that haveSpecular
varying levels of specular intensity. Black will indicate areas of 0% specular reflectivity,
whereas white will indicate areas of 100% specular reflectivity. Notice on the example
that the metal portions are reflective and emitting specular reflections, whereas the rust
area does not. The rust area has black mapped to it, whereas the metal area has
white. 

 

 

 

Bump Map
The  map type are used to create fine details in materials that would be unrealisticBump
to include in the model, like the hammered chrome and brushed nickel in the example.
There are two methods of applying bump maps. The first and easiest is using a black
and white image. The second way is by using a normal map.

Black and White Image
When using a black and white image for a bump map, the black values are interpreted
as lower and the white values are interpreted as raised.

Normal Maps
Normal maps contain more colors than the standard black and white bump maps.
These additional colors represent different levels of distortion on X, Y and Z
coordinates. This can create more complex bump effects than a black and white bump
map which represents only two dimensions. However, most bump effects can look very
realistic without the need for normal maps. Enable this setting when a Bump map is
selected by checking .Normal Map

Bump Height
With Bump maps,  controls the effect of the map. Increasing this raises theBump Height
peaks of the bumps, and helps exaggerate the bump when the texture needs to be
more visible.

 

 

 

Opacity Map
The  map type can use black and white values or alpha channels to make areasOpacity
of a material transparent. This is useful for creating materials like the mesh material
shown, without actually modeling the holes.

Opacity Mode
The opacity mode can be set to three different methods:

Alpha
This will use any alpha channel that is embedded in the image to
create the transparency. If no alpha channel is present, no transparency will be
shown.
Color
This will interpret black areas as completely transparent and white areas as
completely opaque. 50% gray will be 50% transparent. This method is available
to avoid the need for alpha channels.
Inverse Color
Inverse color is the opposite of color. White will be completely transparent,
black will be completely opaque and 50% gray will be 50% transparent.

 

 

 

Mapping Types

Image Textures and 2D Textures allow you to take 2D images and place them onto 3D
objects. How they are applied will affect how they appear. KeyShot provides seven
different mapping types for these types of textures. When an Image Texture or 2D
Texture is active, you will see a Mapping Type option with the following mapping types.
 

Planar

The  mapping type will project a texture on the X, Y or Z axis. The orientation isPlanar
set in the Interactive  tool. Surfaces of 3D models that are not oriented onMove Texture

On this page:

Planar
Box
Sphere
Cylinder
UV
Camera
Node



the chosen axis will show stretching of the texture in the other two axes.

Box

The  mapping type will project a texture from six sides of a cube in towards a 3DBox
model. A texture will be projected from a side of the cube until stretching occurs, then
the next best projection side will take over. Box mapping is a quick and easy solution
that will work in most cases because there will be minimal stretching of textures.

Sphere

The  mapping type will project a texture inwards from a sphere. The texture willSphere
resemble the original image the most at the equator. The texture will start to converge
as it reaches the poles of the sphere. As with box mapping, stretching is less of an
issue when working on multi sided objects than it is with any of the planar mapping
modes.

Cylinder

The  mapping type will project a texture inwards from a cylinder. The texture willCylinder
project the best on surfaces that are facing the inside of the cylinder. The texture on
surfaces that do not face the inner walls of the cylinder will stretch inwards.

UV

The  mapping type is a completely different method of applying 2D textures to 3DUV
models. Using 3D applications such as 3D Studio Max or Maya, you can design how
the texture map is applied to each surface. It is more time consuming and is much more
widely used in the entertainment industry as opposed to the design/engineering world.

Camera

The  mapping type will keep the texture oriented with respect to the camera.Camera
This will provide a consistent texture appearance on the surface regardless of the
position of the camera.

Node

...

 

Move Texture Tool
In addition to the automatic mapping modes, KeyShot has an interactive mapping tool
that will allow scaling, translating and orienting of any of the automatic mapping types
interactively.

The interactive mapping tool is used to fine tune the position of textures as they are
mapped to your model. The tool is accessed from the texture mapping tab within the
material editing menu, and it is available when in box, spherical and cylindrical mapping
modes.

Translate
Use arrow handles to move the texture mapping position on the XYZ axes. To translate
the mapping, click on any of the three axis arrows. The red, green and blue arrows
correspond to the X, Y and Z axes.

Rotate
Use circle handles to rotate and align the texture mapping to your model. Hold SHIFT to
constrain the rotation to 15 degree increments.

Scale
Use cube handles to change the size of the texture mapping. Click on red, green or blue
boxes to scale the texture on only one axis, or click on the center yellow box to scale

 

 



the texture uniformly.

Position
Use this to establish exactly where you want the center of your texture image to project.
Once in position mode, you can simply click on the surface of the model to change the
where your texture is projecting.

Cancel or Confirm Changes
After adjusting the texture mapping with the mapping tool, click the green check mark to
confirm the changes and close the mapping tool. Click the red X to cancel the changes
and close the mapping tool.

 

Labels
Labels are designed for easy placement of logos, stickers or images that need to be
placed freely onto a 3D model. Labels are added through the labels tab in a material’s
properties.

Any common image format will be supported such as JPG, TIFF, TGA, PNG, EXR and
HDR. An unlimited number of labels can be added to a material and each label can
have it’s own mapping type. If an image has an alpha channel embedded, it will be
retained and areas of transparency will not show. The sample image uses a PNG with
transparency so that the square border of the image does not show.

 

In this section:
Label Properties
Label Textures
Label Mapping

 

Label Properties
Adding Labels
Labels are added by either clicking the “+” Icon and selecting “Add Label.” Once added,
the label name will be displayed in the list. You can also choose “Duplicate” to create
copies of existing labels.

Deleting Labels
Labels can be deleted by selecting the label in the list and clicking the Trash Icon

Duplicating Labels
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Labels can be duplicated by selecting the label in the list and clicking the Add Icon, and
select duplicate.

Layering
Labels will be layered as they are added. If labels overlap on the model, they will stack
in the same order as ordered in the Labels list. The label order can be shifted by
pressing the up and down arrow buttons.

Label Type
Each label can be assigned a material type. The default material applied to a label is
plastic, but it can be changed to Advanced, Anisotropic, Diffuse, Emissive, Metal,
Metallic Paint, Paint, Translucent, Toon, and Xray. The Properties Tab will show the
contextual settings for the label type selected. See the Materials section for more.

 

 

Label Textures
In the  tab you can add other maps to your label similarly to the  Label Textures Textures
tab for Materials. The type of texture maps available to a label type will be similar to the
type of textures available to the material type. Use the check boxes in the list of texture
types to enable or disable a texture map.

Reload

Use the  button  if you made changes to the image file and need to updateReload
the Label on your model.

Load

Use the Load button  to replace the label map image file with a different file. The
name of the file will appear in the text box.

To learn more about the label capabilities in KeyShot watch the video below.

 

Label Mapping
The default mapping type for labels is Normal Projection. This allows labels to be
projected on surfaces interactively. Change the mapping type by using the Mapping
Type dropdown menu.

To position the label, click the mapping tool button and then click on the model to move
the label. When the label is in the desired position,

Confirm the placement by clicking the green check button in the bottom of the realtime
window. That will deactivate the interactive positioning.

To scale the label, move the scale slider. This will adjust the size of the label and
maintain height to width proportions. To scale the label vertically or horizontally, expand
the scale parameter to scale independently on the X or Y axis.

To rotate the label, use the angle slider which will rotate the label in degrees.

Labels can also be flipped vertically, horizontally and repeated by checking any of those
options.

Enabling the “Two Sided” option will display the label on both sides of the surface it is
applied to.

The “Sync” option will sync the mapping settings across all texture maps applied to the
the label.

Brightness and Contrast sliders adjust the label image qualities.

 

Environments
The primary method of lighting a scene in KeyShot is through Environment
Lighting. Environment Lighting uses spherical High-dynamic-range imaging (HDRI) to
represent the full, physically accurate lighting of an interior or exterior space.



Environment Presets
KeyShot comes with many environment lighting presets to get you on your way fast.
Access all environment preset from the  window,  tab. AdditionalLibrary Environments
environments may be accessed on .KeyShot Cloud

Environment Tab
The  tab is where you control all the settings for your environment lighting.Environment
Access the settings from the  window,  tab.Project Environment

HDRI Editor
KeyShot Pro users will see the HDRI Editor button on the Environment tab directly
beneath the HDRI preview. 

In this section:
Adding Environments
Adjusting Environments
Changing the Background
HDRI Editor

 

Adding Environments
KeyShot is designed to provide real-world lighting right out of the box. Through
environment presets and the ability to modify them or create your own, your scene can
be lit just the way you need with everything visible in real-time.

Environment List

The  tab of the  window includes the ability to save differentEnvironment Project
Environments and their settings to a list for fast access and navigation.

When a new scene is opened the Environment List is populated with the environment
used in the Default Startup Scene specified in the General Preferences. All changes
made to the settings will be recorded and saved with that environment.

Creating a New Environment

To create a new Environment based your current settings, click the  icAdd Environment

on  at the top left of the pane. Alternatively, you can populate the list with
environments by dragging-and-dropping one or more from the  Library.Environments

On this page:
Environment List
Creating a New Environment

Adjusting Environments
KeyShot allows you to adjust your HDRI lighting through a set of easily adjustable
settings.

Changing the Background

In KeyShot you have 3 options of showing the environment 

HDRI Editor
The KeyShot  is a simple way to make adjustments to lighting environmentsHDRI Editor
or create your own. The  provides a unique system of adjustable light,HDRI Editor
image and gradient   to light your scene.Pins

HDRI Editor Overview

The KeyShot HDRI Editor is fully integrated into the  Environment tab located in the Proj
 windowect . All  and settings for ,   and  are embeddedPins Color Adjustments Transforms

in the KeyShot file eliminating the need to save an individual .HDZ for each custom
Environment you create. This provides a huge convenience and asset management
benefit while greatly reducing the amount of data necessary to store locally and in
KeyShot .KSP files.

The HDRI Editor has flexible features including:

In this section:

HDRI Editor Pins
HDRI Editor Background
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Export of HDR/EXR
Gradient Background
Draggable interactive Sun & Sky
Sun & Sky Ground Color
Sun Size parameter
Rectangular Pin Rounded Corners
Gradient Pins
Image Pin Color Adjustments
Extract pins from previous version HDZ files
Pop out HDRI Editor canvas

 

HDRI Editor Pins
Pins are light sources that can be placed into the HDRI to further enhance the image
file, and give the desired lighting effect on the object scene.

Pin List

Contains all the pins created in the HDRI editor. You can enable or disable a pin by
clicking the checkbox to the left of its name. You can rename a pin by double clicking its
name. Right click pins for options to delete or duplicate. The icon to the right of the
name denotes the type of pin it is. The active pin being edited will be highlighted blue in
the list and will be marked by a blue dot in the preview window.

Pin Options

Add Pin

The  options include , , , and Add Pin Add Pin Add Gradient Pin  Add Image Pin Add Copy
 Click on the “+” icon to add a pin. Select a pin type to place in the HDRI. The newPin.

pin will be displayed in the pin list as well as the preview window. To make a pin active
for editing, select it in the pin list or click on the pin handle in the preview window. Drag
the pins by their handles to position them. The “Add Highlight”-pin is explained below in
the “Set Highlight” section.

Delete Pin
Click on the trash can icon to delete the active pin.

Move Pin Up/Down
Click on the arrows to change the pin order in the pin list. The order is important as it
will display and layer pins from the top down.

Pin Folders
Use pin folders to organize all your pins in your HDRI. Click on the “Add Folder” icon to
add a folder to the list and drag pins into the folder.

Set Highlight
Adding and setting highlights can be achieved by clicking “Set Highlight.” This will bring
forward the KeyShot realtime window where you can position your pin by selecting a
region on the model you want to highlight. CTRL+Click (CMD+Click on Mac) anywhere
on the surface of the model and a pin will be generated facing that point on the surface.
When finished, click “Done.” Pins added this way can be edited as normal.

To set an existing highlight click onto “Set Highlight”, and then select an existing pin in
the editor. Click on the object to set the highlight using the selected pin, and use your
left mouse button to drag it into the right position.

Pin Types Explained

Standard Pin
Add Pin places a pin into the center of the unfolded HDRI. Grab it to place it in the
desired location. Use the controls explained in section “Adjusting Pins” to get achieve
the desired effect.

Gradient Pin
A Gradient Pin allows you to place a light source with color and opacity variations.

On this page:

Pin List
Pin Options
Pin Types Explained
Additional Settings



Copy Pin

When this options is selected, a snapshot is taken of the HDRI image and used as a
new pin. After you select “Add Copy Pin,” a pin handle with an orange outline will
appear on the preview window. This outline shows the area of the image that will be
copied to be used as a pin. Toggle between circular and rectangular for shape you
want, then set the size and angle with the adjustment sliders. When on the green check
to create the copy pin.

After creating the copy pin, move the pin by the handle to place it where desired.
Adjustment sliders similar to those used with the regular pin will be available with the
same effects.

Image Pin
The image pin allows you to use HDR, HDZ, EXR, JPG, PNG, JPEG, and BMP as a
pin. There are limitless usages for this pin, such as creating specific reflections,
simulating a lighting array and using part of an HDR with another HDR among others.

When adding an image pin, you will prompted to select an image to be used. Once
selected, the image will be placed in the preview window.

Adjustment sliders will be available to edit the image pin. These sliders are similar to the
regular pin sliders.

Additional Settings

Circular/Rectangular

This will toggle the shape of the pin. This is crucial when creating very specific shapes
and reflections in your renderings.

Half
For either pin shape you can select the shape to be cut in half. This will cut the pin in
half. All adjustments will work the same except that you are now only seeing half of the
pin.

Radius (Circular)
This determines the pin size of circular pins.

Width/Height/Angle (Rectangular)
This determines the shape and size of rectangular pins.

Color
Use this to set what color the pin will project. For accurate real-world lighting, use the
Kelvin scale.

Blend Mode
With this option, choose different ways to have the pins blend and interact with each
other. Pin order becomes very important with this function.

Falloff Mode
This controls the falloff of the light from the center of the pin. Different modes have
different behaviors. You can see the effect of the various modes both in the editor as
well as in the KeyShot realtime window.

Falloff
This controls the softness of edge of the pin light. Increase the falloff for more blended,
softer edges.

Brightness
Use this to adjust the overall intensity of the pin light.

 

HDRI Editor Background

When you select the  item in the  you have four optionsBackground HDRI Editor Pin List
for your HDRI Editor Background: , ,  and .Color Gradient Sun & Sky Image

Color

On this page:



Gradient

Sun & Sky

Resolution
Here, set the resolution of the sun and sky that will be generated. A smaller resolution
has better performance, but a larger resolution has better shadow and reflection quality.

Location
Here, you can choose a preset city that is closest to where the scene is taking place for
accurate portrayal of the sun and seasons at location.

Coordinates
Another option is to choose “Custom Location” and enter the geo coordinates of a
location.

Date
Use this to set the date to the day the scene will be taking place for accurate portrayal
of color temperatures of the seasons.

Time
Use this to set the time the scene takes place for correct placement of the sun.

Turbidity
Increase this setting to add more haze to the sky. This will tint the sky with a warm tone
and filter the sunlight that is cast in the scene.

Keep Pins
Enable this feature to keep any pins already created when generating a sun and sky
HDRI.

Keep Environment Settings
Enable this feature to retain environment settings when generating a sun and sky HDRI.
Keep Adjustments
Enable this feature to retain adjustments to the normal HDRI when generating a sun
and sky HDRI.

Generate HDRI
Once your settings are complete, click this button to replace the existing HDRI with a
sun and sky HDRI. Caution: Clicking this will remove the previous HDRI. If you want to
save your previous HDRI, make sure to save it first before you click “Generate HDRI.”

Image

 

Cameras
The  tab controls the settings for all camera views in KeyShot nand allows youCamera
to set the active KeyShot camera. It also allows you to save different camera views of
your scene, which allows cameras to be re-used, modified, or animated. Cameras can
be adjusted much like a real camera and include advanced functionality such as shift
lenses, walkthrough mode and Depth of Field, along with KeyShot Pro features such
as panoramic lenses, to produce cube or spherical maps for real-time VR rendering and
output. 

This section explains how to work with the different types of cameras and their
respective settings.

In this section:
Navigating Your Scene
Camera List
Position and Orientation
Lens Settings
Perspective Matching
Stereo (VR)
Depth of Field
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Navigating Your Scene
The following explains how to use your mouse to change the view of your camera. It’s
important to realize that the mouse is moving the camera and not the model, unlike a
3D modeling application. In other words, when you use Left Mouse Button (LMB) to
rotate, the camera is rotating around the model. To change the position of the models,
see .Moving Models and Parts

Mouse Controls

The mouse is the main method for controlling the position and orientation of the
camera. With it, you can rotate, pan and change distance

Camera Tumble (Rotate)
To tumble your camera, press and hold LMB while moving the mouse. This changes
both the azimuth and inclination of the camera.

On this page:

Mouse Controls
Keyboard Controls
Multi-touch Controls
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Camera Pan
To pan your camera press and hold the MMB while moving the mouse. This changes
the position of the camera.

Camera Dolly (Distance)
To dolly your camera, roll the scroll wheel forward to increase distance or back to
decrease distance. 

Keyboard Controls

KeyShot also provides additional ways to navigate your scene and control your camera
using the keyboard. 

Camera Dolly (Distance)
To dolly your camera, press Alt + RMB (Windows/Mac) while moving the mouse. This
changes the distance of your camera.

Camera Perspective
To change camera perspective, press Shift, Alt + RMB (Windows/Mac). This will adjust
perspective and field of view.

Camera Twist
To twist the camera, press Ctrl, Alt + Wheel (Windows) or , Alt + Wheel (Mac). 

Standard Views
To cycle through the standard view (front, back, left, right, top, bottom, isometric
select Ctrl, Alt + 1-7 (Windows) or , Alt + 1-7 (Mac)

Focal Length
To change Focal Length press Alt + Wheel (Windows/Mac).

Set Camera Target
To quickly center the camera on an area, select Ctrl, Alt + RMB (Windows) or , Alt +
RMB (Mac).

Next Camera/Viewset
To toggle through cameras and viewsets, press Shift + N. 

Toggle DOF
To toggle Depth of Field (DOF) press D.

All KeyShot hotkeys can be seen .here

Multi-touch Controls

Basic touch controls allow you to orient the camera on touch-enabled devices. 

1 Finger – Tumble camera
2 Finger Pinch – Zoom
3 Finger Drag – Pan
5 Finger Touch – Reset camera

Learn more about multi-touch input .here

 

Camera List
The camera list at the top of the Camera tab contains all the cameras for the scene. In
the camera list, the  is always available and cannot be locked orFree Camera
overwritten. It can always be selected and remains independent of camera animations.

Saving a Camera

To save a new camera, select  to the left of the camera list.Add new camera 
Cameras can be renamed for easy identification and better organization, simply
right-click and select .Rename

The    is a Pro feature that allows you to addAdd Camera and Environment Studio

On this page:
Saving a Camera
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a Studio along with the currently active camera and environment.

Note: This replaces the Viewset functionality from KeyShot 5/6. Read more information
about the Studio feature and Viewset to Studio conversion here.

After a camera is saved, any change while that camera is active will display  a(unsaved)
fter the camera name. If you want to save the changes you can select Save Current

   which overwrites the active camera settings. If you do not want to applyCamera
changes, select  to revert the active camera back to its last saved state.Reset Camera

Select will add a new camera to the list, and the previouslyAdd new camera 
selected camera view will be preserved.

Additionally, any camera can be locked by right-clicking on the name or by selecting the
lock icon .

Any unlocked camera can be deleted using the   .Remove current camera

Position and Orientation
All KeyShot cameras are defined by their position in 3D space in relation to the Camera

. The Camera Target specifies the exact mathematical point or location theTarget
camera is “looking at.” This relationship is critical to understand, especially when
fine-tuning settings and creating camera animations.

Position and Orientation Settings

When the camera is moved in the Real-time View, the  settingsPosition and Orientation
will update to reflect the current camera position. Using the default Spherical definition;
the Distance, Azimuth, Inclination, and Twist are all measurements from the Camera
Target location.

Camera Modes

There are two modes for defining Position and Orientation: Spherical and Absolute.

Spherical
Default setting for defining position and orientation of the camera. All values
reflect camera position in relation to the static Camera Target.

Distance - Distance between the Camera Target and Camera
in scene units. Setting this value too low can lead to the
camera being “inside” the 3D model. This can be controlled
with the mouse scroll wheel. The direction can be inverted in
Preferences.
Azimuth - Rotation around KeyShot up (Y) axis, measured in
degrees.
Inclination - Defines camera tilt, or vertical rotation from
horizontal plane.
Twist - Defines camera twist.

Absolute
Position - Defines X/Y/Z coordinates of camera location in scene units.
Target - Defines X/Y/Z coordinates of Camera Target in scene units.
Keep View Direction - Locks View Direction for Position/Target
changes.
Twist - Defines camera twist.

Set Camera Target

Press the   button to define a new location that the camera will beSet Camera Target
referencing as its target by clicking on an object in the scene. The default Camera
Target is always the center of geometry in the scene.

Walkthrough Mode

On this page:
Position and Orientation
Settings

Camera Modes
Set Camera Target
Walkthrough Mode
Standard Views
Grid
Stay Above Ground
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See .Walkthrough Mode

Standard Views

Quickly access camera presets based on common orthographic directions.

Grid

Enables on-screen grid (not visible in rendered output) which can be helpful for image
composition and camera placement.

Stay Above Ground

This option allows all camera movements to be restricted to the upper hemisphere. This
is useful for scenes where bottom views are undesirable.

Walkthrough Mode
Walkthrough Mode allows you to move around inside your scene and see it from a
"first-person" point of view.

To enter Walkthrough Mode go to  window,  tab, Project Camera Position and Orientation
. Select  and the Walkthrough Mode HUD will appear and a cameraWalkthrough Mode
called   will be added to the camera list.First Person

Walkthrough Navigation

To navigate within the scene in Walkthrough Mode, you can:

Use the arrows on your keyboard or the arrows in the widget.
Hold the left mouse button and drag in the direction you would like to move.
Hold the right mouse button and drag to rotate in place.
Hold the middle mouse button to pan the camera.

On this page:
Walkthrough Navigation

Lens Settings
The various Lens Settings can be found in the  window, under  tab, Projects Camera Len

. The four types include:s Settings

Perspective
Orthographic
Shift
Panoramic

In this section:
Perspective
Orthographic
Shift
Panoramic

Orthographic
An  lens uses parallel projection to view the scene: all lines parallel to eachOrthographic
other appear parallel regardless of camera distance or position. An orthographic lens is
most commonly found in CAD modelers and is not affected by perspective distortion,
foreshortening, or parallax. This means that relative distance in the realtime view is
always accurate for any parallel or perpendicular lines. 

Panoramic
The  for Cameras allows you to render a Spherical or Cube MapPanoramic Lens Setting
image in real-time or rendered output. This feature can be used to render out your own
spherical EXR images to use as environments to light KeyShot scenes or to load in your
VR headset image viewer. Whenever a  is used, the camera position willPanoramic lens
be limited to spherical 360 degree viewing and the camera target is used as a position
reference.

Using the Panoramic Camera

In the Camera tab, under Lens Settings, select Panoramic. Select your desired format
of Spherical or Cube Map from the Mode radio buttons. The Real-time View will display

https://luxion.atlassian.net/wiki/spaces/K7M/pages/40106719/Walkthrough+Mode
https://luxion.atlassian.net/wiki/spaces/K7M/pages/54624257/Perspective
https://luxion.atlassian.net/wiki/spaces/K7M/pages/54624262/Orthographic
https://luxion.atlassian.net/wiki/spaces/K7M/pages/54558723/Shift
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40111258/Panoramic


a Panoramic Preview message at the top to indicate you are Panoramic mode. This
means the camera can be rotated spherically and the real-time rendering in the Real-ti
me View will not occur.

Reset Panoramic Camera

Click the Reset View button at the bottom of the screen to return the camera to the
original view.

Preview Map

Click the Preview Map button in the Lens Settings to open a flat preview of your
Panoramic image.

Panoramic Camera Resolution

When using the Spherical Mode the Resolution in the Image tab will be locked at a 2:1
ratio. Cube Map Mode will be locked to an 6:1 ratio. Try increasing the pixel resolution if
the image does not appear clear.

Moving a Panoramic Camera

Since the Camera Position is limited to 360 degree viewing, there may bespherical 
times where you want to adjust the camera position. There are two way to move a
Panoramic Camera.

Position and Orientation

You can use the  sliders or input boxes in the  tab toPosition and Orientation Camera
adjust  and . Grab the slider to make fast Distance, Azimuth, Inclination Twist
adjustments or enter a value into the input box for more precision.

Geometry View

If you are using KeyShot Pro, You can open the Geometry View (Window, Geometry
), select the Geometry View icon on the Ribbon or hit the . In the GeometryView... O-key

View, you can right-click the active camera and select  toMove Active Camera Position
adjust the camera. When you move the active camera, you will see it automatically
adjust to keep the same camera target.

On this page:
Using the Panoramic
Camera
Reset Panoramic Camera
Preview Map
Panoramic Camera
Resolution
Moving a Panoramic
Camera

Position and
Orientation
Geometry View
Related Pages

Related Pages

Render VR Images

Perspective

A  lens closely represents how physical camera lenses work. The Perspective Perspecti
 controls the amount of distortion (convergence) seen in the realtimeve / Focal Length

view; real world values can be used here to replicate camera lens focal lengths.

Popular focal lengths (Source: Wikipedia).

14 to 21mm: Ultra-Wide — Dramatic distortion due to very short focal length. 

24 to 35mm: Wide — Wider field of view than a standard lens. The resulting
perspective can show some distortion.



50 mm: Standard — Some distortion but generally acceptable for most use.

85 mm: Portrait — Less distortion than standard lenses.

135 mm: Telephoto — Commonly used to capture faraway objects or in product
photography for 

200 to 500 mm: Super Telephoto — Specialized lenses for minimal distortion.

When trying to match perspective in an backplate image, it is recommended to set the
Perspective value to the camera lens focal length which is often included in the Exif
data. 

Field of View is inversely related to Perspective and controls the “cone of vision” seen in
the realtime view. Larger Perspective values will result in a smaller Field of View, while
smaller Perspective values increase the amount that’s visible in the realtime view. 

Ground grid will overlay a 1:1 grid on the KeyShot ground plane; the density of the grid
is controlled by the Environment size. This grid is useful for matching perspective and
camera angles and will not be visible in rendered output. 

Shift
A  lens is useful for recreating two-point perspective camera views. It allows you toShift
keep a camera’s position while shifting the viewing plane to eliminate vertical distortion.
Most commonly seen in architectural photography, a Shift lens can be used to remove
the third (vertical) vanishing point in product photography. A blog post showing the use
of the Shift lens can be found here: https://blog.keyshot.com/2016/use-shift-lens-setting
-keyshot

To use the Shift lens, press the  button and KeyShot will calculateEstimate Vertical Shift
the values needed to achieve a 2 point perspective lens. The Perspective/Focal Length
and Field of View can still be adjusted to control the amount of perspective distortion.

Vertical Shift and  control the vertical and horizontal movement of theHorizontal Shift
camera’s viewing plane; these values can be adjusted beyond the slider extents
(including negative values!) to control what’s visible in the realtime view. 

Any time the camera position is changed, it is necessary to re-calculate the shift values
by pressing the “ ”button. This ensures that the values are correctstimate Vertical Shift
for the current camera position and orientation.

Perspective Matching

Perspective Matching allows you to interactively match the camera to the camera with which a background image was taken. In orderPerspective 
to activate  , please load a  . Refer to  for further information on this topic.Match Perspective Backplate Changing the Background

When clicking on the  button, you will notice 2 or 3 sets of lines in different colors along with a dialog.Match Perspective

For best results we recommend to turn on , found under the   menu. It can also be toggled on and off using the   hoShow Coordinate Legend View Z
tkey. This will help you identify the orientation of the model in the scene.

How it works:

https://blog.keyshot.com/2016/use-shift-lens-setting-keyshot
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Decide whether you want to use 2 or 3 point perspective, i.e. 2 or 3 vanishing points. In most cases you want to use a 2 point perspective. 3 point
perspective is most commonly used when trying to place building or object when the camera is placed at a low of high eye level. When using 2
point perspective, you will only adjust the vanishing according to the plane on which the object is placed. 3 point perspective adds another set of
lines allowing you to adjust the vanishing point in the vertical direction.

Notice that the lines and colors correspond to the scene's coordinate system. X is blue, Z is red, and Y is green. Move the end points of the lines
according to the coordinate layout to reference points in the background image. Notice the camera values update accordingly. Once aligned, pan
and dolly the camera to position the object so it fits properly inside the scene.

Two-Point Perspective
Adjust the perspective with 2 sets of orthogonal lines to match the vanishing points of a background image.

Three-Point Perspective
Adjust the perspective with 3 sets of orthogonal lines to match the vanishing points of a background image.

Ground Grid
Turn on ground grid in the scene to help match the perspective.

Reset lines
Reset all sets of lines to their default position. The camera will update accordingly.

Stereo (VR)
Stereo mode will display when ,  or Perspective Panoramic Cube Map Panoramic

is selected. This setting allows a scene to be viewed in real-time or output asSpherical 
still images and animations using virtual reality (VR) hardware.

Spherical and Cube Maps offer a 360-degree stereo viewing experience while Stereo
Perspective shows a stereoscopic image of the viewport. For more information on using
KeyShot with VR devices, please see the   section.Virtual Reality

Head-Mounted Display (HMD)

Support is available for real-time viewing using Oculus Rift and HTC Vive
Head-Mounted Display (HMD) viewing (currently Windows only). From the  tab,Camera
enable the  option for your  or  camera. Click the Stereo Perspective Panoramic Head-Mo

 button to select Oculus Rift or OpenVR for HTC Vive to open the HMDunted Display
viewing window. 

Note
An HMD must be connected for the Head-Mounted Display button to be
enabled and viewing window to be activated.

https://luxion.atlassian.net/wiki/spaces/K7M/pages/40111433/Virtual+Reality


Depth of Field
Depth of Field allows you to set the focus distance and the f-stop of the camera just like
you would with a regular camera.

To enable the depth of field, go to Project  Camera and click on the Depth of Field
check box. Once enabled you can either use the   button or use theSelect Focal Point
manual values.

By clicking on the   button you can then click on any part of theSelect Focal Point
real-time view and   will focus on that point and blur out rest of the scene inKeyShot
accordance with the F-stop.



Image



This section covers all items found in the  tab of the  window.Image Project In this section:
Resolution
Image Adjustments
Image Effects
Region Rendering

Resolution

Resolution is the first item found in the  >  tab. This resolution defines the width and height in pixels of the real-time view andProject Image
changes dynamically as you adjust the application size and docked window size.

https://luxion.atlassian.net/wiki/spaces/K7M/pages/40107366/Resolution
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40107432/Image+Adjustments
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40107531/Image+Effects
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40108156/Region+Rendering


How it Works

Whatever aspect is set here defines the aspect for final image output. For example, if you plan to render at 1920X1080px you want to make sure
the resolution set in the  tab has the same aspect. The easiest way to do this is to select from the  dropdown. This will automaticallyImage Presets
lock the aspect to the selected preset. A locked aspect is indicated by the chain-link icon located in between width and height set to a blue state.
 When this is the case you will be able to change the size of the application window and maintain the correct image aspect for output. If you do not
want the real-time view to adjust size as you resize the docked windows and application window you can enable the lock icon to the right of the
height field. 

If your desired output resolution is not populated in the  dropdown you can manually type in the values or you can create a customPresets
resolution or aspect preset by selecting  from the  dropdown. Once created, you can access your custom presets through the Edit Custom Presets

 flyout menu in the  dropdown.Custom Presets



Image Adjustments

Brightness and Gamma are post processing image effects. 

Image Effects

The parameters found in the Effects accordion are post processing image effects that do not affect render performance or time.

Bloom

Vignette

Chromatic Aberration

Region Rendering

When working on scenes in KeyShot with complex lighting or materials, you may notice the Real-time View can take longer to resolve. Real-time
Region Render can help maintain a fast workflow by allowing to render specific regions of your scene in real-time.

To initiate Real-time Region Rendering, select the   tab, located in the   window. At the bottom, click the   checkbox as shown inImage Project Region
the image below.



In the Real-time Viewer, drag the corners of the region render box to focus all of KeyShot’s render power on the area you’re want to resolve. The
smaller the Real-time Region is, the faster the image will resolve, allowing you to maintain that speedy workflow. You can see a side-by-side
comparison of a layered glass material with and without enabling Real-time Region Rendering below. In this example, the Region render image
resolves 300% faster.

When it’s time to start your final render, be sure to uncheck the Region Render box if you want to render the extents of the Real-time View.

KeyShot is known for being a tool that offers great results in very little time. Real-time Region Rendering is one of the many features that allows
you to maximize your creative output and reduce the time it takes to produce that final shot.

Studios

KeyShot  allow you to combine and save scene variations in one file for quickStudios
creation and presentation.  may contain any combination of , Studios Camera Environme

,  or .nt Models Sets Multi-Materials

On this page:
Working with Studios



Working with Studios

View the  window from the main menu under  The  wiStudios Window, Studios... Studios
ndow is a dockable window and may also be accessed from the  at the top of theRibbon

KeyShot interface by selecting the Studios icon  .

Within the dialog there are four dropdown menus that display the currently active Camer

, , . Click the  icon  in the topa Environment Model Sets or Multi-Materials Add Studio
left corner to add a new Studio with the active elements added to that Studio.

Inline with the Studio name are icons  that indicate what elements are
included in that Studio. By default the active  and  are includedCamera Environment
when a new Studio is created. With a Studio active, uncheck any checkbox to exclude
that element from the Studio. To modify a Studio simply select a different , Camera Envir

,  or  from the dropdown menus. Multiple Model Sets canonment Model Set Multi-Material
be added to a Studio by checking the corresponding boxes within the  dropdModel Sets
own menu.

Viewset to Studio Conversion

Viewset to Studio Overview

Prior to KeyShot 7, you could create a , a combination of a Camera andViewset
Environment, or a  a combination of Camera/Viewset and Models. A  Scene Set, Studio
simplifies this by combining options for Camera, Environment, Models and Materials in
one window.

On this page:
Viewset to Studio Overview
Opening Scenes with
Viewsets
Studio Workflow for Adding
Camera/Environment
Combos 
Notes on Studios
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Opening Scenes with Viewsets

In KeyShot 7, when a scene with Viewsets and/or Scene Sets is imported, each
Viewset and Scene Set is converted to a Studio. When you import a scene that contains
Viewsets or Scene Sets, you will see this message:

The Studio window should appear after you open the scene. If you do not see it, select 
 or hit the . Any previous Viewset or Scene Set will appearWindows, Studios... U-key

with the same name in the list of Studios.

Studio Workflow for Adding Camera/Environment Combos 

Prior to KeyShot 7, when selecting 'Add new viewset' a Viewset would appear in the
camera list with a unique Camera and Environment. The same can be done using
Studios using the following workflow:

Adjust Camera to desired position.

Select Add Camera and Environment Studio  , Add Locked.
Drag-and-drop an Environment into the Real-time View and repeat step 2.

Another approach is to set a Camera and Environment, then Add a Studio.

Select an existing Camera or Add New Camera  .
Select an existing Environment in list or drag-and-drop an Environment into
Environment list and select.

Select from Ribbon or Studios dialog.Add Studio   

You can now cycle through the Studios to view the different Camera and Environment
combinations you've created.

Notes on Studios

When you add a Studio, it enables the active Camera and Environment
If you add a new camera to the camera list, it will use the camera selected
If the Free Camera is active when a Studio is created, Camera will not be
enabled for the Studio
If you add an Environment to the Environment list, it will use the environment
selected

Render
Taking a screenshot of the Real-time View may be adequate for the initial design
iteration process but eventually you will need to output high-resolution Still Images,
Animations or a KeyShotXR. You can do this through the  dialog, which is foundRender
on the KeyShot  .Toolbar

In this section:

Render Output
Render Options
Render Queue
Image Editor

Render Output
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The   page is where you define the file specifications. The first step is to select theOutput
type of output you desire. There are three types of output:

Still Image
A static image and the default rendering output. View options.

Animation
An animation with optional video and individual frame output. Note: This option is only
available if there are animations in the scene. . Learn more about View options Animatio

.n

KeyShotXR
An interactive KeyShotXR with all code and images. Note: This option is only available if
you have the KeyShotXR add-on. . Learn more about .View options KeyShotXR

In this section:
Still Image Output
Animation Output
KeyShotXR Output
Layers and Passes

Still Image Output

The  output option provides output of a single static image as well as optionsStill Image
for render layers, render passes and region rendering.

Output Options

Name

Set the file name of the render in the text field. If one is not entered, the default name
will be the scene name with an incremental suffix.

Folder
Choose where the render will be saved. Unless a specific folder is chosen, it will be
saved in your KeyShot 6 renders folder.

Format
Choose from JPG, TIF, EXR, TIF 32 Bit, PNG, PSD, and PSD 32 bit. All formats other
than JPG can include an alpha channel. The PSD format will output a single layer PSD
file.

Resolution
Set the resolution of the render. Type it in or select from the presets.

Print Size
If final output is for print quality, enter in the dimensions of the print size as well as the
desired DPI. After size has been set, the resolution will update with the correct
dimensions.

Layers and Passes

See  section.Layers and Passes

Region

Select the   render checkbox to enable rendering a smaller portion of your overallRegion
image. Rendering a smaller region speeds up the rendering time. This is useful when
only a small change to one part of a scene is needed. After enabling region render,
select and move the drag points to resize the region in the Real-time View window or
enter a specific   and   location, or   and  . Note: Units are in pixels.Left Top Width Height

On this page:
Output Options
Layers and Passes
Region

Animation Output

Output Options

Resolution
Set the resolution for the animation being rendered. Choose from the preset pulldown,
or enter in your own custom dimensions.

Time Range
Specify the range of the animation to be rendered. Default is “Entire Duration.” You can
also set the designated work area to be rendered, as well a specific frame range. The
“duration” and “frames” auto updates when time range is changed.

On this page:
Output Options

Video Output
Frame Output

Layers and Passes
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Video Output

Set the name and Folder location where the animation will be saved. Choose a file
format with the pulldown.

Frame Output

Enable to output every frame used to create the animation. Designate the file name and
folder where the frames will be saved. See Settings for Still Image output for settings. In
order to modify the frame number postfix change the "%d" to i.e. "%04d" if you want the
frames to have the format frame.0001.jpg.

Layers and Passes

See  section.Layers and Passes

KeyShotXR Output

The   output option is available if the KeyShotXR Add-on is installed. TheseKeyShotXR
options provide setup and output of a KeyShotXR as well as options for render layers
and render passes.All the parameters set in the  can be edited in theKeyShotXR Wzard
KeyShotXR Render Output options as well. Additionally, there are other options for file
format, file size, and iBooks output for viewing on iOS devices. There are also
Advanced options for KeyShotXR control, customization and direct upload to a website
via FTP. This section describes these settings in detail.

Output Options

This section allows you to set up the resolution as well as the destination of the
KeyShotXR.

Image Quality
Selecting the “Preview” button will render one frame from the KeyShotXR and has a
compression slider that allows adjustments to the quality of the image, and updates in
real-time. Be aware that a larger file size could increase the time to load the
KeyShotXR in the browser.

iBook Widget
If this is enabled, an HTML5 widget will be output in the same folder as your
KeyShotXR which can be embedded in an iBook using iAuthor. Choose the Ppad model
that you will be creating the iBook for from the drop-down options.

KeyShotXR Control

Rotation Control

...

Smoothness Control

Animation Frames
If animation is applied to the scene, you will be able to create a KeyShotXR from this
animation. Additional parameters will be shown if enabled. See previous page for

On this page:

Output Options
KeyShotXR Control

Rotation Control
Smoothness Control
Angle Control

Advanced
Layers and Passes
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animation frames settings.

Horizontal Frames
This controls the number of frames in the “X” direction. The higher the number of
frames, the more smoothly your model will rotate.

Vertical Frames
This controls the number of frames in the “Y” direction. The higher the number of
frames the more smoothly your model will rotate.

Number of Images to be Rendered
This shows the number of images to render based on the number of horizontal and
vertical frames.

Horizontal/Vertical Angle Increments
This shows the degrees between each frame. This value will change depending on the
number of vertical and horizontal frames and the starting and ending angles.

Angle Control

Use these sliders to control the beginning and ending of the KeyShotXR.

Horizontal
This controls the beginning and end of the rotation on the “X” plane.

Vertical
This controls the beginning and end of the rotation on the “Y” plane.

Advanced

Advanced settings for KeyShotXR are located in a drop-down menu on the same
window as the custom settings. This menu controls how your KeyShotXR interacts in
the web browser.

Rotation Damping
Increasing this value will increase the smoothness of the camera rotation when panning
inside the web browser.

Mouse Sensitivity
This controls the overall mouse sensitivity in the KeyShotXR . Increasing this value will
increase the model movement with less mouse movement.

Zoom-In
Enabling zoom-in will allow you to zoom into the KeyShotXR when inside the browser.
Use the “Maximum Allowed Zoom-In Percent” slider to control the amount the user can
zoom in your KeyShotXR.

Preserve Image Quality
Enable this option to render the frames at larger resolution for optimal image quality
when zooming in. The image quality will be preserved when zooming in by enlarging the
rendered frame resolution accordingly. This is separate from the viewport resolution
setting for each frame. This will also increase the KeyShotXR file size.

Download on interaction
Enabling this option will set the KeyShotXR to only load the images into the browser
after the user interacts with the KeyShotXR .

Allow Fullscreen Mode By Double-Click
Double-clicking the left mouse button will enter full-screen mode.

Show Loading Icon
enabling this will allow the loading icon to be shown when the KeyShotXR is loading in
the browser. This image can be changed by selecting “Browse” and browsing to the
image file you prefer.

Name of Div
This defines the KeyShotXR section in the HTML code.

FTP Deployment
Enable this option to allow KeyShot to load the rendered KeyShotXR directly into your
FTP address.



Confirm Before Deployment
When the KeyShotXR is finished rendering, you will be prompted to accept the
deployment to the FTP site.

Generate Embeddable HTML Code
This will give you the code necessary for implementing your KeyShotVR in a website
using the iframe tag.

Embed FTP Settings in BIP File
This will save all the FTP credentials inside your KeyShot BIP file for easy deployment
by another user.

Layers and Passes

See   section.Layers and Passes

 

Layers and Passes
KeyShot supports output of render layers and render passes. Render layers output
specific parts and models assigned to layers, while a render pass outputs a specific
attribute of the scene on its own layer. For example, a Lighting pass will output all the
lighting on a single layer while a Shadow pass will output all the shadows on a single
layer.

Output of layers and passes is used to separate out all the various aspects of the scene
to provide more control in post processing operations. For example, you may want to
adjust the intensity of light, shadows or a materials color. Having any of these on a
separate layer gives you this control.

Render Layer Output

This option is only available if you have assigned parts and models to a render layer.

Select   checkbox to enable layer ouput. Select the gear icon   toAll Render Layers
show the   dialog and select the   forRender Layer Settings Alpha (Transparency) Mode
the layers. Alpha types include:

Straight Alpha - Unmatted - This alpha type...

Premultiplied Alpha - Matted with Black - This alpha type...

Aliased - Opaque Fringe - This alpha type...

Render Pass Output

Select   checkbox or the checkbox next to the individual pass type toAll Render Passes
enable pass output. Doing so will render the selected pass(es), along with the original
image format specified on the output tab. Select the   or   option fromPSD PSD 32 BIT
the   drop-down menu to enable the   checkbox. This will compile allFormat Add to PSD
your passes into a single PSD file.

KeyShot supports 11 types of render pass output, including:

Diffuse Pass

Lighting Pass

Global Illumination Pass

On this page:
Render Layer Output
Render Pass Output

Note
Enabling the render layers option will render all render layers created. To
create a render layer go to the Project window, Scene tab. Go Properties,
Render Layer to create a render layer. Select a part or group of parts and
select the render layer you would like it to be on.

https://luxion.atlassian.net/wiki/spaces/K7M/pages/40422460/Layers+and+Passes


Caustics Pass

Reflection Pass

Refraction Pass

Shadow Pass

Ambient Occlusion Pass

Depth Pass
Depth pass creates a depth map, which is an image that contains information relating to
the distance of surfaces to the camera. Depth maps are used in other applications like
Adobe Photoshop & Adobe After effects to simulate effects like depth of field.

Geometric Normal Pass
Create a normal map image of your scene.

Clown Pass
Clown pass creates an image where individual parts are rendered with flat colors. This
is an easy way to create and save selections in Photoshop for post-rendering work. To
use a clown pass, import it to the actual image in Photoshop. This creates another
layer. Use the color range tool to select each of the colors in the clown pass and create
a mask for each group.

Normals Pass

Render Options
The Render Options window contains all settings for Render Mode, CPU Usage, and
Render Quality. These options are specific for the Still Image, Animation and
KeyShotXR output.

Mode

Default

The  render mode simply allows you to render immediately after adjusting yourDefault
render output settings or, if using KeyShot Pro, to send your render to the render
queue. 

Background

The  render mode option allows you to run the render in the backgroundBackground
and continue working. Note: the Real-time View will be paused by default when the
render is started. Select  and un-check  to un-pause theRender Pause Real-time Render
Real-time View and continue working.

Send to Network

If you use , the  render mode allows you toKeyShot Network Rendering Send to Network
send your render to the KeyShot Network Rendering Monitor. Make sure the Monitor is
installed and running to send a job to be rendered on the network. Visit the KeyShot

 for more information.Network Rendering Overview

CPU Usage

For  and  render modes, the  setting allows you toDefault Background CPU Usage
specify how many CPU cores you want to utilize for rendering your project. Selecting Us

 will use the  settings defined on the e Realtime CPU Settings CPU Usage KeyShot
.Ribbon

On this page:
Mode

Default
Background
Send to Network

CPU Usage
Quality

Maximum Samples
Maximum Time
Custom Control

https://luxion.atlassian.net/wiki/spaces/K7NR
https://luxion.atlassian.net/wiki/spaces/K7NR/pages/39873118/Overview
https://luxion.atlassian.net/wiki/spaces/K7NR/pages/39873118/Overview


Quality

KeyShot has three output options for quality based on your needs.

Maximum Samples

The  option controls how many times the image or animation frameMaximum Samples
will be calculated and refined. Each additional sample will further smooth out noise/grain
in the image. This option uses the same rendering technique as you see when working
in the Real-time View. (This technique is also used in  option, but differsMaximum Time
from the method used in  option.)Custom Control

Samples
This controls how many times each pixel in the rendered image is calculated for
increased accuracy. Too low of a value will result in an image that has excessive noise.
Increasing samples will reduce the noise, however, increasing this setting too high will
increase render times without a noticeable difference in quality.

Samples Per Frame
The  option will read  when the  tab isMaximum Samples Samples Per Frame Animation
selected under the  section. This option is ideal for animation output as Output it guarant

. Therefore, as the animationees that each frame will be rendered at the same quality
plays through the frames you will not see changes/flickering in shadows or noise
patterns on materials.

How many samples should I use?
Generally speaking, a simple scene will require fewer samples and a scene
with more complex lighting and materials will require more samples. Start low
and increase the samples if you still see noise or the render looks grainy.
Before rendering out an animation using Maximum Samples, test your
samples with a still image render first.

Samples and Resolution
A sample calculates the color of a pixel. There is a point of diminishing
returns where you increase samples past the point of added quality, and just
increase the render time.



This method is typically preferred over the time-based output for animations, as some
frames may require substantially more time to reach the same quality level as levels of
detail and complexity change through the course of your animation. Using the
time-based output will lead to more noise in the more complicated frames.

Maximum Time

The  option for render quality will progressively refine the render for theMaximum Time
amount of time set. This option uses the same rendering technique as what you see in
the Real-time View. This technique is also used in Maximum Samples option, but differs
from the method used in  option.Custom Control

When rendering an animation, you may set the maximum time for each frame to render,
or set a total duration for the entire animation.

Custom Control

The  option allows control over all quality settings available in KeyShot.Custom Control
This mode typically produces smoother results in areas of high noise or shadow.

Samples
This will control the amount of rays per pixel that will be sent into the environment to
gather information to determine that pixel’s final shade. It is best to control this setting
per material and set a value between 8 and 16 in the render settings. For information on
samples and setting samples per material, please see the section on roughness and
glossy samples.

Ray Bounces
Ray bounces are the number of times rays of light are calculated as they bounce
around a scene. For a detailed explanation and examples please see the section that
covers ray bounces in the Real-time settings.

Something important to be aware of is that as you increase the resolution
of your image or animation, each pixel covers relatively less area of the

. This means you can use a lower samples setting when rendering atimage
higher resolutions. Note that this does not apply to rendering with area lights,
caustics or interior mode as increasing samples while using those features
will still increase the quality.



Anti Aliasing
Anti aliasing is a method for smoothing out jagged edges that are created by pixels.
Since pixels are made up of squares, they can produce a jagged look where edges
meet. Anti aliasing smooths out these edges. In most cases, the default value of 1 is
sufficient.

Shadow Quality
Shadow quality will control the shadow quality for ground shadows. This can be tuned in
real-time to determine what value is necessary. Please see the section on shadow
quality found in the real-time settings.

Global Illumination Quality
This will control the quality of all indirect light. Increasing this value can dramatically
increase render time. It is rarely necessary to set a value above the default value of 1. If
Global Illumination is turned off, this parameter will be grayed out. For more information
and please see the section on detailed indirect illumination in real-time settings.

Pixel Blur
This will apply a slight blur to the image to reduce the overly sharp look that computer
generated images can have. Higher values will have more blur. This does not increase
render time.

DOF (Depth of Field)
This will control the quality of depth of field if it is enabled in the camera tab. Increasing
this value will have an effect on render time. For production quality a value between 3 –
5 is recommended. If Depth of Field is not activated, this parameter will be grayed out.
Please see the section on cameras for more information on depth of field.

Caustics
Increasing this value will improve the samples and quality of the caustics. If caustics are
not enabled, this parameter will be grayed out. Please see the section on caustics for
more information.

Sharp Shadows
This will allow sharp shadows to be cast across 3D geometry when the lighting scenario
would create a sharp shadow. It is more accurate to have this checked and it is enabled
by default. It is generally recommended to leave this on.

Sharper Texture Filtering
This will attempt to preserve detail in textures when viewed at grazing angles. For
example, imagine being eye level with a wood table and seeing the wood grain
compress together. Detail can get lost in the compressed areas. This setting reduces
the loss of detail. This feature can increase render time so enable only when using
textures with glancing angles.

Global Illumination Cache
Disabling GI Cache replaces the potential dirty shadows and black spots with noise.
Increasing GI quality will reduce the noise. Increasing the samples will also help in
reducing the noise.



Render Queue

The  section contains setting for the render queue used in batch processingQueue
your still image and animation renderings.

Add/Delete Job
Use these buttons to add and remove jobs from the queue list. When a job is added,
you are recording the exact state of your scene. This includes all render settings. Each
job can have unique settings.

Add Camera
Send saved Cameras to the Render Queue. This button is active if more than one
Camera exists. Click the  button to open the Camera Queue window andAdd Cameras
check the Cameras you want to add to the queue.

Add Model Sets
Send saved Model Sets to the Render Queue. This button is active if more than one
Model Set exists. Click the  button to open the Model Sets QueueAdd Model Sets
window and check the Model Sets you want to add to the queue.

Add Studios
Send saved Studios to the Render Queue. This button is active if more than one Studio
exists. Click the  button to open the Studios Queue window and check theAdd Studios
Studios you want to add to the queue.

Move Up/Down
You can select a job in the list and click  or  to change the order ofMove Up Move Down
the job in the list. Jobs at the top render first. You can use the check box next to the job
to turn off that job. The job will then be skipped during processing of the queue. 

Send to Network
If you have KeyShot Network Rendering installed, the option to  willSend to Network
become available. Highlight one or more jobs in the Queue and click the Send to

button.Network 

Process Queue
When you are ready to start the queue, click the   button.Process Queue



Image Editor
The Image Editor is a post-process utility that allows you to make tweaks to your render
while it is rendering. Click the pencil icon to open the image editor in the render output
window.

Close Render
Click this to close the render output window. CAUTION: all unsaved adjustments made
in the image editor will be lost. Be sure to save your render after making adjustments
before closing the render output window.

Save
Saves the current state of the render. Be sure to save after completing adjustments in
the image editor in order to keep changes.

Gamma
Gamma compensates the way colors are displayed for optimal color range for human
vision. Lower values will increase contrast and higher values will decrease contrast.

Brightness
Control the brightness on the rendered image.

Saturation
Increase or decrease the color intensity in the render.

Hue
Shift the colors in the render. This can be a quick way to create multiple color studies
from a single render.

Bloom Intensity
Bloom will add glow around emissive materials and add an overall softening to the
image. Increase the slider to create a brighter glow.

Bloom Radius
Affects how far a bloom extends from the edges.

Vignetting Strength
Darken the corners and edges of your frame.

Vignetting Color
Choose the color of your vignette with the color picker window.

 

 



Scripting
Scripting allows you to unleash the power of KeyShot for automation, batch processing
and more. Scripting functionality includes control for camera, lighting presets, materials
and material templates, environment, background and backplates, rendering (images,
animations, and VR) and opening, saving and importing files.

KeyShot scripting uses Python 3.4. To access the  console go to Scripting Window,
You can use KeyShot's predefined scripts or create your own customScripting Console. 

scripts inside the  tab. You can also input one-line commands inside the pythonScripts
interpreter, located at the bottom of the  tab. Console For additional documentation that
includes a  , click .quick start guide here

In this section:

Script Location
Creating A Script
Script Examples

Script Location
Scripts are located in the KeyShot Resource folder, e.g. \KeyShot 7\Scripts. To change
this location or add another location, select  and change theEdit, Preferences, Folders
path for the  folder. Scripts in the folder will be visible in the  tab of the Scripts Scripts Scri

 window.pting

http://keyshot.com/scripting/doc/7.0/quickstart.html
http://keyshot.com/scripting/doc/7.0/
https://luxion.atlassian.net/wiki/spaces/K7M/pages/69274433/Script+Location
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37958043/Creating+A+Script
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37958020/Script+Examples


Creating A Script
To create a script, select  from the  tab. Provide a name for the script andCreate Scripts
the author.

If Python 3.4 is installed locally on the machine, then KeyShot will detect Python and all
of the installed modules, such as , , , etc., that can then be freely usedNumPy SciPy PIL
for scripting in KeyShot (this can be disabled in the advanced preferences section). You
may also import a script or edit an existing script using the corresponding buttons on the

 tab.Scripts

Vector and matrix classes are made available in the  module to help withluxmath
doing calculations. They are named  and  respectiluxmath.Vector luxmath.Matrix
vely.

 

 

 

 

Script Examples
In this page you will find KeyShot's predefined scripts and instructions on how to use
them.  These scripts are listed under the Scripts tab inside the Scripting window.

On this page:

Create Standard Views
Encode Video
Render Ambient Occlusion
Render Animation Passes
Render Images
Render Panoramic Frames



Create Standard Views

Creates seven standard view cameras: front, back, top, bottom, left, right, and
isometric.

How to use:

Select script and press Run. You will receive confirmation message: Successfu
l!
Click OK.
You will find the seven standard views under .Project > Camera

Encode Video

Encodes video using an image sequence over a specific range of frames.

How to use:

Select script and press Run.  The user prompt appears.
Click the browse button and select a folder with the image frames.
For frame format, copy the name of the file, replacing the frame number with
%d, e.g. my_new_animation.%d.jpg.
Enter the start frame – the number in the name of the first image, e.g. 1 on
my_new_animation.0001.jpg.
Enter the end frame – the number in the name of the last image, e.g. 60 on
my_new_animation.0060.jpg.
Enter FPS for the video.
Enter the video name.
Click OK to begin the process.

Render Ambient Occlusion

Renders an ambient occlusion pass of your scene.

How to use:

Select script and press Run.  The user prompt appears.
Click the browse button and if you wish to change your output folder.
Set the output image name.
Set the output width and height.
Set the render time. The default value is 20 seconds.  Increase the render time
better quality.
Add to queue should be enabled if you wish to add your job to the local render
queue. Otherwise your job will be rendered according to your render mode
options: default, background, or network.
Decide if you wish to process your local queue after adding the job.  If you
disabled the "Add to queue" checbox, then this box should also be disabled.
Click OK to begin the process.

Render Animation Passes

Renders your animation frames with the option to output "ambient occlusion"
and/or "toon outline shading" passes. Please note that in order to run this script, you
must first apply animations to your scene.*

How to use:

Select script and press Run.  The user prompt appears.
Click the browse button and if you wish to change your output folder.
Set the output file format. KeyShot uses %d to keep track of the frame number
and you should leave this symbol in the name (e.g.
my_new_animation.%d.jpg).
Set the output width and height.
Enter the start frame – the number in the name of the first image, e.g. 1 on
my_new_animation.0001.jpg.
Enter the end frame – the number in the name of the last image, e.g. 60 on
my_new_animation.0060.jpg.
Select the passes that you wish to render.
Add to queue should be enabled if you wish to add your job to the local render



queue. Otherwise your job will be rendered according to your render mode
options: default, background, or network.
Decide if you wish to process your local queue after adding the job.  If you
disabled the "Add to queue" checbox, then this box should also be disabled.
Click OK to begin the process.

Render Images

Imports all CAD files within a folder and renders them one at a time. This script can be
used to render an animation from an obj file sequence. Once your images are rendered,
you may stitch them up and compile the video with the Encode Video script above.

How to use:

Select script and press Run. The user prompt appears.
Click the browse button and select the folder with the geometry (.obj)
sequence.
For input, type the extension of the geometry without the dot (obj).
For output, type the extension of the image format without the dot (png).
Input the width and height of the output images in pixels.
If you created a material template for automatic material assignment, then
select your template.  Otherwise, use "None".
Click OK to begin the process.

Render Panoramic Frames

Renders a series of frames that can be used to create a panoramic view of the product
(that is, 360 degrees along the vertical axis Y). Once your images are rendered, you
may stitch them up and compile the video with the Encode Video script above.

How to use:

Select script and press Run.  The user prompt appears.
Select which camera you'd like to use.  The center of the camera will be the
pivot of rotation.
Set the number of frames to render. The default number of frames is 50. Since
the camera rotates a full 360 degrees, this comes out to about 7 degrees per
frame (360 / 50).
Set the output file format. KeyShot uses %d to keep track of the frame number
and you should leave this symbol in the name (e.g.
my_new_animation.%d.jpg).
Click the browse button and if you wish to change your output folder.
Set the output width and height.
Add to queue should be enabled if you wish to add your job to the local render
queue. Otherwise your job will be rendered according to your render mode
options: default, background, or network.
Decide if you wish to process your local queue after adding the job.  If you
disabled the "Add to queue" checbox, then this box should also be disabled.
Choose the direction of rotation: clockwise (checkbox ON) or counterclockwise
(checkbox OFF).
Click OK to begin the process.

*Animation is only available in KeyShot Pro edition.

Animation
KeyShot Animation allows you to animate your models and cameras in no time.

To translate a part across the scene, simply right-click the part in the scene tree, select 
, and tweak the animation settings. Similarly, to animate aAnimation > Translation

camera: right-click a camera in the scene tree, select your animation type, and make
the desired changes. You may also launch the Animation Wizard (Animation >

) and follow the prompts.Animation Wizard

Animations in KeyShot are represented by rectangular nodes in the animation timeline.
Each node has a start time (left side), an end time (right side) and a duration (the
rectagle's length). You may move them around, scale them, stack them, or line them up
in sequence to achieve different effects.

In this section:
Animation Types
Animation Wizard
Working with Animations
Deformation Animations
Animation Effects
Animation Properties

https://luxion.atlassian.net/wiki/spaces/K7M/pages/37958449/Animation+Types
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37958492/Animation+Wizard
https://luxion.atlassian.net/wiki/spaces/K7M/pages/37953131/Working+with+Animations
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40126374/Deformation+Animations
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40184253/Animation+Effects
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40249923/Animation+Properties


 

Animation Types
There are three types of animations in KeyShot:

Part Animations
Material Animations
Camera Animations

On this page:

 

 

 

Part Animations

Part animations affect your model's position, orientation, and visibility in the scene. They allow you to translate, rotate, and fade all while
maintaining your model's hierarchy. Thus, animations applied to your model's top assembly will also affect all parts under that assembly.

Translation
Rotation
Fade

Translation

A Translation is an animation in which a model or any one of its parts moves along the XYZ axis and changes position.



How to add a Translation:

1. Right-click your model/part in the scene tree and select  You may also apply your translation animation via theAnimation > Translation.    nimatiA
.on Wizard

2. The Translation node will appear in the animation timeline.

3. Use the  window to control your model's movement. For more information about these properties, click .Translation Properties here



4. Click   in the animation timeline to play a preview in realtime. You may also click and drag the time scrubber in the timeline.Play

Rotation

A Rotation is an animation in which a model or any one of its parts rotates around its own axis or some other part's axis.



 Tip: When dealing with complex animations consisting of multiple pivot points, we recommend a top-down hierarchy structure in your scene tree.
Click   for a full article on how to animate hinges and multiple pivot points.here

How to add a Rotation:

1. Right-click your model/part in the scene tree and select  You may also apply your Rotation animation via theAnimation > Rotation.    nimationA
.Wizard

2. The Rotation node will appear in the animation timeline.

3. Use the   window to control your model's movement. For more information about these properties, click  .Rotation Properties here

https://blog.keyshot.com/animating-hinges-with-multiple-pivot-points-keyshot


4. Click   in the animation timeline to play a preview in realtime. You may also click and drag the time scrubber in the timeline.Play

Fade

The Fade animation provides a smooth transition between two opacity values.



How to add a Fade:

1. Right-click your model/part in the scene tree and select  You may also apply your Fade animation via the .Animation > Fade.    nimation WizardA

2. The Fade node will appear in the animation timeline.

3. Use the   window to control your model's opacity level. For more information about these properties, click  .Fade Properties here



4. Click   in the animation timeline to play a preview in realtime. You may also click and drag the time scrubber in the timeline.Play

Material Animations

Material animations can only be applied to materials in your in-project library (in your scene). If you apply a material animation onto a material, the
animation will not be listed in the scene tree under any group or part. Rather, the material animation "lives" inside the . If two partsMaterial Graph
share the same material, then both parts will be affected by the material animation. Material animations include:

Color Fade
Number Fade

Color Fade (Animation)

The  animation provides a smooth transitions between two or more color values.  You can apply a  to your material'sColor Fade Color Fade
diffuse, specular, and opacity map.  You may also apply a  to any material value like roughness, refraction index, power, contour width,Color Fade
etc.

How To Apply A Color Fade Animation:

1. Select a part in your scene that has the desired material.

2. Right-click and select  from the right-click context menu.Material > Edit Material Graph

3. Inside the  go to Material Graph Nodes > Animation > Color Fade.

4. Click and drag from the output channel on the Color Fade node to the desired input channel on your material node. This will connect the Color
Fade node to your material node.

5. The   animation node will appear in the animation timeline.Color Fade

6. Use the Color Fade Properties window to set your color transitions. For more information about these properties, click .here

7. Click   in the animation timeline to play the preview in realtime. You may also click and drag the time scrubber in the timeline.Play

Number Fade (Animation)

The   animation provides a smooth transitions between two numerical values.  You can apply a   to your material'sNumber Fade Number Fade
diffuse, specular, and opacity map.  You may also apply a   to any material value like roughness, refraction index, power, contourNumber Fade
width, etc. 

How To Apply A Number Fade Animation:

1. Select a part in your scene that has the desired material.

2. Right-click and select   from the right-click context menu.Material > Edit Material Graph

3. Inside the   go to Material Graph Nodes > Animation > Number Fade.

4. Click and drag from the output channel on the Number Fade node to the desired input channel on your material node. This will connect the
Number Fade node to your material node.

5. The   animation node will appear in the animation timeline.Color Fade

6. Use the Color Fade Properties window to set your color transitions. For more information about these properties,  click  .here



7. Click   in the animation timeline to play the preview in realtime. You may also click and drag the time scrubber in the timeline.Play

Camera Animations

Camera animations include:

Orbit
Panorama
Inclination
Dolly
Translation
Path
Depth of Field
Zoom
Switch

Orbit

A camera Orbit rotates the camera around its target. The instructions below assume that you've already created a camera in your scene and set
its target.

How to add a camera Orbit:

1. Right-click your camera in the scene tree ( ) and select  You may also apply your Orbit animation via the Project > Scene Orbit. Animation
Wizard.

2. The Orbit animation will appear inside the animation timeline.



3. Use the   window to control your orbit span in degrees.Orbit Properties

4. Click  in the animation timeline to play the preview in realtime. You may also click and drag the time scrubber in the timeline.Play



Panorama

The camera Panorama rotates the camera around its own axis to simulate a full panoramic view. You may use this type of animation for showing
a car interior or an architectural interior. The instructions below assume that you've already created a camera in your scene and set its target.

How to add a camera Panorama:

1. Right-click your camera in the scene tree ( ) and select   You may also apply your Panorama animation via the Project > Scene Panorama. Anima
tion Wizard.

2. The Panorama animation will appear inside the animation timeline.

3. Use the   window to control your Panorama span in degrees.Panorama Properties



4. Click   in the animation timeline to play the preview in realtime. You may also click and drag the time scrubber in the timeline.Play

Inclination

The camera Inclination rotates the camera up and down around its target. The instructions below assume that you've already created a camera in
your scene and set its target.



How to add a camera Inclination:

1. Right-click your camera in the scene tree ( ) and select   You may also apply your Inclination animation via the Project > Scene Inclination. Animat
ion Wizard.

2. The Inclination animation will appear inside the animation timeline.

3. Use the   window to control your Inclination span in degrees.Inclination Properties



4. Click   in the animation timeline to play the preview in realtime. You may also click and drag the time scrubber in the timeline.Play

Dolly

While the  animation changes the focal length of the camera to achieve it’s effect, the Dolly animation physically moves the camera closer toZoom
the subject. Use this camera animation when you want to dynamically change your camera location. The instructions below assume that you've
already created a camera in your scene and set its target.



How to add a camera Dolly:

1. Right-click your camera in the scene tree ( ) and select   You may also apply your Dolly animation via the Project > Scene Dolly. Animation
Wizard.

2. The Dolly animation will appear inside the animation timeline.

3. Use the   window to control your Dolly distance. The Distance slider is calibrated to your .Dolly Properties scene units



4. Click   in the animation timeline to play the preview in realtime. You may also click and drag the time scrubber in the timeline.Play

Translation (Camera)

Camera Translation allows the camera to move on the X, Y and Z axes. The instructions below assume that you've already created a camera in
your scene and set its target.



How to add a camera Translation:

1. Right-click your camera in the scene tree ( ) and select   You may also apply your Translation animation via the Project > Scene Translation. Anim
ation Wizard.

2. The Translation animation will appear inside the animation timeline.

3. Use the   window to control your Translation. The Translation sliders are calibrated to your  .Translation Properties scene units



4. Click   in the animation timeline to play the preview in realtime. You may also click and drag the time scrubber in the timeline.Play

Path

Camera path animation creates a path through which the camera can travel. This is useful for walkthroughs, or for more dynamic camera
movements. The instructions below assume that you've already created a camera in your scene and set its target.



How to add a camera Path:

1. Right-click your camera in the scene tree ( ) and select   You may also apply your Path animation via the Project > Scene Path. Animation Wizard.

2. The Path animation will appear inside the animation timeline.

3. Adjust your camera in realtime or select a different camera view from  and then add your control points. You can think ofProject > Camera
control points as the dots that connect your camera path from start (point 1) to end (n-th point).



When all control points have been added, you may click OK.

4. Use the   window to control the camera path.Path Properties



5. Click   in the animation timeline to play the preview in realtime. You may also click and drag the time scrubber in the timeline.Play

6. To view and edit the camera path, open the   icon from the   or select  . The camerasGeometry View Ribbon Window > Show Geometry View
(Control Points) and camera path will be visible. Left-click to select a camera. Right-click to show options to move, add or delete a control point.

https://www.keyshot.com/manual/keyshot6/?section=geometry-view
https://www.keyshot.com/manual/keyshot6/?section=ribbon


7. To move a Control Point, select a control point, and click the Move Tool button.



The move tool will appear.  Position and confirm.



Depth Of Field (Animation)

The camera Depth Of Field animation animates your camera's focus point. The instructions below assume that you've already created a camera
in your scene, that you've set its target, and enabled Depth of Field under the camera's settings.

Start



End

How to add a camera Depth of Field:

1. Right-click your camera in the scene tree ( ) and select   You may also apply your Depth of Field animation viaProject > Scene Depth of Field.
the Animation Wizard.

2. The Depth of Field animation will appear inside the animation timeline.



3. Use the   window to control your Depth of Field start and end settings.Depth of Field Properties

4. Click   in the animation timeline to play the preview in realtime. You may also click and drag the time scrubber in the timeline.Play



Zoom

The camera Zoom changes the camera's focal length. The instructions below assume that you've already created a camera in your scene and set
its target.



 

How to add a camera Zoom:

1. Right-click your camera in the scene tree ( ) and select   You may also apply your Zoom animation via the Project > Scene Zoom. Animation
Wizard.

2. The Zoom animation will appear inside the animation timeline.

3. Use the   window to control your Zoom distance. The Distance slider is calibrated to your  .Zoom Properties scene units



4. Click   in the animation timeline to play the preview in realtime. You may also click and drag the time scrubber in the timeline.Play

Switch

The camera Switch animation is an instant change between the current camera view and another camera in the scene. The instructions below
assume that you've already created a camera in your scene and set its target.



Tip: Camera Switch Event animation can be used to chain multiple camera path animations, created through existing cameras.

How to add a camera Switch:

1. Right-click your camera in the scene tree ( ) and select   You may also apply your Switch animation via the Project > Scene Switch. Animation
Wizard.

2. The Switch animation will appear inside the animation timeline. Click and drag or the Switch node to position it at the desired location in the
timeline.

3. Use the   window to change the To Camera.Switch Properties



4. Click   in the animation timeline to play the preview in realtime. You may also click and drag the time scrubber in the timeline.Play

Animation Wizard
The Animation Wizard is the easiest way to create animations step-by-step. You start
out by choosing an animation type and the wizard walks you through very step in the
animation setup. The instructions below assume that your KeyShot version includes
animation. For more information about each animation type, click .*here
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How to launch the Animation Wizard:

1. Click the Animation button in the Toolbar.

2. Click the Animation Wizard button in the animation timeline.



3. Choose your animation and click Next.

4. Follow the steps in the wizard and play your animation preview in realtime.



*Currently, the Animation Wizard does not include .material animations

 

Working with Animations

Animations are represented in the timeline and labeled according to the name set in the
animation properties for translations, rotations and camera animations. When an
animation node is clicked in the timeline, the properties will be displayed. Animations
can be shifted in time and scaled interactively to control timing and duration. Groups of
animations can be consolidated in a single folder for organization. These folders can
also be scaled and shifted to control timing and duration.

Managing Animations

Animation management utilities can be found by right-clicking on animations in the
animation list. To change the animation order or to move an animation into an existing
folder, click and drag the animation. To multi-select animations, hold  (PC) orCTRL
Command (Mac) while selecting multiple nodes.

Delete
Select this option to delete one or more animations from the timeline.

Add Folder
Right-click on a blank area in the animation list to display this option.

Duplicate
To duplicate an animation or animations, right-click on the animation(s) you would like
to copy and select .Duplicate

Mirror
Right-click on the animation(s) you would like to have a reverse duplicate animation of.
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Managing Animations
Animation Properties



This is useful for exploded view animations and for situations where you need to have
the animation end where it began, such as for a looping video.

Animation Properties

Selecting an animation will display its properties on the right side of the  windAnimation
ow. These settings are the same used when creating an animation via the Animation

. You may change all existing animation settings as well as the name of theWizard
animation in the animation properties.

If the  window is docked, or if you are using the window with a short window,Animation
you can compress sections of the properties to see the parameters that are most useful
to you at that time.

 

Deformation Animations
A model deformation is any change in the model's shape: twists, expansions,
contractions, and character rigging. These types of animations required advanced
techniques available in CAD packages such as Maya and 3DS Max. While KeyShot
does not offer a "deformation" animation, it does still support deformations set up in
CAD and exported to an Alembic (.ABC) file.

How to import your deformation animations from an Alembic file:

 Click the Import button (or File > Import) in KeyShot.1.

 Browse to your Alembic (.ABC) file and click Open.2.

 From the   dialogue > 3. KeyShot Import Animation enable  confiDeformable Meshes and 
rm your  . Import

4. Click   in the animation timeline to play a preview in realtime. You may also clickPlay
and drag the time scrubber in the timeline.

The file will import and appear as an animation node on the  where it Animation Timeline



may be positioned and re-sized.

Animation Effects

Animation Effects add realism to your animations. These effects include:

Motion Blur
Motion Ease

Motion Blur

KeyShot “Motion Blur” provides a real-time preview of motion applied to the scene where movement is blurred. Capture the motion of objects or
cameras as they rotate or move across the screen before you even play an animation or render an image.

To apply “Motion Blur” to objects in motion, check “Motion Blur” button on the Animation window tool bar. Click the arrow to toggle the motion blur
to Model/Part or Camera animation. If you already have objects or cameras with animations applied to them, the real time view will update to
show the objects in motion.

“Motion Blur” can be seen quickly after turning the option on by adding a “Translation” animation to an object or an “Orbit” animation to a camera.
The amount of motion blur is controlled through the “Animation” settings by adjusting how fast and how far an object or camera is moving. When
“Motion Blur” is enabled, the real time preview of the motion is dependent on the FPS setting.

Motion Ease



Motion easing will create a more natural look when applied to rotations, translations and camera animations. This will add acceleration and
deceleration to motion. For example, if a car goes from one stop sign to another and reaches a maximum speed of the 35 miles per hour, it is not
traveling that speed for the entire time. The car has to start moving, accelerate to its top speed and then slow down as it approaches the next stop
sign. Without motion easing, the car would start and stop abruptly and travel 35 miles per hour the entire time it is in motion.

Linear



Ease In



Ease Out



Ease in/Ease Out

Animation Properties

This section goes over the different animation controls inside the Animation Properties window. Each animation has its own controls:

Translation Properties
Rotation Properties
Fade Properties

Translation Properties
Use the translation properties to control direction of movement.

Translation

The translation sliders include:  ,  , and Translate X Translate Y Translat
. e Z

Translate X
Controls movement along the X axis.

Translate Y

Controls movement along the Y axis.

Translate Z
Controls movement along the Z axis.

Axis Orientation
When you apply a rotation to your model, you must choose the



rotation axis: X, Y, or Z axis. However, these axes have two states: O
 and riginal Local Global.

Original Local
The Original Local state uses the rotating part's local axis. If Y pointed up originally, rotating the part over 45 degrees means that the Y axis is
now also tilted 45 degrees. Use this axis state your model's axis orientation is not square (slightly tilted) with KeyShot's global axis. To reveal the
global axis, press the "Z" key on your keyboard.

Global
This is KeyShot's global axis.  To reveal the global axis, press the "Z" key on your keyboard. Y axis always points up. Even if you have rotated a
part using your modeling software.

Rotation Properties
Use the rotation properties to control your rotation.

Rotation

The rotation settings include  ,  , and  .Degrees Axis Axis Orientation

Degrees
Controls the angle of rotation in degrees.

Axis
Determines the reference axis of rotation. There are three
mutually-exclusive options: X, Y, or Z.

Axis Orientation
When you apply a rotation to your model, you must choose the
rotation axis: X, Y, or Z axis. However, these axes have two states: O

 and riginal Local Global.

Original Local
The Original Local state uses the rotating part's local axis. If Y
pointed up originally, rotating the part over 45 degrees means that the
Y axis is now also tilted 45 degrees. Use this axis state your model's
axis orientation is not square (slightly tilted) with KeyShot's global
axis. To reveal the global axis, press the "Z" key on your keyboard.

Global
This is KeyShot's global axis.  To reveal the global axis, press the "Z"
key on your keyboard. Y axis always points up. Even if you have
rotated a part using your modeling software.

Pivot Point

A pivot point is the point around which a part/model will rotate. When you apply a rotation animation, the pivot point is set to "Self" by default.  To
select a different pivot point from the scene tree or in your scene, click the   button.Pick

Center and Origin
By default, the pivot point is always at the center of the model. Change this to   if your wish to use the model's origin instead. For example, itOrigin
is possible that a cube's origin lies at one of its eight vertices.

 Tip: You may use a helper object for even more control over your pivot point (find useful primitives under  ). Then, positionEdit > Add Geometry
the primitive and click the   button to select it from your scene tree or your scene.Pick



Dynamic Pivot Points
This setting will allow the rotating part or model to follow a moving helper object. Dynamic pivot points should also be enabled when there are two
or more rotations (each with different helper objects) applied to the same part or model.

Note that not all moving helper objects are dynamic pivot points. For example, let's say that you wish to animate a part orbiting around a helper
object while the second is moving. In this case, enabling dynamic pivot point will not provide you with the desired result. Instead, make sure that
the orbiting object is a child under the helper object in your scene tree hierarchy.

When dealing with complex animations consisting of multiple pivot points, we recommend a top-down hierarchy structure in your scene tree
instead of relying on "Dynamic Pivot Points". Click   for a full article on how to animate hinges and multiple pivot points.here

Fade Properties

Fade Properties

Use the fade properties to control the opacity level.

Fade

The fade sliders include:   and  .Fade From Fade To

Fade From
This is your model's starting opacity level. Accepted values are
between 0% and 100%, where 0% means that the model is invisible
and 100% means that the model is 1 entirely visible.

Fade To
This is your model's opacity level by the end of the
animation. Accepted values are between 0% and 100%, where 0%
means that the model is invisible and 100% means that the model is
1 entirely visible.

KeyShotXR
Note: KeyShotVR has been renamed to KeyShotXR to avoid confusion with the VR capabilities in KeyShot and better capture the extended,
interactive features in KeyShotXR. 

KeyShotXR gives you the ability to turn your 3D renderings into interactive visuals. With KeyShotXR, you can create and present high-quality,
touch-enabled, 3D content in any web browser. The content can be viewed using touch-enabled devices (or mouse) and does not require a
browser plugin to work.

How is KeyShotXR different from other 360° viewers?

KeyShotXR goes beyond the standard 360  turntable viewing capability of other viewers. With KeyShotXR you can:°

Create turntable, spherical, hemispherical, tumble and animated interactive visuals.
Use the camera as a pivot point to create a first person point-of-view or panoramic shot
Ensure your visuals provide high-quality, scientifically accurate material and lighting representation
Have full control over your visual with advanced features and customization
Export direct to Apple iBooks for use on both iPad Retina and iPad Mini

Learn more and see examples  . here

https://blog.keyshot.com/animating-hinges-with-multiple-pivot-points-keyshot
https://www.keyshot.com/vr/


 

KeyShotXR Wizard
 

You can set up a KeyShotXR through the KeyShotXR Wizard. The KeyShotXR Wizard
is accessed by pressing the KeyShotXR button on the KeyShot Toolbar, or through the
main menu by selecting , or by hitting the . Window, KeyShotXR... V-key

Note: These and other KeyShotXR options are located in the KeyShotXR tab of the
Render options window ( , ).Ctrl-P Cmd-P

Pick KeyShotXR Mode

There are six KeyShotXR modes to choose from. When you select one of the six
modes, you will see a preview of the KeyShotXR view rotation. After choosing a mode,
click  .Next

Turntable

Creates a standard turntable view to rotate a model up to 360 degrees.

Spherical

Creates a fully-spherical view to see all sides of the model.

Hemispherical

Create a half spherical view to rotate around only a portion of the model.
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Pick KeyShotXR Mode
Turntable
Spherical
Hemispherical
Tumble
Custom
Animation

Pick KeyShotXR Rotation
Center

Environment
Object
Camera
Look At
Custom
Horizontal
Environment
Rotation

Pick Initial KeyShotXR View
Set KeyShotXR Smoothness

Smoothness Control
Angle Control

Set KeyShotXR Output



Tumble

Create a view that rotates around the model center.

Custom

Enter values for each KeyShotXR option to create a custom view. 

Animation

If an animation is present, create a view using an animation. See KeyShotXR Animation
.

 

Pick KeyShotXR Rotation Center

Next, you will be able to select the center of rotation for your KeyShotXR. After selecting
a center of rotation, click .Next

Environment

This option will set the center of rotation at the center of the scene.

Object

Select an object in the scene as a center of rotation.

Camera

Use the current camera settings to use as your rotation center.

Look At

Use your current “Look At” as your rotation center.

Custom

This option allows you to select the center of rotation from your scene tree items.

Horizontal Environment Rotation

Enable this option to have the environment rotate with the KeyShotXR.

Pick Initial KeyShotXR View

Next, you can fine tune the initial camera view of your KeyShotXR. Set the distance,
azimuth, inclination, and perspective as you would on the camera tab. Use the grid
option to help you center your model for optimal rotation. Once finished choosing your
initial camera angle, click .Next

Set KeyShotXR Smoothness

In this step, you will be able to control the smoothness of your KeyShotXR.  Once the
number of frames has been set, click .Next



Smoothness Control

Allows you to control the smoothness of the model rotation. A higher value of horizontal
and/or vertical frames will increase the smoothness of the rotation on the model inside a
web browser, but it will also increase the total number of frames to be rendered and
may affect load times of the KeyShotXR in the browser.

Angle Control

If a  KeyShotXR is chosen, you will also see options for Angle Control. AngleCustom
Control allows you to enter beginning and end angles for both the horizontal and vertical
rotation.

Set KeyShotXR Output

In the final step, you configure the output of the KeyShotXR as well as the image
resolution for each frame. 

Choose the name of your KeyShotXR and the location of where it will be saved on your
computer.

Set the resolution of your KeyShotXR or choose a preset from the pull down.

KeyShotXR has a default image for the loading icon. To change the icon, click “Browse”
and select an image file to replace the default image.

Select  to change any of the settings in the previous steps. Select  toBack Render Now
start rendering the KeyShotXR or select  to open the Render dialogRender Options
KeyShotXR Output options.

 

 

 

KeyShotXR Animation
If an animation is applied in the scene, the  option will be shown as anAnimation
available KeyShotXR mode. Any animation type can be included as a
KeyShotXR. Select   in the .Animation KeyShotXR Wizard

Frames

Use the slider or input field to set the number of frames to render in the KeyShotXR. If
you have a specific section of the timeline you would like to use, select .Work Area

Resulting FPS

This determines the overall smoothness of the KeyShotXR when it is used in a browser.
Increasing the  slider increases the frame rate. A higher value will give aFrames
smoother transition, but be aware that internet speeds can also affect frame rate.

Loop Animation

This option will provide an infinite looping for the KeyShotXR Animation. Additional
options can be accessed by selecting  on the final step of theRender Options
KeyShotXR Wizard.
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Resulting FPS
Loop Animation

 

Interior KeyShotXR
The Interior KeyShotXR is essentially a “look-around” KeyShotXR that uses the camera
itself as the rotation center. With this feature, in addition to the option to control
Horizontal Environment Rotation, dynamic interior and look-around KeyShotXRs can be
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created to help visualize what a space feels like in first person.

How it Works
From the KeyShotXR Wizard or the KeyShotXR Render dialog, you are presented with
an option to Pick KeyShotXR Rotation Center. Use Camera as the rotation center to
enable the Interior KeyShotXR. Depending on the desired outcome, you can also
enable Horizontal Environment Rotation from the same dialog page. If the background
is set to Lighting Environment, the Horizontal Environment Rotation should be
enabled for the most realistic effect.

 

KeyShotXR Files
Once the KeyShotXR has finished rendering, a web browser window with the finished
KeyShotXR will be displayed. Additional settings can be set in the HTML code that was
produced with the KeyShotXR. You can find the HTML code along with all the render
frames in a folder at your save location.

...

 

KeyShotXR Variables
Below is a list of KeyShotXR variables. these variables are set in the  file created.html
by KeyShot when the KeyShotXR is rendered. These variables can be edited after the
KeyShotXR is created if minor edits are needed, rather than recreating the
KeyShotXR over again. The  file can be edited use a standard text editor..html

Variable Location

All KeyShot variables are located in the KeyShotXR   file  section, within a .html <head> <
 tag, and are called by the  function.script> initKeyShotXR()

<head>
<script type="text/javascript">
function initKeyShotVR() {
var nameOfDiv = "KeyShotVR";
}
</script>
</head>

Variables

nameOfDiv

The div id of the KeyShotXR. This is where the KeyShotXR content is located.

Usage Example:

var nameOfDiv = "KeyShotXR";

<body oncontextmenu="return false;">
<div id="KeyShotXR"></div>
</body>

folderName

The name of the folder that contains all the files for the KeyShotXR. This is set under R
  options in the  tab,  entry.ender, Output KeyShotXR Name

Usage Example:

var folderName = "material_ball_VR.10";

viewPortWidth

The width of the KeyShotXR in pixels. This is set under     options in the Render, Output K
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Variable Location
Variables

nameOfDiv
folderName
viewPortWidth
viewPortHeight
backgroundColor
uCount
vCount
uWrap
vWrap
uMouseSensitivity
vMouseSensitivity
uStartIndex
vStartIndex
minZoom
maxZoom
rotationDamping
downScaleToBrows
er
addDownScaleGUI
Button - Deprecated
downloadOnInteract
ion
imageExtension
showLoading
loadingIcon
allowFullscreen
uReverse
vReverse



 tab,   first text field entry.eyShotXR Viewing Resolution,

Usage Example:

var viewPortWidth = 640;

viewPortHeight

The height of the KeyShotXR in pixels. This is set under     options in the Render, Output
 tab,   second text field entry.KeyShotXR Viewing Resolution,

Usage :Example

var viewPortHeight = 640;

backgroundColor

The background color of the .html page in hexidecimal notation. This will be the color
behind/surrounding the KeyShotXR. The default is white (#FFFFFF). This option can
only be set from in the  file..html

Usage  :Example

var backgroundColor = "#FFFFFF";

uCount

This is the number of horizontal frames in the KeyShotXR. This is set under   Render, Ou
 options in the   tab, under .tput KeyShotXR KeyShotXR Control, Smoothness Control

Usage  :Example

var uCount = 18;

vCount

This is the number of vertical frames in the KeyShotXR. This is set under   Render, Outp
 options in the   tab, under  .ut KeyShotXR KeyShotXR Control, Smoothness Control

Usage Example:

var vCount = 18;

uWrap

This allows the KeyShotXR to continue rotation in the horizontal direction when set to
true.

Usage Example:

uWrap = true;

vWrap

This allows the KeyShotXR to continue rotation in the vertical direction when set to true.

Usage Example:

var vWrap = true;

uMouseSensitivity

This controls the horizontal mouse/touch sensitivity for the KeyShotXR. Changing the
value to/from a negative value will change the direction of the KeyShotXR rotation. This
is set under     options in the   tab, under  .Render, Output KeyShotXR Advanced

Usage Example:



var uMouseSensitivity = -0.0055;

vMouseSensitivity

This controls the vertical mouse/touch sensitivity for the KeyShotXR. Changing the
value to/from a negative value will change the direction of the KeyShotXR rotation. This
is set under     options in the   tab, under  .Render, Output KeyShotXR Advanced

Usage Example:

var vMouseSensitivity = 1;

uStartIndex

This controls the horizontal start frame for the KeyShotXR. This is set by viewing angle
in the KeyShotXR settings, under     options in the   tab, under Render, Output KeyShotXR

.KeyShotXR Control, Angle Control

Usage Example:

var uStartIndex = 1;

vStartIndex

This controls the vertical start frame for the KeyShotXR. This is set by viewing angle in
the KeyShotXR settings, under     options in the   tab, under Render, Output KeyShotXR Ke

.yShotXR Control, Angle Control

Usage Example:

var vStartIndex = 0;

minZoom

This controls the minimum zoom level for the KeyShotXR. Setting to a negative value
will allow Zoom out capability. Increasing the value above 1 will change the zoom level
of the KeyShotXR when loaded. This is set in the KeyShotXR settings, under   Render, O

 options in the   tab, under  by checking the  checkboutput KeyShotXR Advanced  Zoom-In
x.

Note: KeyShot automatically calculates the resolution when rendering the
KeyShotXR based on this setting . If when 'Preserve image quality' option is enabled
changed afterward, grainy images may be experienced.

Usage Example:

var minZoom = 1;

maxZoom

This controls the maximum zoom level for the KeyShotVR. Increasing this number,
increases the amount a KeyShotVR can be zoomed in. This is set in the KeyShotVR
settings, under     options in the   tab, under  byRender, Output KeyShotVR Advanced 
checking the   checkbox.Zoom-In

Note: KeyShot automatically calculates the resolution when rendering the KeyShotVR
based on this setting when 'Preserve image quailty' option is enabled. If changed
afterward, grainy images may be experienced.

Usage Example:

var maxZoom = 1;

rotationDamping

This controls the speed at which the rotation slows down when a KeyShotXR is rotated.
Increasing this value will increase the duration of rotation before coming to a stop. This



is set in the KeyShotXR settings, under     options in the   tab,Render, Output KeyShotXR
under Advanced.

Usage Example:

var rotationDamping = 0.96;

downScaleToBrowser

This variable controls the automatic resizing of a KeyShotXR when a browser is resized;
it allows a KeyShotXR to be responsive. This is set to true by default and can only be
changed in the  file. .html

Usage Example:

var downScaleToBrowser = true;

addDownScaleGUIButton - Deprecated

With KeyShot 6 this option has been deprecated. The option is still available for legacy
KeyShotXRs that require this from in the  file..html

Usage Example:

var addDownScaleGUIButton = false;

downloadOnInteraction

This variable allows a KeyShotXR only to be loaded after it has been clicked. This
option is set in the KeyShotXR settings, under     options in the Render, Output KeyShotX

 tab, under R Advanced.

Usage Example:

var downloadOnInteraction = false;

imageExtension

This variable is the image extension for the frames generated for the KeyShotXR. Only
one extension type may be used. This is set in the KeyShotXR settings, under   Render,

 options in the   tab, under Output KeyShotXR KeyShotXR Control, Format.

Usage Example:

var imageExtension = "jpg";

showLoading

If this variable is set to , the loading icon will be shown. If set to , it will not betrue false
shown. This option is set in the KeyShotXR settings, under     options inRender, Output
the   tab, under    by selecting the  option.KeyShotXR Advanced Show Loading Screen

Usage Example:

var showLoading = true;

loadingIcon

This allows a different loading icon to be used. The variable is the filename of the icon
located in the the KeyShotXR   folder. This option is set in the KeyShotXR settings,files
under     options in the   tab, under   by selecting the Render, Output KeyShotXR Advanced,
Default loading icon.

var loadingIcon = "ks_logo.png";

allowFullscreen



This variable allows a KeyShotXR to be viewed fullscreen when it is double-clicked in
desktop browsers. This option is set in the KeyShotXR settings, under     oRender, Output
ptions in the   tab, under   by selecting KeyShotXR Advanced, Allow Fullscreen Mode by
Double-Click.

Usage Example:

var allowFullscreen = true;

uReverse

Usage Example:

var uReverse = false;

vReverse

Usage Example:

var vReverse = false;

 

Example of  KeyShotXR variables in the KeyShotXR .html file

 

Embedding KeyShotXR
There are several methods for embedding a KeyShotXR. This section will provide the
instructions for embedding a KeyShotXR within various media.

In this section:
Embedding a KeyShotXR in
PowerPoint

Embedding a KeyShotXR in PowerPoint
The following instructions describe the process to embed a KeyShotXR in Microsoft
PowerPoint.

https://luxion.atlassian.net/wiki/spaces/K7M/pages/43941990/Embedding+a+KeyShotXR+in+PowerPoint
https://luxion.atlassian.net/wiki/spaces/K7M/pages/43941990/Embedding+a+KeyShotXR+in+PowerPoint


1.  
2.  
3.  
4.  
5.  
6.  
7.  

8.  
9.  

10.  

Embed a KeyShotXR in PowerPoint

For PowerPoint 2007 and up download LiveWeb (lwsetup40.zip)
Extract the .zip folder contents
Run lwsetup.exe
Launch PowerPoint
Go to the Insert tab
Select Web Page from the LiveWeb section (LiveWeb dialogue appears)
Add the KeyShotXR url (ex. https://www.keyshot.com/vr/keyshot6/motox/motox
.html)
Select Add and hit Next >
Adjust the settings as needed and select Finish
Start the PowerPoint and click on the slide with the KeyShotXR to load it

Position a KeyShotXR in PowerPoint

You may not see the KeyShotXR in the slide while in edit mode. Don't worry, it's still
there. Click on the slide in edit mode and a bounding box will appear. This will be the
KeyShotXR. By default, KeyShotXRs will appear in the upper left corner. You can
position the KeyShotXR in the PowerPoint by adjusting the bounding box, modifying the
style of the KeyShotXR html itself, or both.

"Unable to locate Web Browser ActiveX Control"

If this error is received when attempting to embed a KeyShotXR, follow these
instructions to allow the KeyShotXR to be embedded.

Open the Windows Registry (right-click start menu, select , type ). Go to theRun regedit
following key (or search for COM Compatibility or ClassID {8856F961-340A-11D0-A96B
-00C04FD705A2} using Ctrl-F):

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\ClickToRun\REGISTRY
\MACHINE\Software\Microsoft\Office\16.0\Common\COM
Compatibility\{8856F961-340A-11D0-A96B-00C04FD705A2}

Double-click  entry and change the value to 0.Compatibility Flags
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Browser ActiveX Control"

Configurator

The  is a tool available in KeyShot Pro for presenting model andKeyShot Configurator
material variations in real-time for design reviews and interactive point-of-sale displays.

KeyShot Configurator Wizard

The KeyShot Configurator Wizard can be accessed from the KeyShot Ribbon. The
Wizard guides your through the setup of Parent Models, Components, and their

On this page:
KeyShot Configurator
Wizard
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relationships. You can also define Material Variations, Studios to include, and Layout
options. To view the Configurator, enter Presentation Mode and use the interactive
menus to control which model and material is displayed.

The first step of the Configurator Wizard is to select what you want to present - Model
Variations, Material Variations, or both.

The second step is to define the , which is the top-level product variationParent Model
you wish to present. This is required even if you are only presenting Material Variations.
If this is the case you can simply select the Default Model Set as your Parent Model.

You can use existing Model Sets if you have already separated them in the Scene Tree
or create them here by using the option to Select geometry from the scene. To do so,
check the box next to the model or parts you want to define as the Parent and click the 
Add Model Set button above the Parent Models list. This will automatically create a
Model Set in the Project window. Once one or more Parent Models have been added in
the Configurator Wizard you can select in the list and click the Preview button to view
and confirm in real-time.





If you wish to present part or accessory variations that are dependent on Parent Models
you will next need to add Components. Once again you can select existing Model Sets
if you have already separated them in the Scene tab or select geometry from the scene
manually.





If you have defined Components you will next need to add Component Groups. These
define the relationship between Parent Models and their dependent Components.
Simply click the inline link to  and check the respectiveAdd Component Group
Components in the list on the right. Repeat this until all relationships are defined. You
can also select   as an option if you wish to display the Parent Model with noNone
Component. In this example of a car with wheels it would not make sense to do so.



Material Variations are added by selecting the desired material/object in the Real-time
 then dragging and dropping materials from the  into the lower list picturedView Library

below. You will then see the material spheres populate the list to select and preview.
Once materials are in the list you can give the Material Variation a name i.e. Wheel
Accent. This material will become a Multi-Material in your scene that can also be
accessed and further edited from the  .Material tab



Studios can be enabled in order to change preset Cameras, Environments or
prop/scene geometry created as Model Sets. Studios must first be created in the
Studios dialog in order for them to show in the Studios section of the Configurator
Wizard. The most common use case of Studios in the Configurator is of Studios
assigned only an Environment so the scene lighting can be changed without having to
reset the Camera.



The Layout section is where you define the style of Presentation Mode for each given
Configurator scene. You can choose between a Compact toolbar or Touch Friendly
thumbnail interface. When using the Touch Friendly mode you will need to click the
Render Materials button in order for the material thumbnails to show in Presentation
Mode. The optimal size values, button and tab visibility, and tab names will vary from
scene to scene and also depending on screen resolution so it is best to spend some
time going between the Layout section and Presentation Mode to dial in the values and
options before your final presentation.





The Summary section allows you to see an overview of the number of variations in your
Configurator and to preview each of the variations in the Real-time View before entering
Presentation Mode.



Virtual Reality

KeyShot allows you to experience both real-time rendering mode and rendered visuals
in virtual reality (VR) using a VR headset. This section describes how to setup and use
VR hardware with KeyShot.

In this section:
VR Overview
Render VR Images
Work In Real-Time VR

https://luxion.atlassian.net/wiki/spaces/K7M/pages/40960054/VR+Overview
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40992822/Render+VR+Images
https://luxion.atlassian.net/wiki/spaces/K7M/pages/41025645/Work+In+Real-Time+VR


1.  

VR Overview

The VR capabilities in KeyShot allow you to use VR devices, such as the Oculus Rift
and the HTC Vive, to view KeyShot scenes. There are two applications for using VR
with KeyShot:

Render VR Images
View rendered panoramic images rendered in KeyShot. This mode is
compatible with any type of VR device capable of viewing VR images. Please



1.  

2.  

check with the manufacturer of the device to know what type of image is
necessary. Learn more

Work in Real-time VR
View and render the Real-time View through the VR headset. This mode is
compatible with the   and the   only. Oculus Rift HTC Vive Learn more

Accessing KeyShot VR Settings

VR capabilities are a KeyShot Pro feature. ( ) All VR settingsCompare KeyShot versions.
are accessed from the  window,  tab, under the  and Project Camera Lens Settings Stere

 sections.o

Terminology

Cube Map

In this mode, six views will be rendered side by side. 
The views are: Front, Back, Right, Left, Top, Bottom. 

If your device supports stereo cub maps it will automatically orient the
images for you to view them correctly.

Spherical

As described by the name, this image will look like a flattened out sphere.
This mode will be compatible with most devices out there.

Side-by-side

In order to see the image in 3D via the headset, you need to have the
same image played in both eyes. In this mode both images are
stitched next to each other.

On this page:
Accessing KeyShot VR
Settings
Terminology

Cube Map
Spherical
Side-by-side
Over-under
Eye Distance
Pole Merging Angle
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1.  

Over-under

In order for you to see the image in 3D in the headset, you need to
have the same image played in both eyes. In this mode both images
are stitched one on top of the other.

Eye Distance

This is to set the distance between your eyes. This is a setting that you
configured when setting up your Oculus Rift or HTC Vive. Use the
same distance set when setting up your device.

Pole Merging Angle

Details coming soon.

Render VR Images
This section will guide you through the steps necessary to render out an image to view
on a VR head-mounted display:

Open and setup the scene of your choice in KeyShot.

Go to the   window's   tab and open the   accordion.Project Camera Lens Settings

Select   modePanoramic .

Depending on the type of VR device you have, you may need to select Cube
 or  i.e. Oculus Rift and HTC Vive can use both, but GoogleMap Spherical, 

Daydream needs a Spherical image.

Enable the   radio button.Stereo

Go to the   menu by using the   button in the toolbar or by going toRender Render
the top menu under   Render, Render...

Render the image as you would any other image. Keep in mind that you will be
"immersed" in the scene, so the bigger the image resolution the more realistic it
will look.

Upload your rendered image to your headset to view the VR image. This step
can be different for each VR headset device. Please consult the headset
manufacturer for specific instructions for loading a VR image.

Related Pages

Panoramic

Work In Real-Time VR
This section will guide you through the steps necessary to view the real-time window
through a VR head-mounted display:

This will only work with the Oculus Rift and the HTC Vive.
These instructions assume that you have the Oculus Rift or the HTC Vive
already installed and ready to go.

Perspective Realtime View

Open and setup the scene of your choice in  .KeyShot
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Go to the   window's   tab and open the   accordion.Project Camera Lens Settings

Select   modePerspective .

Enable the   radio button.Stereo

You can change the stereo settings if you know specifically what you need or
you can just leave the default settings the way they are.

Click on the   dropdown and choose which VR deviceHead-Mounted Display
you have. For the Oculus choose   and for the HTC Vive, choose OOculus Rift p
enVR.

It might take a few seconds for the VR device's software to load but you can
now put your headset on to view your scene.

Panoramic Realtime View

Workflow 1:

Open and setup the scene of your choice in KeyShot.

In the top menu, go to  .Camera  Enable VR

Choose between   or  .Cube map mode Spherical mode

Choose your desired resolution. Keep in mind that the higher you go the more
powerful your machine will need to be. For example, if you are working on a
laptop, you should stay at lower resolution.

Choose which VR device you have. For the Oculus choose   and forOculus Rift
the HTC Vive, choose OpenVR.

Click  (It might take a few seconds for the VR software to start)Start. 

Workflow 2:

Open and setup the scene of your choice in  .KeyShot

Go to the   window's   tab and open the   accordion.Project Camera Lens Settings

Select   modePanoramic .

Choose between   or  .Cube map mode Spherical mode

Enable the   radio button.Stereo

You can change the stereo settings if you know specifically what you need or
you can just leave the default settings the way they are.

Click on the   dropdown and choose which VR deviceHead-Mounted Display
you have. For the Oculus choose   and for the HTC Vive, choose OOculus Rift p
enVR.

It might take a few seconds for the VR device's software to load but you can
now put your headset on to view your scene.

KeyShot Cloud
KeyShot Cloud is an online library where you can share your own custom materials and resources, as well as having access to resources
uploaded by other KeyShot users. When the KeyShot Cloud button is pressed, your default web browser will open and take you to the login page
for KeyShot Cloud.
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KeyShot Cloud User Interface
Search Field
View Style / Settings
Category Tabs
Search Result Counter
Search Results
Details
“Like” Button
Download





 

KeyShot Cloud Account

Click the KeyShot Cloud button on the
toolbar, or go directly to https://cloud.keyshot.

.com

Before you have access to KeyShot Cloud,
you will need to login with an existing account
or to create a new one. Click Register and
enter your details.

To log out, click the settings icon in the upper
right of KeyShot Cloud window and select
“Log Out”.

 

 

KeyShot Cloud Search
KeyShot Cloud has robust search capability. Type any search term or use search syntax (ex. @username) to search for resources.

The search results may be organized using the  and the  dropdown menus.Order By Results Since

Click on a resource entry to bring up the details of that specific resource such as the size, description, tags, creator, and more. The details section
will also contain the  button to download the resource to your KeyShot Library, as well as a  button to flag any resource asDownload Report
offensive material.

https://cloud.keyshot.com/
https://cloud.keyshot.com/




 

Uploading/Downloading Resources

Uploading Resources

To upload your custom resources to the Cloud Library, click the  button on theUpload
bottom right of the KeyShot library panel.

You will be prompted to edit the name if desired and to add a description and tags to
help other users search for your resource. If you don’t know what tags to use, you can
click  and KeyShot will auto generate tags for you.Suggestions

After clicking , a confirmation of resources to be uploaded will be displayed. Click Next U
 to send your resource to the cloud and give other users access.pload

On this page:

Uploading Resources
Downloading Resources



Downloading Resources

To download a resource on the Cloud, click the  button on the resource youDownload
would like to download. The resource will be automatically downloaded to your
downloads folder in the appropriate tab, and you will then be able to move it to an
existing or custom folder.

 



Network Rendering
KeyShot Network Rendering allows you to connect multiple computer systems in your office network and utilize the available hardware to reduce
rendering times significantly. In fact, the correlation between render time and number of cores in your network is approximately linear and
inversely proportional.  In other words, by doubling the number of cores you potentially cut your render time in half.* In addition, rendering over the
network is convenient. You may continue working in KeyShot or any other application without slowing down your system while the designated
rendering stations process your render “jobs”.

The KeyShot Network Rendering software is compatible with Mac and PC systems.
 

The more cores you have, the faster your images and animations will render.**

* Please note that this is an approximation under optimal conditions.  Render times are subject to hardware specs, core count differences
between slaves, scene complexity,  , multi-tasking, and network traffic.unit of time

** Please note that Luxion does not sell or rent cores.  All computer hardware (i.e. processor cores) is provided by the customer.

More on KeyShot Network Rendering and Network Rendering Installation can be found in the KeyShot 7 Network Rendering Manual.

View KeyShot 7 Network Rendering Manual

 

Preferences
This section describes where to find the KeyShot  (options/settings) andPreferences
what they do. You will find the KeyShot  in the Main Menu under Preferences Edit,
Preferences…

After making changes, make sure to select the  button. In someSave Changes
instances you maybe required to restart KeyShot in order for the changed settings to
take effect. To prevent any changes from taking effect simply select the  button.Cancel

The follow sections describe what preferences are available in each tab of the Preferen
 window.ces

In this section:

General Preferences
Interface Preferences
Folders Preferences
Plugins Preferences
Color Management
Hotkeys Preferences
Advanced Preferences

 

General Preferences

General

Show Welcome Window at Start Up

https://luxion.atlassian.net/wiki/display/K7NR/KeyShot+7+Network+Rendering+Manual
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40210531/General+Preferences
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40211498/Interface+Preferences
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40212081/Folders+Preferences
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40213847/Plugins+Preferences
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40215861/Color+Management
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40216076/Hotkeys+Preferences
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40242856/Advanced+Preferences


Displays a splash-screen at startup with recent scenes, demo scenes, news and info.

Adjust aspect ratio to backplate
Automatically resizes the  to the same aspect ratio of any backplateReal-time View
image that is loaded into the .Real-time View

Auto Update
Prompts you to download and run the update installer when a newer version becomes
available.

Pause KeyShot when sending jobs to Network Rendering
Pause rendering in the Real-time View and stop the usage of your CPU when jobs are
submitted to KeyShot Network Rendering.

Pause Real-time Render after time or samples 
Select an amount of time or render samples from the dropdowns to automatically pause
the rendering in the Real-time View and stop the usage of your CPU.

Screenshots

Format
Select the format for the saved screenshot (JPEG or PNG).

Quality
Determines the compression of the saved image. Higher settings mean less
compression yet better quality, but the file size will also increase. The default value is
99.  

Ask where to save each screenshot
KeyShot will prompt you to specify a location when saving a screenshot from the Real-ti

.me View

Save a camera/viewset with each screenshot
When checked, KeyShot will save a camera view for every screenshot that is saved out.
These views can be accessed from the camera tab in the project window.

Default Startup Scene

This lets you set the default startup scene when you start KeyShot. The  scenstartup.bip
e is set as the default. Any KeyShot scene may be set as a startup scene. To change,

simply click on the  icon  and browse to the scene you want KeyShot to loadFolder
on startup.

Backup Revision

Create a serialized backup revision with each save
When checked, the  will become enabled. KeyShot will create aRevision Manager
serialized backup every time that you save rather than overwriting the scene. This
results in a full copy of the original scene.

Backup history depth
Determines how many instances of the scene will be saved before the oldest one get
overwritten. By default the value is 5. When the scene is saved a 6th time, the first
(oldest) version of the scene will be overwritten. The maximum value is 99. 

Save Reminder

Display save reminder notification every: 
KeyShot will prompt you to to save at the interval selected. These times include every 5,

and . Select  if you do not want a  to10, 15, 30  60 minutes Never Save Reminder
appear. 

Cloud Library

This shows the login status for the KeyShot Cloud Library. You log into KeyShot Cloud
directly from within KeyShot by clicking the  icon in the toolbar. A browserCloud Library

On this page:
General
Screenshots
Default Startup Scene
Backup Revision
Save Reminder
Cloud Library



and internet access is required. Once logged in, here you can see the username with
which you are logged in with the option to log out. Learn more about .KeyShot Cloud

Interface Preferences

Interface

Language
Select the desired language in the menu.

Theme
Select desired color for the KeyShot interface.

Selection outlines
Displays an orange outline around selected parts.

Use CPU for selection outlines
Enable this if selection outlines are unstable on GPU.

Include camera changes in undo/redo
This will include all camera movements in the undo stack.

Reverse camera distance scrolling
Reverse the scrolling on the camera when dollying the camera.

Enable sub menus in Real-time View
Rather than showing a list of functions in the right click menus, these functions will be
logically grouped into sub menus.

Show in-project material list under material properties tab
All in-project materials will be displayed.

Disable scene tree hierarchy changes
Prevents you from making any changes to the scene tree hierarchy by dragging and
dropping parts.

Lock pivot to target
When it is enabled the pivot moves with the target when you pan the camera.

Scene Tree object preview tooltips
When checked you will see a spinning OpenGL shaded preview of an object when
hovering over it in the scene tree.

3Dconnexion Settings

KeyShot supports input devices from 3Dconnexion on both Windows and Mac. Make
sure a 3Dconnexion device is connected in order to be able to change these settings.
Learn more about .3Dconnexion

Restrict to dominant axis
Only allows one axis movement at a time.

Invert axis
Inverts camera movement direction.

Use global up axis
When checked (default) the camera will always rotate around the global up axis, even
when tilted. 

On this page:
Interface
3Dconnexion Settings

Folders Preferences
The folders tab allows you to specify folders or shared folders for all of your KeyShot
Resources including Textures, Backplates, Environments, Materials, Renderings,

(including KeyShotXR files) anScenes, Animations , Material Templates, Colors, Scripts 
d . Plugins

Specify location for all folders

This option sets the default location for all resource folders

Resources

On this page:
Specify location for all
folders
Customize each folder
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Select the folder icon   to set the default location for all KeyShot Resource folders.

Customize each folder

This option allows you to set the locations for each resource independently or add
additional folders or shared directories.

Plugins Preferences
All 3rd party plugins installed for KeyShot are displayed here. Note: these are not the

 KeyShot plugins used with modeling applications.

Plugins

The  window will show all installed KeyShot compatible plugins with checkboxesPlugins
to enable or disable the plugin when KeyShot starts. Plugins are installed via Windows
or Mac OS X installation files and uninstalled through the operating system options.

On this page:
Plugins

Color Management
Compensate for Image Gamma when applying Library Colors
Gamma corrects color values when applying them to a material directly from the Color
Library. This will try to keep the appearance of the color in the Library. With this option
selected, the color of the material in the scene and in the Library will always match, if
you don't change the Image Gamma after applying the color.

Apply Image Gamma to colors in Swatches and Color Pickers
Checking this option will apply the set Image Gamma to both the color swatches of
materials and the color picker. This will only adjust the actual color preview, not the
values.

Enable Color Management

Enable this option to use ICC color profile files in KeyShot. Select the folder icon  to
load your desired color profile. Both .ICC and .ICM file formats are supported. The
status window will show if the color profile was loaded and color profile created. Select 

 to save your color profile settings. To delete the color profile simplySave Changes
remove the file location or disable by unchecking .Enable Color Management

Hotkeys Preferences

You can customize all existing hotkeys inside KeyShot. Hotkeys are categorized as Sim
and . Depending on the type of hotkeyple Hotkeys, Mouse Actions  Camera Controls

you select, either the  or the  input fields will become active.Simple Hotkey Mouse Action
 are always active.Camera Controls

Filter/Hotkey List

This allows you to search for a specific  or  in the list. The HotkeyAction/Group Hotkey
List shows all of the KeyShot commands capable of having a key combination

On this page:
Filter/Hotkey List
Simple Hotkey
Mouse Action
Camera Control
Other Options

Shared Folders
Shared folders will allow you to point KeyShot to access files in folders that
are shared on a server or local computer. All shared folders will show inside
of the KeyShot Library. 

To use shared folders you will need to select  and clickCustomize each folder

the folder icon  to the right. The  dialog will open.Configure Folders
From there you can select the plus icon to add a new folder path. Selecting a
folder and clicking  will allow you to edit the folder and change the path orEdit
switch to a default folder. At least one default folder is required for each
resource.



assigned. Actions with empty Hotkey entries do not have a hotkey assigned.

Simple Hotkey

Select a , i.e a hotkey that doesn't contain any mouse actions from theSimple Hotkey
list of hotkeys. To edit, simply start typing in the input field. You can always change the
hotkey back to its default setting by selecting .Change to Default

Mouse Action

Select a  hotkey from the list, and start modifying the hotkey by changingMouse Action
the mouse action from the pull-down menu, and select up to three modifier keys, i.e. Alt,

.Shift, Ctrl

Camera Control

This function allows you to change the camera controls based on your favorite modeling
application. In the hotkey list you can see what application has been selected to change
the camera controls.

Hotkey Presets
Simply select the 3D modeling software from the dropdown menu, and all camera
controls will adjust accordingly. Support is included for:

3ds Max
Alias
Alibre
Fusion 360
Maya
NX
PTC Creo
Rhino
Solid Edge
SOLIDWORKS
SpaceClaim
ZBrush

Other Options

Reset All
This will reset all hotkeys to their default settings.

Import Hotkeys...
You can import your own custom hotkeys file that has been exported from a KeyShot
installation previously. KeyShot hotkey file format is .KSH.

Export Hotkeys...
Choose this function to export your custom hotkeys to use on another machine.

Advanced Preferences
Advanced settings are settings that hardly ever get touched. These settings control
some very specific usability settings, Live Linking, Network settings, Log and scripting
functions.

Advanced

Fast realtime updates
When checked, KeyShot will down-sample the scene while the camera is moved to
enable faster performance. On machines with many cores this function may be turned
off to ensure a smooth camera movement without loss of quality.

Graphics effects
When checked, enables the ,  and  effects under Bloom Vignetting Chromatic Aberration

 window,  tab, .Project Image Effects

On this page:
Advanced
LiveLinking
Network
Log
Scripting



Use gloss instead of roughness for materials
When checked, This will change all setting names for  to . You willRoughness Gloss
need to re-select a material in order for this setting to take effect.

Use UV mapping as default
When checked, this will always apply UV mapping to applied texture maps if available.

Link materials of duplicate parts
When checked, parts that are duplicated will have materials linked automatically.

Link duplicate materials when assigning from Library
When checked, duplicate materials that are being assigned to the scene from the library
will be automatically linked. This will avoid having multiple instances of the same
material in the scene.

Respect animation ordering
When checked, the next animation origin will match the previous animation origin.

Show Support Tool in help menu
When checked, the   will be available from the  menu. This too willSupport Tool Help
allow you to gather valuable information about your machine, operating system and
installed drivers, which can be helpful for our support and development team when
troubleshooting potential problems in KeyShot.

Render output window memory limit
This controls the amount of memory reserved for the image buffer in the output window.
If the rendered image takes up more memory than this limit, it will be downscaled until it
is below the limit. This is useful if you are rendering gigapixel images and your scene
takes up a lot of memory. It does not affect the output image itself (as specified in the
Render Settings), but does affect images saved directly from the output window.

LiveLinking

LiveLinking connects KeyShot to a modeling application via a custom plugin. When
enabled, LiveLinking allows you to run KeyShot in parallel with supported 3D modeling
software, and update the geometry inside of KeyShot without losing any of the material
assignments, cameras, lighting, etc. All plugins developed by Luxion or a partner
company may be found  .here

Enable LiveLinking
When checked (default), KeyShot will start and connect to supported 3D modeling
software through the installed plugin. Note: these plugins for 3D software are different
from  for KeyShot explained in the Preferences.plugins

LiveLinking Network port range
This is the port range the installed plugin is using.

Network

This section allows the user to configure the proxy settings in order to communicate with
Luxion's software update server and the KeyShot Cloud Library. This may be necessary
when KeyShot is installed in environments with tight firewall security.

Proxy type dropdown
This dropdown menu provides four options: (defaulNo proxy, Automatic proxy detection 
t) ., HTTP, SOCKS v5

Host
This option becomes available when  or  are selected. Enter theHTTP SOCKS v5
hostname of the proxy server as recognized on the network, or the host's IP address.

Port
Enter the port the proxy server is using to communicate through the firewall.

Enable proxy authentication
It may be necessary to enable proxy authentication on the server. To do so, check this
checkbox.

Username
Enter the user name that the user has been assigned to communicate with the proxy
server.

https://www.keyshot.com/plugins
https://luxion.atlassian.net/wiki/spaces/K7M/pages/40213847/Plugins+Preferences


Password
Enter the password for the user account on the  proxy server.

Log

The log can be accessed under the   menu in the KeyShot menu bar. It will containHelp
a log of all errors that occurred while running KeyShot.

Threshold
This dropdown menu contains the lowest level of warning that will be captured in the
log. Warning levels are: (default)Information , Warning, Critical, Fatal.

Display log window on critical errors
When checked, the log window will open up automatically as soon as a critical error
occurs.

History back buffer
Sets the number of entries in the log.

Scripting

This section provides the setting to take advantage of using local Python library
installations for KeyShot's Scripting capabilities. Learn more about Scripting .here

Use local Python paths
If checked, and if the user has Python libraries like PIL or SciPy installed locally, it will
be possible to use those libraries inside of KeyShot. However, only version 3.4 is
supported which is the same version that is being used inside KeyShot. If not checked,
then only the Python modules exposed inside KeyShot will be available to the scripts
running inside.

Glossary of Terms

Abbe Number (Dispersion)
The variation of refractive index versus wavelength, which produces a rainbow like effect as the value is increased.

ZPR
ZPR is an export option to be used with Zcorp 3d printers.

End-User License Agreement

Luxion KeyShot® 7

 

© 2010 - 2017 Luxion ApS. All Rights Reserved.

Protected by US patents 8,913,065; 9,043,007; 9,183,654.

Copyright law and international treaties protect this computer software program. Unauthorized reproduction or distribution of this software
program, or any portion of it, will be prosecuted to the maximum extent possible under law and may result in civil and criminal penalties.

KeyShot®, KeyShotVR®, KeyShotXR® and LiveLinking are Trademarks or registered Trademark of Luxion ApS.

PLEASE READ THE FOLLOWING CAREFULLY AS IT AFFECTS YOUR LEGAL RIGHTS:

THE LICENSE GRANT MADE TO YOU PURSUANT TO THIS END-USER LICENSE AGREEMENT (THIS “AGREEMENT”) IS CONDITIONED
UPON YOUR ACCEPTANCE OF ITS TERMS. IF YOU DO NOT AGREE WITH THIS AGREEMENT’S TERMS, YOU SHOULD RETURN THE
SOFTWARE AND ANY DOCUMENTATION, AND YOU WILL RECEIVE A FULL REFUND FOR ANY MONIES PAID FOR THE SOFTWARE.

 

https://luxion.atlassian.net/wiki/spaces/K7M/pages/37957984/Scripting


1. . The software (the "Software"), no matter how delivered (e.g. as an download online, in CD form), as well as any and all relatedLicense
documentation ("Documents") are licensed to you by Luxion ApS, a Denmark corporation. This License is non-exclusive, with Luxion retaining the
right to license the Software and/or Documents to any other party at Luxion’s sole discretion. This license is not a sale and except for the license
granted below, Luxion retains all right, title and interest in and to the Software and Documents and any copies thereof. The node-locked License
allows you to use the Software and Documents on a single fixed personal computer system or on a single mobile computer system (the “Host
System”). The floating License allows you to use the Software and Documents within your organization by checking out no more than the number
of purchased licenses from a license host. You are also allowed to make one copy of the Software in machine-readable form and one copy of the
Documents in hard-copy form for backup purposes only. You must reproduce on any such copy (in whatever form such copy may be) the Luxion
copyright notice and any other proprietary legends that are on the original copy of the Software and Documents. Annual maintenance includes all
updates and releases for the prepaid year as

well as phone in support.

 

2. . The Software contains copyrighted material, trade secrets, and other proprietary information, and in order to protect them you mayRestrictions
not reverse engineer, disassemble, or otherwise reduce the Software to a human-perceivable form except to the extent that it is unallowable to
prohibit such acts under applicable law. You may not modify, network, rent, lease, loan, sell, distribute, or create derivative works based upon the
Software or Documents in whole or in part. You may not electronically transfer the Software from one computer to another over a network. In
addition, you may not remove, obscure, or alter any proprietary rights or notices affixed or contained in the Software or Documents. All rights not
expressly granted are reserved by Luxion.

 

3. . This License is effective until terminated. You may terminate this License at any time by destroying the Software or DocumentsTermination
and all copies thereof. If you fail to comply with any provision of this License, this License will terminate immediately without notice from Luxion
and other legal remedies will become available to Luxion. Upon termination, you must destroy the Software, Documents and all copies thereof.

 

4. . You agree and certify that the Software will not be exported from the jurisdiction in which you acquired it except asExport Law Assurances
permitted by the applicable laws of such jurisdiction.

5. . The Software and Documents are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure byU.S. Government Restricted Rights
the U.S. Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause
at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software - Restricted Rights at 48 CFR 52.227-19 and
successors thereof, as applicable. Contractor/manufacturer is Luxion ApS.

 

6. . YOU EXPRESSLY ACKNOWLEDGE AND AGREE THAT USE OF THE SOFTWARE IS AT YOUR SOLEDisclaimer of Warranty on Software
RISK. THE SOFTWARE AND DOCUMENTS ARE PROVIDED "AS IS" AND WITHOUT WARRANTY OR CONDITION OF ANY KIND AND
LUXION EXPRESSLY DISCLAIMS ALL WARRANTIES AND CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES AND CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. LUXION DOES NOT
WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET YOUR REQUIREMENTS, OR THAT THE OPERATION OF
THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT ANY DEFECTS IN THE SOFTWARE WILL BE CORRECTED.
FURTHERMORE, LUXION DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE
USE OF THE SOFTWARE OR DOCUMENTS IN TERMS OF THEIR CORRECTNESS, ACCURACY, RELIABILITY, OR OTHERWISE. NO ORAL
OR WRITTEN INFORMATION OR ADVICE GIVEN BY LUXION OR AN AUTHORIZED REPRESENTATIVE THEREOF SHALL CREATE A
WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY. SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU (AND
NOT LUXION OR ANY AUTHORIZED REPRESENTATIVE) ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR
CORRECTION. SOME STATES AND JURISDICTIONS MAY NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE
EXCLUSION MAY NOT APPLY TO YOU.

 

7. . UNDER NO CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL LUXION OR ITS SUPPLIERS BE LIABLE FORLimitation of Liability
ANY INCIDENTAL, SPECIAL, CONSEQUENTIAL DAMAGES OR RELIANCE THAT RESULT FROM THE USE OF OR INABILITY TO USE THE
SOFTWARE OR RELATED DOCUMENTATION, EVEN IF LUXION OR A LUXION AUTHORIZED REPRESENTATIVE HAVE BEEN ADVISED
OF THE POSSIBILITY OF SUCH DAMAGES. THESE LIMITATIONS SHALL APPLY NOTWITHSTANDING THE FAILURE OF ESSENTIAL
PURPOSE OF ANY LIMITED REMEDY. SOME STATES AND JURISDICTIONS MAY NOT ALLOW THE LIMITATION OR EXCLUSION OF
LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

In no event shall Luxion’s total liability to you for all damages, losses, and causes of action (whether in contract, tort (including negligence), or
otherwise) exceed the amount paid by you for the Software.

 

8. . This license shall be governed by and construed in accordance with the laws of Denmark. If for any reason aControlling Law and Severability
court of competent jurisdiction finds any provision of this license, or portion thereof, to be unenforceable, that provision of the license shall be
enforced to the maximum extent permissible so as to effect the intent of the parties, and the remainder of this license shall continue in full force
and effect.

 



9. . You acknowledge and agree that your obligations and promises of under this Agreement are of a unique, intellectual characterInjunctive Relief
that gives them particular value. You acknowledge and agree that a breach of any of the promises or agreements contained in this Agreement will
result in irreparable and continuing damage to Luxion for which there will be no adequate remedy at law and, in the event of a breach, Luxion will
be entitled to injunctive relief and/or a decree for specific performance, and any other additional relief as may be proper (including monetary
damages if appropriate).

 

10. . You may not assign any rights or obligations arising under this Agreement without Luxion’s prior written consent. Luxion mayAssignment
assign any rights or obligations under this Agreement without your prior written consent. Subject to this restriction on assignment, this Agreement
will inure to the benefit of and bind the successors and assigns of each of Luxion and you.

 

11. . A waiver of a breach or default under this Agreement will not be a waiver of any other default. Failure by either party to enforceWaiver
compliance with any term of this Agreement will not be a waiver of that term.

 

12. . The Parties agree that any and all disputes arising out of the terms of this Agreement, their interpretation, and any of the mattersArbitration
herein released shall be subject to binding arbitration, to the extent permitted by law, in Denmark. The Parties agree that the prevailing party in
any arbitration shall be entitled to injunctive relief in any court of competent jurisdiction to enforce the arbitration award. The Parties further agree
that the prevailing party in any arbitration shall be entitled to reimbursement of their reasonable attorneys' fees and costs incurred in the
arbitration. THE UN CONFERENCE ON CONTRACTS FOR THE INTERNATIONAL SALE OF GOODS IS HEREBY EXPRESSLY DISCLAIMED.

 

13. . This Agreement states the final, complete, and exclusive agreement between the parties with respect to theEntire Agreement; Amendments
subject matter and supersedes any previous oral or written communications, representations, understandings, or agreements with respect to that
subject matter. Any representations, warranties, or statements made by either party that differ from the terms of this Agreement will be given no
force or effect. No course of dealing or usage of trade or course of performance will be relevant to explain or supplement any term expressed in
this contract. The terms of this Agreement may be modified only in writing signed be you and an authorized representative of Luxion.
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